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Microsoft Office 2010 & Windows 7 for CPAs
Course Information

Learning Objectives To increase the productivity of accountants using Microsoft
Office 2003, 2007 & 2010 and Window XP, Vista & System 7

Course Level Intermediate

Pre-Requisites Basic familiarity with Microsoft Office and Windows

Advanced Preparation None

Presentation Method Live lecture using full color projection systems and live
Internet access with follow up course materials

Recommended CPE Credit 8 hours

Handouts Templates, checklists, web examples, manual

Instructors J. Carlton Collins, CPA

AdvisorCPE is registered with the National Association of

State Boards of Accountancy (NASBA) as a sponsor of

continuing professional education on the National Registry

of CPE Sponsors. State boards of accountancy have final

h&:‘nm e d > authority on the acceptance of individual courses for CPE
N Y credit. Complaints regarding registered sponsors may be
addressed to the national Registry of CPE Sponsors, 150

Fourth Avenue, Nashville, TN, 37219-2417. Telephone: 615-
SPONSORS 880-4200.

Copyright © May 2010, ASA Research, AdvisorCPE, & Accounting Software Advisor, LLC
4480 Missendell Lane, Norcross, Georgia 30092 770.734.0450

All rights reserved. No part of this publication may be reproduced or transmitted in any form without the
express written consent of AdvisorCPE. Request may be e-mailed to marylou@advisorcpe.com or further
information can be obtained by calling 770.842.5904 or by accessing the AdvisorCPE home page at:
http://www.advisorcpe.com/

ASA Research and AdvisorCPE are subsidiaries of Accounting Software Advisor, LLC.

All trade names and trademarks used in these materials are the property of their respective
manufacturers and/or owners. The use of trade names and trademarks used in these materials are not
intended to convey endorsement of any other affiliations with these materials. Any abbreviations used
herein are solely for the reader’s convenience and are not intended to compromise any trademarks.

Some of the features discussed within this manual apply only to certain versions of Office, and from time
to time, Microsoft might remove some functionality. Microsoft Office is known to contain software bugs
which may prevent the successful use of some features in some cases. AdvisorCPE makes no
representations or warranty with respect to the contents of these materials and disclaims any implied
warranties of merchantability of fitness for any particular use. The contents of these materials are subject
to change without notice.

Instructor Contact Information
J. Carlton Collins
Carlton@ASAResearch.com
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Web Sites Maintained by ASA Research:

www.Carltoncollins.com
www.ASAResearch.com
www.CPAAdvisor.us
www.AccountingSoftwareAdvisor.com
www.AccountingSoftwareReports.com
www.AccountingSoftwareAnswers.com
www.AccountingSoftwareConsulting.com
www.AccountingSoftwareNews.com
www.QuickbooksAdvisor.info
www.AdvisorCPE.com
www.CarltonCollins.com
www.ExcelAdvisor.net
www.MBSAdvisor.com
www.SBAAdvisor.com
www.OfficeAdvisor.us

Main Web Site

Accounting Software Web Site
Technology Advice Web Site
Mirrored Web Site

Accounting Software Feature Reports
Accounting Software Advice Web Site
Top Accounting Software Consultants
Accounting Software News Web Site
QuickBooks Web Site

CPE Information Web Site
Miscellaneous and Example Web Site
Microsoft Excel Web Site

Microsoft Accounting Systems Web Site
Microsoft SBA Web Site

Microsoft Office Web Site

We publish selected materials, power point slide shows and downloadable example files on the
web as a service to the CPA community. Please feel free to learn about our other topics at these
great web sites. Thank you.

ASA RESEARCH

Speaker

Carlton's Links |

1. Carlton Collins, CPA - Keynote Speaker

Highly Rated & Entertoining Speaker, More than 2,000 Presentations, Technology Expert

QuickBooks Acct. Software | Security Inventory Technology | Miscellaneous

About Mr. Collins:
Biography

2010 Courses & Lectures
Ratings

Recent 2009 Ratings
Books Published
Articles Published
Carlton Quoted
Participant Comments
Pictures

Speaking:

Keynote Titles/Topics
Pricing/Spesking Fees
Consulting

Awards:

CPA Certificate

AICPA Certificate

GSCPA Certificate

GSCPA Discussion Leader
Award

Great Plains Reseller
Solomon Advisory Council
Epicor Partner Award
ACCPAC Outstanding Partner

Social Netwerking:
Facebook (Carlton.Collins
Carlton on Wikipedia

). Carlton Collins, CPA Biography
ASA Research
Atlanta, Georgia

Carlton@ASAResearch.com
770.842.5902

1. Carlton Collins, CPA is a Certified Public Accountant with experience in technology, tax, auditing, accounting systems,
financial reporting, and bond financing. He is an author, lecturer, and technology & accounting systems consultant. He has
published more than two dozen books, two hundred articles, and thousands of web pages. As a public speaker, Mr. Collins has
delivered more than 2,000 lectures in 44 states and 5 countries addressing more than 500,000 business professionals, including
numerous keynote lectures at national and international conferences. Key awards include: "AICPA Lifetime Achievement
Award", "Tom Radcliffe Outstanding Discussion Leader Award", "GSCPA OQutstanding Discussion Leader Award", and
"Accounting Technologies' Top Ten CPA Technologists Award". As a consultant, Mr. Collins has assisted 275+ large and small
companies with the selection and implementation of accounting systems. Mr. Collins has a Bachelors degree in Accounting
from the University of Georgia, is a 26 year member of the AICPA and the Georgia Society of CPAs, and is also a licensed realtor.

At the University of Georgia Mr. Collins was elected President of the Phi Eta Sigma Honor Society, was initiated into the BIFTAD
Honor Society, was a member of Alpha Tau Omega fraternity, and served three years in the Judicial Defender/Advocate
program. At Glynn Academy High Schoaol Mr. Collins was Senior Class President, Class Valedictorian, and received a principle
nomination to Annapolis Naval Academy. Mr. Collins has been married for 25 years and has two children. He devotes his leisure
time to family, travel, tennis, fishing, snow skiing, and riding motorcycles (dirt and street). Mr. Collins is president of his home
owners association, participates in the Gwinnett Clean and Beautiful program, and volunteers for Cooperative Ministries food
drive.

Selected Positions, Awards & Accomplishments:

mn

€ Internet | Protected Mode: On 3 v H100%
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2010 Computer
Technology
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2010 Computer Technology

The arrival of new computer technology makes Office 2003 and Windows XP obsolete.
Why? Because Office 2003 only sees up to 1 GB of RAM and can only use one
microcomputer processor chip. Likewise, Windows XP can only see 3 GB of RAM and use
one microcomputer processor chip. Computers these days are stronger, but in order to
take full advantage of that strength, your operating system and applications must be
stronger as well. The key factors you need to consider as you purchase a new computer,
operating system, and applications are as follows:

1. Do you want a 32 Bit or 64 bit system?

2. How much RAM do you want?

3. How many CPU processors do you want?

4. Which Operating System Do you want?
Example:

As an example, in January 2009, | purchased a desktop computer with 4 processor chips
and 8 GBs of RAM. | am running a 64 bit version of the operating system, not an older 32
bit version. The computer is an HP Pavilion Model a6750f. | paid $701 for the computer,
and about $94 each for the monitors. To support four monitors, | also added a Matrox
M9120 Plus PCle x16 video card ($289) and a quad video cable ($89). The total cost of
my system is $1,455. The computer is lightning fast — it launches Excel in about 1/3" of a
second and loads web pages in about 1/3"™ of a second. | routinely have 30 to 50
applications and web pages open at the same time, and | reboot the system about once
every two months. Here is a picture:

EXCEL FOR
CPAS
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| also have an older HP 4350 duplexing laser printer with third drawer which | paid
$2,000 for 1.4 million pages ago, and you can buy the same printer today for about
$389. For color printing and scanning | have an Epson RX680 printer which | paid $228
for. | use Comcast high speed Internet which costs $89 a month including DVR
television, and | use a Netgear MIMO wireless router which cost me $119. | back up my
system online via XCenetric and | also have several 300 to 500 GB USB drives which |
backup my files to as well.

The primary software | use on my computer is as follows:

Norton Internet Security - $49 a year to protect 3 computers.
Microsoft Office Ultimate 2010 beta (free).

Adobe Photoshop Elements ($139).

Adobe Acrobat (5286)

Skype (Free)

GoToMyPC (S16/month)

ok wNnE

Let’s Dig Deeper

Further, to help you better understand the issues at hand, presented below is a
summary of today’s newer technologies.

32 Bit vs 64 Bit

Just as more highway lanes accommodate more traffic flow, 64-bit computers
accommodate more data flow.
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64-Bit is 8 Times Faster - Since the early nineties, all computers have been built with a
64-Bit architecture, but only recently have 64-Bit operating systems and applications
been embraced. If your computer is more than 2 years old, chances are good that you
are still operating in the older 32-Bit environment — which is technically 2 to 8 times
slower, depending upon what task your computer is doing.

Micro/Mini/Mainframe - Many years ago, 32-bit computers were commonly referred to
as “micro _computers”; 64-bit computers were commonly referred to as “mini
computers”(like an IBM AS/400 or Digital VAX); and 128-bit computers were commonly
referred to as “main frame computers”. All of these computers have always used the
same memory chips, same drives, same CPUs, same components, etc — the only
difference has been the number of lanes of traffic provided for data flow. Ten years
from now it is very likely that your desktop computer will actually be a mainframe.

RAM

How Much RAM? - The old adage these days is you can’t be too rich, too thin, or have
too much RAM. For the past three decades, stronger computers have needed an
increasing amount RAM, and this will not change. When Windows Vista was released in
January 2007, almost no one had more than 1 GB of RAM, but Vista actually needed
3GBs of RAM to run well. Microsoft did not tell us this, and we installed Vista on our
computers with less than desirable results. Eventually we started installing Vista on
computers with 3+GBs of RAM, and found that Vista is a truly great operating system —
but by then, the damage to Vista’s reputation was wide spread. Since then Microsoft
has released Windows System 7 — which is really Vista 2.0, with about 500 minor
enhancements thrown in.

As of 2010, the standard for RAM is 4 GBs for laptops and 8 GBs for desktop systems.

RAM Speeds - You should know that RAM comes in different types and speeds, and of
course the faster your RAM, the faster your computer will perform. Although “DDR”
memory chips are still available, in 2008, most memory suppliers started transitioning
from “DDR2” memory chips to the more efficient and higher density “DDR3”
technology. Basically DDR2 allows the computer to “fetch” four times more data than
DDR chips, and DDR3 chips allow the computer to “fetch” twice as much data as DDR2
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memory chips. It’s like using a small shovel, bigger shovel, and really big shovel to dig a

hole.

! 27 \

DDR2 is available at 800 and 1066 speeds, while DDR3 reaches speeds from 800 to 1600.
Presented below are tables which summarize the clock speeds and data transfer rates
for commonly available memory chips.

DDR2 Speeds l

Standard Cycle I/0 Bus |Data transfers per| Module |Peak transfer
name time clock second name rate

DDR2-400 100 MHz 10 ns 200 MHz 400 Million 2-3200 3200 MB/s

DDR2-533 133 MHz 7.0 ns 266 MHz 533 Millien PC2-4200 4266 MB/s
PC2-43001

DDR2-667 166 MHz & ns 333 MHz 667 Million PC2-5300 5333 MB/s
PC2-54001

DDR2-800 200 MHz Sns 400 MHz 200 Million PC2-6400 6400 MB/s

DDR2-1066 266 MHz 3.75 ns 533 MHz 1066 Million PC2-8500 8533 MB/s

Source: Wikipedia

DDR3 Speeds

Standard Cycle I/0 Bus |Data transfers per| Module |Peak transfer
name time clock second name rate

DDR3-800 100 MHz 10 ns 400 MHz 200 Million PC3-6400 6400 MB/s
DDR3-1066 133 MHz 7.5 ns 533 MHz 1066 Million PC3-8500 8533 MB/s
DDR3-1333 166 MHz & ns 667 MHz 1333 Millicn PC3-10600 10667 MB/s[4]
DDR3-1600 200 MHz 3ns 800 MHz 1600 Million PC3-12800 12800 MB/s

Source: Wikinpedia

For Example, Take Kingston - To explain this using easier to understand terms, Kingston
offers three classes of memory chips as follows: Value RAM, High speed RAM, and High
Performance RAM for gaming. | would recommend that you stay away from the value
RAM, and at a minimum purchase high speed RAM instead.
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CPU Processors

Clock Speed Hits Wall - For two decades, computer manufacturers made computers
faster primarily by cranking up the clock speed. This worked well until the early 2000’s
where computer manufacturers hit a wall. Clock speeds of 4.0 Ghz generated more heat
than a computer could handle, and the chips basically melted. Manufacturers’ tried
adding more fans and bigger fans, but the problem persisted. Short of adding chilling
towers loaded with liquid nitrogen, manufacturers were forced to find speed elsewhere.

Multiple CPUs to the Rescue - Computer manufacturers turned to adding multiple CPUs
to a computer to gain more speed. This is not a new idea, a Cray Super computer has
always been a regular computer with a lot of CPUs glued together. For example, in 2009
Cray produced the Xt5 system called “Jaguar”. This system has 224,000 CPUs working in
tandem and as of Nov 2009 is the fastest computer in the world with a speed of 1.75
petaflops, beating out IBM’s Roadrunner 1.04 petaflops mark set in June 2009.

FLOPS is an acronym meaning FLoating point Operations Per Second. Here is your table:

Computer Performance
Name FLOPS

yottaFLOPS 102
zettaFLOPS 10%
exaFLOPS 108
petaFLOPS 10"
teraFLOPS 102
gigaFLOPS 10%
megaFLOPS 10%
kiloFLOPS 10°

Not So Fast - While a lot of hoopla is splashed on these theoretical calculations, having
two CPUs really speeds up your computer, but adding more CPUs has a diminishing
return on performance. Here’s why:

Not Really Multi-Tasking - Your computer is usually doing three or four things at the
same time. For example, it might be performing these tasks all at the same time:

1. Reading the C drive;

2. Writing to the USB drive;

3. Displaying progress on the monitor; and
4. Printing a report

If you have just 1 CPU, your computer spends 1/50™ of a second on each of these 4
tasks until all tasks are complete. For example, the CPU will spend 1/50th of a second
reading drive C, 1/50"™ of a second writing to the USB drive D, 1/50"™ of a second
displaying the progress on the monitor, and 1/50" of a second printing the report. It will
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continue this process and it will appear as though your computer is doing four things at
once, but it is not. The CPU is only performing one task at a time. By contrast, if you
have four CPUs, then each CPU will perform each task at the same time. Hence your
computer is exactly four times faster with four CPUs compared to just one CPU.

Really is Multi-Tasking - However, your computer is seldom doing 8 things at once,
therefore if you have 8 CPUs, 4 of them are probably just sitting there with nothing to
do. | guess that if you frequently had extremely complicated calculations which could be
spread across multiple CPUs, then the extra CPUs might come in handy. But most of us
use our computers to create word documents, send and read e-mail, and make simple
calculations in Excel — so the utility of the Cray Jaguar mentioned above is basically
useless in all but the most extreme cases. It does however make for good bragging
rights at cocktail parties. The conclusion is that adding an unlimited number of CPUs to
your computer is not really practical, but makes for a good show. Right now it seems to
make sense to have a computer with at least 4, and perhaps 8 CPUs, and no more.

Operating System

OS - It doesn’t help much to have more RAM or CPUs if you operating system doesn’t
see all of that RAM. That is why it is important to choose an operating system wisely.
Windows XP supports just one CPU, Vista supports 64 CPUs and Windows 7 supports up to 256
CPUs. As shown below, different operating systems see different amounts of RAM.

Product Maximum RAM

Desktop Operating Systems:

Windows 7 Ultimate - 32 Bit 4GB '

Windows 7 Enterprise - 32 Bit 4GB '
Windows 7 Professional - 32 Bit 4GB -
Windows 7 Home Premium - 32 Bit 4GB -
Windows 7 Home Basic - 32 Bit 4GB -
Windows 7 Starter - 32 Bit 2GB '

Windows 7 Ultimate - 54 it 260
Windows 7 Enterprize - 54 8t 265
Windows 7 rofessiona - 52 Bit .
Windows 7 Home Premium - 64 Bit 16 GB -
Windows 7 Home Basic - 64 Bit 8GB .
Windows 7 Starter - 64 Bit 2GB [ ]

Windows Vista Ultimate - 32 Bit 4GB -

Windows Vista Enterprise - 32 Bit 4GB -

Windows Vista Professional - 32 Bit 4GB [}

Windows Vista Home Premium - 32 Bit 4GB '

Windows Vista Home Basic - 32 Bit 4GB -

Windows Vista Starter - 32 Bit 1GB '

Windows Vista Ultimate - 64 Bit 128 GB

Windows Vista Enterprise - 64 Bit 128 GB

Windows Vista Professional - 64 Bit 128 GB

Windows Vista Home Premium - 64 Bit 16 GB

Windows Vista Home Basic - 64 Bit 8GB

Windows XP - 32 Bit 2GB or 3GB

Windows XP - 64 Bit 2GB or 4GB

Server Operarating Systems:

Windows Sever 2008 - 32 Bit 4GB or 64 GB

Windows Sever 2008 - 64 Bit 8GB, 32 GB, 128 GB, or 8TH
Windows Sever 2003 - 32 BIT 2GB, 4GB, 8GB, 16 GB, or 128 GB
Windows Sever 2003 - 64 BIT 16 GB, 64 GB, 512 GB, 1 TB,or 2TB
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If you study the table carefully, you will conclude that the 64-bit operating systems are the ones
to choose, the 32-Bit versions of these operating systems simply don’t see enough RAM.

Apple versus Microsoft

> al Zf'lu
‘ Wlndosvé

| Like Apple - | am a fan of Apple computers. I've owned a lot of Apple computers in the
past, and in the early nineties | even appeared on a television commercial with Apple
President John Scully promnoting Apple solutuions. | own a big chunk of Apple stock and
| am no stranger to Apple solutions.

Apple is Not Superior - With that said, over the past two years | have challenged several
of my Apple freinds to contests using my $550 HP pavilion laptop against their $2,200 to
$2,800 MACbook and MACAIr computers. Even though their computers costs more than
three of my HP laptops — my HP laptop did everything their computers would do, and
did them faster. My Apple bigot friends are usually left stunned and speechless,
especially after they start trying to show me graphic and video things that they assume
my computer can’t do; and | shown them that | can easily do those things.

Complaints from Apple Users - | teach full day hands on Excel courses and typically
there is at least one MAC user in the class, and before the day is done, that MAC user is
disgruntled because their system is more complicated to use than the Widnows based
system the rest of us are using.

Apple is More Proprietaary - Add to the mix that Apple solutions tend to be more
proprietary whereas Windows solutions tend to use a more open architecture and cost
far less. You can easily make the case for a Windows based computer over a Mac.

Hackers Target Windows More - It is true that there are twelve times more Windows
users than MAC users, therefore Windows users are targeted more by hackers and
writers of computer viruses; but Apple is still prone to similar attacks and viruses as well.

For accounting systems, there are very few good choices available for the MAC.
The bottom line is that | never buy Apple myself. | figure that you can pay $550 for a

faster HP computer with less expensive applications, or $2,200+ for a slower MAC
computer with more expensive proprietray applications. For me, this is an easy decision.
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» Windows Vista

Windows Vista
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Microsoft Windows Vista

When Windows Vista was released in January L
2007, Vista needed 3GBs of RAM to run well,

which no one had at the time. Microsoft did

not tell us this, and we installed Vista on our
computers with less than desirable results.
Eventually we started installing Vista on '-«
computers with 3+GBs of RAM, and found that

Vista is a truly great operating system — but by

then, the damage to Vista’s reputation was

wide spread.

Vista’s Bad Rap Explained

Most people cringe by the mere mention of “Vista”. | hated it too when it first came out.
However within one year, | considered Windows Vista to be the most outstanding
operating system the world has ever seen. Here’s how the product got such a bad
reputation:

1. Changed the Kernel in the name of Security - To make Vista far more secure
than Windows XP, Microsoft changed the kernel — the core of the Vista operating
system. It was an excellent improvement from a security standpoint, but this
meant that all applications (like QuickBooks) had to be slightly modified in order
to run on Vista. Microsoft asked the various application developers throughout
the world to modify their products to launch on Vista’s new and improved
kernel, but for the first time in Microsoft’s history, the company was
unsuccessful at getting developers to immediately update their products.

Tweaking Needed - Therefore when the Vista operating system was launched in
January 2007, many applications would not run without a little tweaking. | myself
counted 15 applications that would not run on Vista including QuickBooks, MAS
90, and Microsoft’s own LiveCam. It was a disaster. However, by September
2007, almost all significant applications were updated to launch on Vista.
Unfortunately by then, the damage to Vista’s reputation had already been done.

A Small Tweak is Really a Big Deal - In defense of the application developers,
making this slight change seems easy, but it is actually very costly because this
change means a new version number. In turn, a new version number means new
product packaging, updated help files, new license agreements, updated web
sites, updated manuals, new brochures and collateral marketing material, etc.
While they are at it, they might as well throw in the other new updates they
have been working on as well - right. These vendors simply told Microsoft that
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they would work in the new code change with their next product release, and
that seems reasonable. The problem is that Microsoft had made this request
years earlier, and the application developers simply ighored Microsoft’s request
until Vista actually started shipping.

2. RAM Needs - The second problem was that Vista needs at least 3 GBs of RAM to
run well, but Microsoft failed to tell us this because at the time, almost no one
had this much RAM — that knowledge would have been a huge barrier to sales.

Vista is Great - Despite the initial problems, in my opinion, Vista is outstanding. In early
2008 | purchased a $599 HP laptop running Vista Professional (64-bit) with two
processors & 4 GBs of RAM. The computer is smoking fast — Excel launches in just one
second. In January 2009 | purchased a $701 HP desktop running Vista Home Premium
(64-Bit) with 4 processors and 8 GBs of RAM. Excel launches in 1/3rcl of a second.

Windows 7 is Great - In June 2009 | purchased an HP pavilion running Windows System
7 with 2 CPU processors and 4 GBs of RAM. It too has been outstanding. It is not a well
kept secret that Microsoft Windows 7 is really Vista 2.0 with about 500 minor
enhancements thrown in; and since | was already a huge fan of Windows Vista, | am also
a huge fan of Windows 7.

Vista’s New Features

Vista provides many new features. Here is a recap, with my favorite new features
underlined.

1. Explorer Improvements

a. Instant Search - Finds files rapidly.
Navigation Pane - Contains quick links to documents and folders.
Command Bar - Displays tasks appropriate for the files being displayed.
Live Icons - Display thumbnail image of the actual contents of each file.
Details Pane - Provides rich information (metadata) about files.
Preview Pane - Preview a file's contents.
Enhanced title bars, borders, and Address Bar.

N

2. BitLocker Drive Encryption — Encrypt your entire hard drive.

3. Encrypting File System - User-level file and folder encryption.

4. Fast Sleep and Resume — New sleep power state is quick and saves battery life.

5. Windows Aero Technology
a. 3-D Flip — 3-dimensional view of open windows for better switching.
b. Windows Flip — Traditional ALT-TAB flip with thumbnail previews.
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C.

Glass — Transparent window edges enforces concept of layered windows.

6. Built-in diagnostics — Built-in troubleshooting, and resolution logic.

a.

~o oo o

Disk Diagnostics.

Monitor Backup activity.

Detects impending disk failures.

Memory Diagnostics.

Network Diagnostics and troubleshooting.
Resource Exhaustion Prevention.

7. Ease of Access Center - Adjust accessibility settings and manage accessibility
programs.

a.

Sm o a0 o

Speech Recognition — Dictation and control your computer with you
voice.

Magnifier - Enlarges part of the screen while you work.

Narrator - A text-to-speech program that reads aloud on-screen text.
On-Screen Keyboard - Visual on-screen keyboard.

Keyboard shortcuts - Alternative to the mouse.

Mouse Keys - Use the arrow keys to move the mouse pointer.

Sticky Keys — Helps one armed people press simultaneous keys.
Filter Keys - Ignore keystrokes that occur when key is held down
unintentionally.

Visual Notifications - Replaces system sounds with visual cues..
Captions - Animations and video indicate activity happening on your
computer.

8. DirectX 10 - heavily enhanced 3-D graphics-rendering capabilities and helps
noticeably improve your computer's performance in games and high-end 3-D
applications.

9. Internet Explorer 7 in Windows Vista

oo oo

Tabbed browsing

Protected mode

Dynamic Security Protection
Phishing Filter

10. Other Vista Improvements to:

®ao oo

Network and Sharing Center & Networking
Remote Access &Remote Desktop Connection
Sync Center

Windows Calendar Publishing

Windows Fax and Scan

Page 16
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Windows Mail

Wireless Networking
Photo Gallery

Windows DVD Maker
Windows Media Center
Windows Media Player 11
Windows Movie Maker

. Windows Sidebar and Gadgets

Performance

Search Folders
Self-Healing System
SuperFetch

Windows Mobility Center
Windows ReadyBoost
Windows SideShow
Windows Update

Search and Organization

. Tablet PC Support

Windows Easy Transfer
Windows Meeting Space
XPS Documents

. Shadow Copy

. User Account Controls

. Windows Backup and Restore Center
. Windows Defender

. Windows Firewall

. Windows Security Center

. Windows Update

Copyright 2010, All Rights Reserved
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Microsoft
Windows 7
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What’s New in Windows 7?

As mentioned below, Windows 7 is in reality Windows Vista 2.0, but the product name
was changed in an effort to shed some of the negative image created by the Vista brand
name. There are no significant changes between Vista and Windows 7; however, there
are hundreds of small changes and improvements. A list of some of the more prevalent
changes and improvements in Windows 7 is presented in bullet form below.

1. Less Nagging — The User Account Control in Vista was constantly popping up and
hovering over you to nag you constantly: “Are you sure you want to continue?”
This pop up box may have our best interests in mind, but it can harass you
bonkers in the name of “security”. Windows 7 allows you to modify this behavior
by reducing the unnecessary and redundant UAC dialogs, making the prompts
more informative, and providing users with more control.

2. Explorer is Better Behaved - Vista sometimes made the left navigation pane in
Windows Explorer a moving target. In Windows 7, the navigation pane stays still,
so you no longer risk getting seasick from all the swaying back and forth.

3. Consolidated Security Messages - In Windows 7, all the security messages have
been consolidated into one icon. When you click the icon, you’ll see all messages
related to firewall, Windows Defender, Windows Update, etc.

4. Side-by-side Windows with Auto-size - Windows 7 includes a cool new feature
in which if you drag two windows to each side of the screen, they will
automatically size themselves to take up half the screen. Even better, when you
drag the window back away from the edge, it returns back to its’ original size.

5. Windows Media Player - In Windows 7 you can stream the music and videos on
one PC in the network to another, and even play back songs from iTunes libraries
on other computers.

6. Connecting to A Wireless Network is Easier - Click the Wi-Fi icon in the system
tray and select a network from the list, instead of opening up a separate dialog
box to make the connection.

7. Multi-touch — Windows 7 now supports multi-touch displays which allows the
user to lose the keyboard and instead use their fingers to touch menu selections
on the screen to navigate and input data. You might have used this technology
on your cell phone. http://msdn.microsoft.com/en-us/magazine/ee336016.aspx

8. Handwriting Recognition — When you write on a Multi-Touch screen,

handwriting recognition is supported for 19 languages. http://technet.microsoft.com/en-
us/library/dd367848(WS.10).aspx
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9. Superbar - Redesigned Windows Shell with a new taskbar. A few improvements
are discussed below. http://www.neowin.net/news/main/09/01/15/windows-7-superbar-overview.

10. Improved Thumbnails — Windows 7 taskbar also provides thumbnail previews of
the running applications. But with the new superbar, you can now see previews
of all running instances of that application. For example, if you have three IE tabs
open, you can see previews of all the three tabs and easily switch between them
by just hovering or clicking over the IE icon in the taskbar.

e Welcome to Windows 7 - Wind... & The Windows Blog - Windows I.. ﬁ' Neowin.net - Where unprofessi...

11. Show Desktop - Provides a preview of all windows open »
faded away into glass sheets when you hover over the icon. Windows [
This helps to have a peek of your desktop before you switch. == oL ?n[. :
Clicking on the icon switches to your desktop. .

12. Pinning — Buttons for pinning applications are integrated with the task buttons
as well as the various office applications.

I |

13. Jump Lists - Allows easy access to common tasks, recently used applications, and
pinned applications.

14. Customize the Notification Area - Users can customize which applications show
notifications.

15. Reorder Taskbar Buttons - According to your likes and dislikes.
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16.

17.

18.

19.

20.

21.

22.

Aero Snap - Automatically maximizes a window when it is dragged to either the
top or left/right edges of the screen, similar to Linux. This also allows users to
snap documents or files on either side of the screen to compare them. When a
user moves windows that are maximized, the system restores their previous
state automatically. This functionality is also accomplished with keyboard
shortcuts. Unlike in Windows Vista, window borders and the taskbar do not turn
opaque when a window is maximized with Windows Aero applied. Instead, they
remain translucent. http://windows.microsoft.com/en-US/windows7/products/features/snap

Aero Peek - Peek gives you the power of X-ray vision, so you can peer past all
your open windows straight to the Windows 7 desktop. Simply point to the right
edge of the taskbar—and watch open windows instantly turn transparent,
revealing your desktop icons and gadgets. (Tip - To quickly reveal a buried
window, point to its taskbar thumbnail. Now only that window shows on the
desktop.) http://windows.microsoft.com/en-us/windows7/products/features/peek

Aero Shake — To cut through a cluttered desktop and quickly focus on a single
window, just click a pane and give your mouse a shake. Voila! Every open
window except that one instantly disappears. Jiggle again—and your windows

are back. http://windows.microsoft.com/en-us/windows7/products/features/shake

HomeGroup — Microsoft’s new home networking system. HomeGroup enables
you to sharing files and printers on a home network. If you connect two or more
PCs running Windows 7, HomeGroup makes it easy to automatically start sharing
your music, picture, video, and document libraries with other people in your
home. HomeGroup is password-protected and you decide what gets shared and
what stays private. You can join a HomeGroup in any edition of Windows 7, but

you can only create one in Home Premium, Professional, Ultimate, or Enterprise.
http://windows.microsoft.com/en-us/windows7/help/homegroup-from-start-to-finish

Removed Applications - The classic Start Menu user interface, Windows
Ultimate Extras and InkBall.

Windows Live Essentials - Windows Photo Gallery, Windows Movie Maker,
Windows Calendar and Windows Mail are not included with Windows 7, but are
instead available for free in a separate package called Windows Live Essentials
which can be found on the Microsoft website.

Support for Virtual Hard Disks — VHD enables you to run a DOS Windows,
Windows XP, Linux, UNIX, or other operating system in a given window. A VHD
can be used as the running operating system on designated hardware without

any other parent operating system, virtual machine, or hypervisor.
http://technet.microsoft.com/en-us/library/dd440864(WS.10).aspx
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23.

24,

25.

26.

27.

28.

29.

30.

31.

Improved Performance On Multi-Core Processors - Windows 7 can support as
many as 256 processor cores compared with 64 for Vista. Windows 7 also does
a better job of distributing tasks across all of your processor cores, so none
remain idle when needed. As mentioned previously in this manual, most
computer users don’t uses numerous applications simultaneously or tackle
extremely complex calculations on a regular basis — therefore your computer will

rarely need to use more than 8 processor cores. http://news.cnet.com/8301-30685 3-10372095-
264.html

Improved Boot Performance — While Vista computers boot in approximately 30
to 50 seconds, Windows 7 computers boot in just 15 seconds.

http://windows7center.com/news/microsoft-to-improve-boot-performance-in-windows-7-manages-to-boot-in-under-15-seconds-in-the-lab/

DirectAccess — Gives mobile users seamless access to corporate networks
without a need to VPN. more

BranchCache - Decreases the time branch office users spend waiting to
download files across the network. more

Federated Search - Finds information in remote repositories, including
SharePoint sites, with a simple user interface. more

BitLocker and BitLocker To Go - Enforce encryption and backup of recovery keys
on PCs and removable drives. more

AppLocker — You can specify which software is allowed to run on a user's PCs
through centrally managed but flexible Group Policies. more

Virtual Desktop Infrastructure (VDI) Optimizations - Use virtual hard drive (VHD)
images to boot a physical PC. More

Multilingual User Interface - Create a single OS image for deployment to users
worldwide. more

Kernel Improvements:

32.

AVCHD Camera Support - (Advanced Video Coding High Definition) is a format
for the recording and playback of high definition video. The format has been
jointly developed by Sony and Panasonic primarily for use in high definition
consumer camcorders. AVCHD has been designed to be compatible with Blu-ray
Disc format and can be used for authoring and distributing of high definition
video on DVD media, though not all Blu-ray Disc players are compatible with
AVCHD discs.
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33.

34.

35.

36.

37.

38.

39.

40.

41.

42.

43.

Universal Video Class 1.1 Support - The USB Video Class (UVC) driver is a
Microsoft-provided AVStream minidriver that provides driver support for USB
Video Class devices. When your device uses UVC, you do not need to supply your
own driver. Instead, the device works automatically with the system-supplied
driver.

Protected Broadcast Driver Architecture (PBDA) — Basically this enables TV
tuner card. Microsoft's new worldwide platform to integrate broadcast TV
services into Windows Media Center on a Windows PC. It integrates virtually any
free or premium TV service into Windows Media Center, while satisfying the TV
industry's requirements for strong content protection in the case of pay TV.

Up To 256 Logical Processors — XP supported just 1, and Vista supported 64.

Timer Coalescing — Allows processors and chipsets to transition to very low
power usage levels while the CPU is idle.

Improved Multi-function Device Support — Better handles combination
printer/fax machine/scanner, or web-cams with a built-in microphones.

Windows Installer 5.0 - Provides developers with more control over setting
permissions during software installation.

User-Mode Scheduling - Database servers can benefit from having a thread
scheduler in-process. This is because the kernel no longer needs to be involved in
context switches between threads, and it obviates the need for a thread pool
mechanism as threads can be created and destroyed much more quickly when
no kernel context switches are required. (In other words — it takes the kernel out
of the database reading and writing process to speed things up.)

New FireWire (IEEE 1394) - Full support for IEEE 1394b with S800, S1600 and
$3200 data rates.

Trusted Installer - Secures some of the core operating system registry keys and
prevents other users, including the system, from making changes.

Internet Information Services (1IS) — The world's second most popular web
server in terms of overall websites behind the industry leader Apache HTTP
Server. As of March 2010, it served 24.47% of all websites according to Netcraft.
The protocols supported in IS 7 include: FTP, FTPS, SMTP, NNTP, and
HTTP/HTTPS.

Disk Partitioning — As a default Windows 7 creates two partitions: 1. The first for
booting, BitLocker and Windows Recovery and 2. The operating system.
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44,

45.

46.

47.

48.

49.

Removable Media - Improvements to ejecting just one camera card at the same
time (from a single hub) and retain the ports for future use without reboot.
Further, removable media is now also listed under its label, rather than just its
drive letter. Also, Windows 7 Explorer now (by default) only shows ports from a
card reader in the My Computer menu which actually have a card present.

Video Support - Windows 7 adds playback of media in MP4, MOV, 3GP, AVCHD,
ADTS, M4A, and WTV multimedia containers, with native codecs for H.264,
MPEG4-SP, ASP/DivX/Xvid, MJPEG, DV, AAC-LC, LPCM and AAC-HE.

Ability To Join A Domain Offline - This makes it possible to join computers to a
domain in locations where there is no connectivity to a corporate network. For
example, an organization might need to deploy many virtual machines in a
datacenter. Offline domain join makes it possible for the virtual machines to be
joined to the domain when they initially start after the installation of the
operating system. No additional restart is required to complete the domain join.

Support for Multiple Heterogeneous Graphics Cards - XP allowed you to mix and
match graphics cars but Vista required you to use the same driver for all graphics
cards. In Windows 7, you can now once again mix and match graphics cards.

XPS Essentials Pack - Microsoft has released Version 1.1 of the XPS Essentials
Pack, allowing Windows XP and Vista users to view and generate documents in
the .XPS format, Microsoft's alternative to the .PDF format. Windows 7 already
incorporates this functionality.

Windows PowerShell - Windows PowerShell™ is a command-line shell and
scripting language designed especially for system administration. Built on the
Microsoft .NET Framework, Windows PowerShell helps IT professionals control
and automate the administration of Windows operating systems and of
applications that run on Windows.

Windows PowerShell (x86)

PS C:UsersiDavid> ls

Directory: C:sUserssDavid

LazstWriteTime Length Name

5-17/2009 Gontacts
5-19/2009 g Desktop
57192089 H Documents
5-19.-2009 H Downloads
5-17-2089 Favorites
5-17-2089 B Links
5-17/2009 H Music
5-1%,208% H Pictures
5-17,208% H Saved Games
5-17-,2009 H Searches
5-17-208% H Uideos

PS8 G:sUserssDavid>
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50. Improved Calculator - Redesigned Calculator with multiline capabilities including
Programmer and Statistics modes along with unit conversion.

7 Calculator .. e —— =
[Mode] Edit Options Help I
Standard VYIS N S '
SRR Alt+2 | Select unit type to convert
Programmer Alt+3 |Ang|e |
@ | Statistics Alt+4
| Fram
iCclunt= a | Enter Value
05 |Degree o
(e |[ e |[ws [ e [[ - | | 7o
|oos [[ e ][ c [ || o
e | __,- Degree =
| [ 7 [[s ][9] 2] =]
NESEXE3 BB
E2 B3 ERE
[0 [[ o [ = [[aue]

@ [Al ClearType Text Tuner
Click the text sample that looks best to you (4 of 4)

The Quick Brown Fox Jumps The Quick Brown Fox Jumps

Over the Lazy Dog. Lorem
ipsum dolor sit amet,

Maecenas elit metus,
pellentesque quis, pretium.

Over the Lazy Dog. Lorem
ipsum dolor sit amet,

Maecenas elit metus,
pellentesque quis, pretium.

consectetuer adipiscing elit.
Mauris ornare odio vel risus.

Qver the Lazy Dog. Lorem
ipsum dolor sit amet,
consectetuer adipiscing elit.

Mauris ornare odio vel risus.

Maecenas elit metus,
pellentesque quis, pretium.

The Quick Brown Fox Jumps

consectetuer adipiscing elit.
Mauris ornare odio vel risus.

The Quick Brown Fox Jumps
Over the Lazy Dog. Lorem
ipsum dolor sit amet,
consectetuer adipiscing elit.

Mauris ornare odio vel risus.

Maecenas elit metus,
pellentesque quis, pretium.

51. ClearType Text Tuner - Use Clear Type Tuner for the best look on your LCD
monitor or laptop screen. Run ‘cttune.exe’ from the Start Menu search box, or
go to the Control Panel Display applet, and select Adjust ClearType Text.

52. Display Color Calibration Wizard — Helps you set your display colors just right. In
particular, Photoshop users and video editors will find built in gamma and color
balance controls and you are no longer dependant on you graphics cards’ control
panel. As an added bonus, it works for multiple monitor setups as well.
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53. Gadgets - Gadgets are small single-purpose applications, or software widgets,

that can sit on a Microsoft Windows user's computer desktop, or are hosted on a
web page.

There are hundreds of gadgets available and some of the more popular gadgets

used today are as follows:

eBay Auction

System Monitor

| ..
You Tube ~ Online 1| (1) _ Google -~
Brendamari S5 3
gtjDaniEIL‘astrn H
& luan Zario
YouTube Downloader Messenger Gadget Google Gadget
d (e ]

N—3
2 --;'"‘:—A‘—E‘5L
g

Digital Frame

Office

Office Tips

Calculator
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54,

55.

56.

57.

58.

Recovery — Windows 7 allows you to create a system repair disc. — To do this
click Start; Back Up; Create a System Repair disc.

Troubleshooting — Microsoft provides a Troubleshooting guide here
http://msdn.microsoft.com/en-us/library/dd776530.aspx. It includes links to
blogs, support groups, and technical support staff who can help you if needed.

Workspaces Center — Formerly called SharePoint Services, this allows distant
people to work together better by improving workflow, reducing shipping and
travel costs; and by sharing all of your information through a single location.
Features shared task list with progress, and library check out system for
opening documents.

Location and Other Sensors - Enables your computer and applications to adapt
to the environment. For example, location sensors (including GPS devices,
WWAN radios, and even triangulation technology) your applications and
gadgets can know exactly where they are, enabling them to provide more
locally relevant content and functionality. Ambient light sensors, can allow your
computer to automatically adjust your screen's brightness based on the current
lighting conditions.

Credential Manager - Allows you to store user names and passwords that you
use to log on to websites or other computers on a network. By storing your
credentials, Windows can automatically log you on to websites or other
computers. Credentials are saved in special folders on your computer called
vaults.

59.Biometric Devices — Support for fingerprint _and retina_scanner devices.

60.

61.

http://windowsteamblog.com/blogs/windows7/archive/2009/01/08/windows-7-puts-it-s-finger-on-enhanced-biometric-support.aspx

Windows Security Center - Has been renamed “Windows Action Center” and
encompasses both security and maintenance of the computer.

WIC-Enabled Image Decoders - Mac-like RAW image viewing which enables raw
image thumbnails, previewing and metadata display in Windows Explorer, plus
full-size viewing and slideshows in Windows Photo Viewer and Window Media
Center.

Improvements for Developers:

62.

New Networking API - Supports building SOAP-based web services in native
code.
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63

64.

65.

66.

67.

68.

69.

70.

71.

72.

73.

74.

75.

76.

. Shorten application install times

Reduced UAC prompts

Simplified development of installation packages

Improved Globalization Support - New Extended Linguistic Services API.

Support for 30-bit and 48-bit Color depths — Includes support for the wide color
gamut scRGB (which for HDMI 1.3 can be converted and output as xvYCC).

Video Modes Supported - 16-bit SRGB, 24-bit sSRGB, 30-bit sSRGB, 30-bit with
extended color gamut sRGB, and 48-bit scRGB.

Better Support For Solid-State Drives — Including the new TRIM command which
allows Windows 7 to identify a solid-state drive uniquely.

USB 3.0 - Microsoft is planning to support USB 3.0 in a subsequent patch,
support not being included in the initial release due to delays in the finalization
of the standard.[55]

Games Return - Internet Spades, Internet Backgammon and Internet Checkers,
which were removed from Windows Vista, were restored in Windows 7.

Internet Explorer 8 - Included in Windows 7.
Windows Media Player 12 - Included in Windows 7.

Disable Microsoft Products — Windows 7 allows users to disable Internet
Explorer, Windows Media Player, Windows Media Center, Windows Search, and
the Windows Gadget Platform.

13 Additional Sound Schemes - Titled Afternoon, Calligraphy, Characters,
Cityscape, Delta, Festival, Garden, Heritage, Landscape, Quirky, Raga, Savanna,
and Sonata.

Microsoft Virtual PC — Is included and allows multiple Windows environments,
including Windows XP Mode, to run on the same machine. Windows XP Mode
runs Windows XP in a virtual machine and redirects displayed applications
running in Windows XP to the Windows 7 desktop. Furthermore, Windows 7
supports the mounting of a virtual hard disk (VHD) as a normal data storage, and
the bootloader delivered with Windows 7 can boot the Windows system from a
VHD, only in the Professional and Ultimate editions however.
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77. Remote Desktop Protocol (RDP) - Is enhanced to support real-time multimedia
application including video playback and 3D games, thus allowing use of DirectX
10 in remote desktop environments.

Windows 7 - Positive Acceptance in the Marketplace:

- InJuly 2009, in only eight hours, pre-orders of Windows 7 at Amazon.co.uk
surpassed the demand Windows Vista had in its first 17 weeks.

- It became the highest-grossing pre-order in Amazon's history, surpassing
sales of the previous record holder, the seventh Harry Potter book.

- After 36 hours, 64-bit versions of Windows 7 Professional and Ultimate
editions sold out in Japan.

-  Two weeks after its release, it was announced that its market share had
surpassed that of Snow Leopard, released two months previously as the
most recent update to Apple's Mac OS X operating system.

- According to Net Applications, Windows 7 reached a 4% market share in less
than three weeks. In comparison, it took Windows Vista seven months to
reach the same mark.

- As of March 4, 2010, Microsoft announced that they had sold more than 90
million Windows 7 licenses.

- Reviews of Windows 7 were mostly positive, praising its usability when
compared to its predecessor, Windows Vista.

- CNET gave Windows 7 Home Premium a rating of 4.5 out of 5 stars, stating
that it "is more than what Vista should have been, it's where Microsoft
needed to go".

- PC Magazine rated it a 4 out of 5 saying that Windows 7 is a "big
improvement" over Windows Vista, with fewer compatibility problems, a
retooled taskbar, simpler home networking and faster start-up.

- Maximum PC gave Windows 7 a rating of 9 out of 10 and called Windows 7 a
"massive leap forward" in usability and security, and praised the new Taskbar
as "worth the price of admission alone".

- PC World called Windows 7 a "worthy successor" to Windows XP and said
that speed benchmarks showed Windows 7 to be slightly faster than
Windows Vista.

- PCWorld also named Windows 7 one of the best products of the year.

- Inits review of Windows 7, Engadget said that Microsoft has taken a "strong
step forward" with Windows 7 and reported that speed is one of Windows
7's major selling points particularly for the netbook sets.
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LAPTOP Magazine gave Windows 7 a rating of 4 out of 5 stars and said that
Windows 7 makes computing more intuitive, offered better overall
performance including a "modest to dramatic" increase in battery life on
laptop computers.

Techradar gave it a 5 star rating calling it the best version of Windows yet.

The New York Times, USA Today, The Wall Street Journal, and The Telegraph
also gave Windows 7 favorable reviews.

Windows 7 - Negative Acceptance in the Marketplace:

Some Vista Ultimate users have expressed concerns over Windows 7 pricing
and upgrade options. Windows Vista Ultimate users wanting to upgrade from
Windows Vista to Windows 7 must either pay $219.99 to upgrade to
Windows 7 Ultimate or perform a clean install, which requires them to

reinstall all of

their programs.

Windows 7 — Hardware Requirements:

Windows 7 reportedly requires lass RAM than Windows Vista to run well. Officially
presented below are Microsoft’s minimum hardware requirements to run Windows 7.

Architecture 32-bit 64-bit
Processor 1 GHz 32-bit processor 1 GHz 64-bit processor
Memory (RAM) 1 GB of RAM 2 GB of RAM

Graphics Card

DirectX 9 graphics processor with WDDM driver model 1.0 (For Aero)

HDD free space |16 GB of available disk space|20 GB of available disk space

Optical drive

DVD drive (only to install from DVD/CD Media)

Desktop Market Share As Of January 2010 (source: Wikipedia)

Windows XP -
Windows Vista -
Windows 7 -
Windows 2000 -
Windows NT -
Windows 98 -
Windows CE -
Windows Me -
Non-Windows -

66.31%
17.39%
7.51%
0.58%
0.11%
0.08%
0.06%
0.05%
7.98%
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Total Windows - 92.02%

Mac OS X 5.90%
Linux 1.12%
Other 1.96%

Microsoft Security Essentials (MSE)
http://www.microsoft.com/security essentials/

Microsoft Security Essentials (MSE) (previously codenamed Morro) is a free antivirus
software created by Microsoft that provides protection against viruses, spyware,
rootkits, and trojans for Windows XP (x86), Windows Vista, and Windows 7 (both x86
and x64). MSE replaces Windows Live OneCare, a commercial subscription-based
antivirus service and the free Windows Defender, which only protected users from
adware and spyware. It is geared for consumer use, unlike Microsoft's upcoming
enterprise-oriented product Microsoft Forefront.

Symantec and McAfee, two competing antivirus vendors, responded by claiming that
MSE is not as good as their own software. AVG Technologies viewed MSE positively,
stating it reinforced the company's ideal of free antivirus software. ARS Technica
reviewed it positively, citing its organized interface, low resource usage, and its status as
freeware.

Microsoft Forefront Client Security
http://technet.microsoft.com/en-us/bb738009.aspx

Forefront Client Security provides malware protection for business desktops, laptops,
and server operating systems. Microsoft claims the product offers simplified
administration through central management, critical visibility into threats and
vulnerabilities, and provides support for Windows Server 2008 roles. Product Pricing:

Component Estimated Prices Description

Microsoft Forefront Client Security §12.72 IS per user The Microsoft Forefront Client Security Agent is a malware protection agent

Agent or per device, per that is installed on business desktops, laptops, and servers that provides real-
year time protection from and scheduled scanning for viruses, spyware, and other

threats,

Microsoft Forefront Client Security £2,468 US per The Microsoft Forefront Client Security Management Console enables

Management Console with SQL SErver, per year administrators to easily manage the malware protection agents, to update

Server 2005 Enterprise Edition™ agents with the latest protection signatures, and to generate reports and

alerts on the security status of their environment.

Restricted for use with Foreffont

Clent Secuniy A single nstalation of the Management Console can fypicaly handle up fo
10,000 chents.
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Component Estimated Description
Price
Microsoft Forefront Client £98 US per The Microsoft Forefront Client Security Management Console enables administrators
Security Management Console SErVEr, per year to easily manage the malware protection agents, to update agents with the latest
protection signatures, and to generate reports and alerts on the security status of
This version of the their environment.
Management Console does
nof indude 5QL Server 2005 A single instalation of the Management Console can fypically handle up fo 10,000
dlients.

Windows Control Panel Settings

Windows 7’s Control Panel contains 53 tools that allow you to configure and control the
way Windows 7 looks and operates. You can view these tools in their newer categorized
view, or if you are old school like me and prefer the older look and feel, click the Classic
View option to display Control Panel as follows:

,(-\ - @ » Control Panel »

G
MName
Control Panel Home

» Classic View JEF; {é @
¥ ¥

Add Administrat...  AutoPlay B: Bluetooth Color Date and Default Device Ease of
Hardware Tools & Devices Management Time Programs Manager Acce...
- -3 . @ (& = 8
¥= ’ (1 _— J
7 " pus B 'w{’*’
] - ),A = e | =
Folder Fonts Game Indexing Internet iISCSI Initiator Java Keyboard Matrox Mouse
Options Controllers Options Options PowerDesk
[ [ A L | Al
i & | (& | =\
Network and Parental Pen and People Near  Performance \ Personaliz.. / Phone and Printers Problem
Controls Input Devices Me Informatio... Modem ... Reports a.

Sharing Ce,

k) &
Programs Realtek HD
wod Featurg?  Audic M...

g i
Tablet PC Taskbar and
Settings Start Menu

Scanners and Security Sound Sync Center
Cameras Center Recogniti..

& 4 & 08 =

View 32-bit Welcome Windows Windows Windows
Control P... Center Anytim... CardSpace Defender

0

Speech

Windows
Firewall

Windows Windows Windows
Sidebar ... SideShow Update

While all of these tools have utility, I've circled those tools which | would like to discuss
in class.

Before delving into Control Panel, it is helpful to understand that Windows 7 saves all of
your setting adjustments in the Registry. You can view your Registry by typing REGEDIT
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in the Start Search Box. This is a rather cryptic set of folders and honestly, Microsoft
does not want you messing around with the Registry unless you really know what you
are doing. Here is what the Registry looks likes:

4 Registry Editor (P

File Edit View Favorites Help
Schema [ Name Type Data
zzcr-—ur\me 28] (Ocfaut) REG_SZ (value not set)
st Dncrie. o et

8] ActiveTitle
“ HKE;’EL;EJRLST 25| AppWorkSpace  REG_SZ 128128128
i 2k Background REG_SZ 58110165
W s1s1 2| ButtonAlternate... REG_SZ 181181 181
AppEvents 25| ButtonDkShadow  REG_SZ 64 6464
Console ] ButtonFace REG 57 212 208 200
4.1, Control Panel ab|ButtonHilight  REG 57 255 255 255
i) Accessibility a5 ButtonLight REG 57 212 208 200
2.} Appearance al] ButtonShadow  REG_SZ 128128128
Schemes 2] ButtonTed REG_SZ 000
Colors 25| GradientActiveT... REG_SZ 166 202240
Desktop 25| Gradientnactive... REG_SZ 192162162
4 - Infrared ab| GrayText REG_SZ 128128128
| File Transf: ab] Hilight REG_SZ 10 36 106
Global a5 HilightText REG_SZ 255255 255
IrTranP ab) HotTrackingColor REG_SZ 00128
InputMethod | it ctiveBorder  REG_SZ 212 208 200
Intemational b InactiveTitle REG_SZ 12818128
’:::::'d ab|TnsctiveTitleTet  REG_SZ 212 208 200
Pomerchs ab]InfoText REG 57 000
i 3 InfoWindow REG_SZ 255255 225
_____ Emvironment 2] Meny REG_SZ 212 208 200
e a6 MenuText REG_SZ 000
Keyboard Layout || 28] Scrollbar REG 57 212 208 200
..... Network At TitleText REG 57 255 255 255
Printers a5 Window REG 57 255255 255
Software abWindowFrame  REG_SZ 00
5-1-5-20 HWindowTet  REGSZ 000
5-1-5-21-506983693-4
§-1-5-21-506983693-4
HKEY_CURRENT_CONFIG —
JCm v
Computen HKEY_USERS\S-1-5-19\Control PanehColors

What | want you to know is that as you make adjustments in Control Panel, those
adjustments are recorded in the registry, usually with a series of “0” or “1” answers to
setting questions. If you wanted to, you could accelerate your mouse by adjusting the
Registry settings — but why? The graphical Control Panel tool is much easier to use, and
it adjusts the Registry for you.

This understanding is helpful in terms of backing up or restoring the registry. When you
create a Restore Point using the System Restore option, all it really does is make a copy
of the Registry. Thereafter, if your computer or an application stops working correctly,
or if you get a virus, you can restore a previous Restore Point which simply copies the
older Registry settings back to you Registry.

Control Panel Materials
| have prepared an extensive set of materials that walks you through the Control Panel
tools, but they were too voluminous to reprint here. To access these materials please

use the following link:

www.ASAResearch.com/web/controlpanel.htm
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God Mode

(Apologies to anyone who might be offended by this use of the Word God, | did not come up with this terminology)

Windows 7 has many settings to adjust how Windows operates. The majority of these
settings adjustments must be made using the Windows Control Panel. Although Control
Panel does a good job of organizing the various tools, it can be a little difficult to use
because often you must toggle back in forth between windows. There is a way that gives
you all adjustment options in one place... and it’s called Windows 7 “God Mode”.

To set up God Mode, first create a new folder on your desktop. Next,
change the name of the New folder by right clicking on the folder, select
Properties from the drop down menu, under the General tab select the y
name of the folder text box and type in the following code to change the )-
name of the folder:

GodMode.{ED7BA470-8E54-465E-825C-99712043E01C}

Now, the folder should have changed from the default blank folder icon to a Control
Panel looking icon.

e=

iGodMode

Thereafter, when you double click on the “God Mode” icon to open it, you will notice
that it looks similar to the Control Panel window, with all options placed in single list.
This allows you to view all the Windows 7 settings in one spot as shown below.
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Windows 7 Tips

1. Problem Steps Recorder - When an application starts misbehaving in Windows 7,
click Start, type PSR and press Enter, then click Start Record. Thereafter the Problem
Steps Recorder will record every click, record screen shots, and package the
information into a zipped MHTML file. This recorded history could save you hours of
troubleshooting time.

2. Burn Images - Windows 7 provides the ability to burn your entire hard drive
(referred to as an ISO image) to CDs or DVDs. Just double-click the ISO image, choose
the drive with the blank disc, click Burn and watch as your disc is created.

http://windowsteamblog.com/blogs/windowsexperience/archive/2009/04/13/burn-iso-images-natively-in-windows-7.aspx

3. Switch to a Projector - Windows 7 now provides a standard way to switch your
display from one monitor to another, or a projector - just press Win+P or run
DisplaySwitch.exe and choose your preferred display.

4. Power Efficiency Report — On a laptop, the efficiency calculator will generate a
report containing useful information about its power consumption. Used in the right
way, this can help you adjust your settings to improve battery life and performance.
To do this open a command prompt as an administrator by typing '‘cmd' in Start
Search, and when the cmd icon appears, right-click it and choose Run as
administrator. Then at the command line, type in '‘powercfg -energy' (without
guotes) and press Return. Windows 7 will scan your system searching for ways to
improve power efficiency and it will then publish the results in an HTML file.

5. Improved System Restore - System Restore in previous versions of Windows fell
short because there was no way of telling which applications or drivers it might
affect - you just have to try it and see. In Windows 7 provides improved option
which 'Scans for affected programs' and tells you which (if any) programs and drivers
will be deleted or recovered by selecting this restore point.

6. Set Time Zone - The new command line tzutil.exe utility enables you set a PC's time
zone from scripts, which is faster for administrators to use. If you wanted to set a PC
to Greenwich Mean Time, for instance, you'd use the commandtzutil /s "gmt
standard time". The command "tzutil /g" displays the current time zone, "tzutil /I"
lists all possible time zones, and "tzutil /?" displays details on how the command
works.

7. Calibrate Your Screen - The colors you see on your screen will vary depending on
your monitor, graphics cards settings, lighting and more, yet most people use the
same default Windows color profile. Windows 7 now provides a Display Color
Calibration Wizard that helps you properly set up your brightness, contrast and color
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11.

settings, and a ClearType Tuner to ensure text is crisp and sharp. Click Start, type
DCCW.

Add Network Support - By default Windows Live MovieMaker won't let you import
files over a network, but a quick Registry tweak will change this. Run REGEDIT,
browse to HKEY_CURRENT_USER\Software\Microsoft\Windows Live\Movie Maker,
add a DWORD value called AllowNetworkFiles and set it to 1 to add network
support.

Activate XP Mode - If you have old but important software that no longer runs
under Windows 7, then you could try using XP Mode, a virtual copy of XP that runs
in a window on your Windows 7 desktop. VirtualBox is a virtualization tool that will
allow you to install a licensed copy of XP in its own Window to create a virtual
machine.

Enable virtual Wi-Fi - Windows 7 includes a little-known new feature called Virtual
Wi-Fi, which effectively turns your PC or laptop into a software-based router. Any
other Wi-Fi-enabled devices within range - a desktop, laptop, an iPod perhaps - will
"see" you as a new network and, once logged on, immediately be able to share your
internet connection. This will only work if your wireless adapter driver supports it,
though, and not all do.

Once you have driver support then the easiest approach is to get a network tool that
can set up virtual Wi-Fi for you. Virtual Router (below) is free, easy to use and should
have you sharing your internet connection very quickly.

A Wit Bouter Macager ¥0.5 Brta

I Virtual Router Manager v0.9E

Wikl R SETNAGL

Turn Your Windows 7 Laptop Into A Wireless Hotspot — Warning - This is awkward
to set up, and prone to complicated security and reliability issues, so most people
don't even try. If you do try it, once it's set up, then any Wi-Fi compatible device that
can connect to you - another desktop, laptop, or an iPod Touch, say - will
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immediately be able to get online, by sharing your internet connection through a
duplicate of your wireless adapter.

The first hurdle is to find a virtual Wi-Fi-compatible driver for your wireless adapter.
Intel's latest 32-bit and 64-bit drivers now include support, as do various others for
Atheros, Broadcom, Realtek and other big players, but these don't apply to every
chipset. Check the support site for your wireless adapter to see what's available.

The next step is to click Start, type CMD, right-click the Cmd.exe link and select "Run
as Administrator". Type the following command:

netsh wlan set hostednetwork mode=allow ssid=MyNet key=MyPassword

Replace "MyNet" with the name you'd like to use for your custom network, and
"MyPassword" with your own password. To launch the virtual adapter, at the
command line, type:

netsh wlan start hostednetwork

Now click Control Panel; Network and Internet; Network and Sharing Centre;
Change Adapter Settings, right-click your internet connection and select Properties.
Click the Sharing Tab, check "Allow other network users to connect...", choose your
virtual Wi-Fi adaptor - and that's it. Any nearby Wi-Fi enabled device should see a
new network appear with the SSID you defined above. They'll be able to connect to
it using your password, and can then immediately share your internet connection.

Right-click Everything — Windows 7 is full of new right-click capabilities. Right-click
an empty part of the desktop, for instance, and you'll find a menu entry to set your
screen resolution. Right-click the Explorer icon on the taskbar for speedy access to
common system folders: Documents, Pictures, the Windows folder, and more.

Display old Taskbar Button & Menu - There's an easy way to get the old context
menu back - just hold down Ctrl and Shift as you right-click the taskbar button.

Desktop Slideshow - Windows 7 provides some attractive new wallpapers and
Windows can display them or your own pictures in a desktop slideshow. To do this,
Right-click an empty part of the desktop, select Personalize > Desktop Background,
then hold down Ctrl as you click on the images you like. You can also set how often
you'd like the images to be changed (anything from daily to once every 10 seconds)
Select Shuffle if you'd like the backgrounds to appear in a random order.
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15. Customize the log-on Screen - Changing the Windows log-on screen used to
involve some complicated and potentially dangerous hacks, but not anymore -
Windows 7 makes it fairly easy.

1. Launch REGEDIT.

2. Browse to:
HKEY_LOCAL_MACHINE\Software\Microsoft\Windows\CurrentVersion\Authentication\LogonUI\Background

3. Double-click the DWORD key called OEMBackground (not there? Create it)
and set its value to 1.

4. Now find a background image you'd like to use. Make sure it's less than
256KB in size, and matches the aspect ratio of your screen as it'll be
stretched to fit.

5. Next, copy that image into the %windir%\system32\oobe\info\backgrounds
folder (create the info\backgrounds folders if they don't exist).

6. Rename the image to backgroundDefault.jpg, reboot, and you should now
have a custom log-on image.

Alternatively, you could use a free tweaking tool to handle everything for you.
Logon Changer displays a preview so you can see how the log-on screen will look
without rebooting, while the Logon Screen Rotator accepts multiple images and
will display a different one every time you log on.

16. Recover Screen Space -The new Windows 7 taskbar acts as one big quick launch
toolbar that can hold whatever program shortcuts you like (just right-click one
and select Pin To Taskbar). And that's fine, except it does consume a little more
screen real estate than we'd like. You can shrink it to a more manageable size by
right-clicking the Start orb, then Properties > Taskbar > Use small icons > OK.

17. Retro Taskbar - If you prefer the more traditional taskbar, right-click the taskbar,
select Properties, and set Taskbar Buttons to "Combine when taskbar is full".

Page 38 Copyright 2010, All Rights Reserved



www.CarltonCollins.com Microsoft Office & Windows 7 for CPAs

18.

19.

20.

21.

22.

23.

You'll now get a clear and separate button for each running application, making
them much easier to identify.

Remove Taskbar Buttons - One problem with the previous tip is the buttons will
gobble up valuable taskbar real estate, but you can reduce the impact of this by
removing  their text  captions. Launch REGEDIT, browse to
HKEY_CURRENT_USER\Control Panel\Desktop\WindowMetrics, add a string
called MinWidth, set it to 54, and reboot to see the results.

Restore the Quick Launch Toolbar - If you're unhappy with the new taskbar,
even after shrinking it, then it only takes a moment to restore the old Quick
Launch Toolbar. Right-click the taskbar, choose Toolbars > New Toolbar, type

“%UserProfile%\AppData\Roaming\Microsoft\Internet Explorer\Quick
Launch"

(without the quotes) into the Folder box and click Select Folder. Right-click the
taskbar, clear 'Lock the taskbar', and you should see the Quick Launch Toolbar,
probably to the right. Right-click its divider, clear Show Text and Show Title to
minimize the space it takes up. Complete the job by right-clicking the bar and
selecting View; Small Icons for the true retro look.

Custom Power Switch - By default, Windows 7 displays a plain text 'Shut down'
button on the Start menu, but it only takes a moment to change this action to
something else. If you reboot your PC a few times every day then that might
make more sense as a default action: right-click the Start Orb, select Properties
and set the 'Power boot action' to 'Restart' to make it happen.

Auto Arrange Your Desktop - If your Windows 7 desktop has icons scattered
everywhere then you could right-click it and select View; Auto arrange, just as in
Vista. But a simpler solution is just to press and hold down F5, and Windows will
automatically arrange its icons for you.

Disable Smart Window Arrangement - Windows 7 features interesting new ways
to intelligently arrange your windows. For example, if you drag a window to the
top of the screen then it will maximize. If you find this distracting then you can
disable this behavior by running REGEDIT, go to HKEY_CURRENT_USER\Control
Panel\Desktop, set WindowArrangementActive to 0, reboot, and your windows
will behave just as they always did.

Browse Your Tasks - If you prefer using your keyboard more than your mouse,
you will love browsing the taskbar using this nifty shortcut. Press Windows and
T, and you move the focus to the left-most icon on the taskbar. Then use your

Copyright 2010, All Rights Reserved Page 39



Microsoft Office & Windows 7 for CPAs www.CarltonCollins.com

24,

25.

26.

27.

28.

29.

30.

arrow keys to change the focus to other icons, and you get a live preview of
every window.

Display Your Drives — Empty drives such as memory card readers are no longer
displayed when they are empty. | like the improvement, but if you disagree then
it's easy to get your empty drives back. To do this, launch Explorer, click Tools;
Folder Options; View and clear 'Hide empty drives in the computer folder'.

See More Detail - The improved Windows 7 magnifier offers an easier way to
zoom in on any area of the screen. Launch it and you can now define a scale
factor and docking position. Once activated, it can track your keyboard focus
around the screen. Press Tab as you move around a dialog box, say, and it'll
automatically zoom in on the currently active control.

Hiding the Windows Live Messenger Icon - If you use Windows Live Messenger a
lot, you'll have noticed that the icon now resides on the taskbar, where you can
easily change status and quickly send an IM to someone. If you prefer to keep
Windows Live Messenger in the system tray, where it's been for previous
releases, just close Windows Live Messenger, edit the shortcut properties and
set the application to run in Windows Vista compatibility mode.

Customize UAC - Windows Vista's User Account Control was a good idea in
practice, but poor implementation put many people off - it raised far too many
alerts. Fortunately Windows 7 displays less warnings by default, and lets you
further fine-tune UAC to suit your preferred balance between security and a
pop-up free life (Start > Control Panel > Change User Account Control Settings).

Sticky Notes - The Sticky Notes application is more useful in Windows 7. Launch
StikyNot.exe and you can type notes at the keyboard; right-click a note to change
its color; click the + sign on the note title bar to add another note; and click a
note and press Alt + 4 to close the note windows (your notes are automatically
saved).

Open Folder In New Process - By default Windows 7 opens folders in the same
process. This saves system resources, but means one folder crash can bring
down the entire shell. If your system seems unstable, or you're doing something
in Explorer that regularly seems to causes crashes, then open Computer, hold
down Shift, right-click on your drive and select Open in New Process. The folder
will now be launched in a separate process, and so a crash is less likely to affect
anything else.

Watch More Videos - Windows Media Player 12 is a powerful program, but it
still won't play all the audio and video files you'll find online. Fortunately the first
freeware Windows 7 codecs package [shark007.net/win7codecs.html] has been
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released, and installing it could get your troublesome multimedia files playing
again.

Preview Fonts - Open the Fonts window in Windows XP and Vista and you'll see
the font names, probably with icons to tell you whether they're TrueType or
OpenType, but that's about it. Windows 7 provides some useful font-related
improvements by providing a preview for every font, giving you a quick idea of
how its’ going to look. The tedium of scrolling through multiple entries for each
family, like Times New Roman, Times New Roman Bold, Times New Roman Bold
Italic and so on, has finally ended. There's now just a single entry for each font
(though you can still see all other members of the family). And there's a new
OpenType font, Gabriola, added to the mix. It's an attractive script font, well
worth a try the next time you need a stylish document that stands out from the
crowd.

Restore Your Gadgets - Windows 7 has tightened up its security by refusing to
run gadgets if UAC has been turned off, so limiting the damage malicious
unsigned gadgets can do to your system. If you've disabled UAC, miss your
gadgets and are happy to accept the security risk, though, there's an easy
Registry way to get everything back to normal. Run REGEDIT and go to:

HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Sidebar\Settings

Create a new DWORD value called AllowElevatedProcess and set it to 1. Your
gadgets should start working again right away.

New WordPad formats - By default WordPad will save documents in Rich Text
Format, just as before. But you can browse the “Save As” Format list and you'll
see you can also save (or open, actually) files in the Office 2007 .docx or
OpenDocument .odt formats.

Protect your data - USB flash drives are convenient, portable, and very easy to
lose. Which is a problem, especially if they're carrying sensitive data. Fortunately
Windows 7 has the solution: You can encrypt your documents with an extension
of Microsoft's BitLocker technology, and only someone with the password will be
able to access it. Right-click your USB flash drive, select Turn on BitLocker and
follow the instructions to protect your private files.
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35. Configure Your Favorite Music - The Windows 7 Media Centre now comes with
an option to play your favorite music, which by default creates a changing list of
songs based on your ratings, how often you play them, and when they were
added (it's assumed you'll prefer songs you've added in the last 30 days). If this
doesn't work then you can tweak how Media Centre decides your "favorite"
tunes. To do this click Tasks; Settings; Music; Favorite Music and configure the
program to suit your needs.

36. Customize System Restore - There was very little you could do to configure
System Restore in Vista, but Windows 7 improves the situation with a couple of
useful setup options. Click the Start Orb, right-click Computer and select
Properties; System Protection; Configure, and set the Max Usage value to a size
that suits your needs (larger to hold more restore points, smaller to save disk
space). And if you don't need System Restore to save Windows settings then
choose the "Only restore previous versions of files" option. Windows 7 won't
back up your Registry, which means you'll squeeze more restore points and file
backups into the available disk space. System Restore is much less likely to get an
unbootable PC working again, though, so use this trick at your own risk.

37.Run As - Hold down Shift, right-click any program shortcut, and you'll see an
option to run the program as a different user, which might be handy if you're
logged in to the kids' limited account and need to run something with higher
privileges. This isn't really a new feature - Windows XP had a Run As option that
did the same thing - but Microsoft stripped it out of Vista, so it's good to see
them bring it back.
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Search Privacy - By default Windows 7 will remember your PC search queries,
and display the most recent examples when searching in Windows Explorer. If
you're sharing a PC and don't want everyone to see your searches, then launch
GPEDIT.MSC, go to User Configuration; Administrative Templates; Windows
Components; Windows Explorer, double-click "Turn off display of recent search
entries..." and click Enabled; OK.

Tweak PC Volume - By default Windows 7 will now automatically reduce the
volume of your PC's sounds whenever it detects you're making or receiving PC-
based phone calls. If this proves annoying (or maybe you'd like it to turn off
other sounds altogether) then you can easily change the settings accordingly.
Just right-click the speaker icon in your taskbar, select Sounds; Communications,
and tell Windows what you'd like it to do.

Rearrange The System Tray - With Windows 7 we finally see system tray icons
behave in a similar way to everything else on the taskbar. So if you want to
rearrange them, then go right ahead, just drag and drop them into the order you
like. You can even move important icons outside of the tray, drop them onto the
desktop, then put them back when you no longer need to keep an eye on them.

Write Crash Dump Files - Windows 7 won't create memory.dmp crash files if
you've less than 25GB of free hard drive space, annoying if you've installed the
Windows debugging tools and want to diagnose your crashes. You can turn this
feature off, though: browse to
HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\CrashControl,
create a new DWORD value called AlwaysKeepMemoryDump, set it to 1, and the
crash dump file will now always be saved.

Find Bottlenecks - From what we've seen so far Windows 7 is already performing
better than Vista, but if your PC seems sluggish then it's now much easier to
uncover the bottleneck. Click Start, type RESMON and press Enter to launch the
Resource Monitor, then click the CPU, Memory, Disk or Network tabs. Windows
7 will display the processes that are hogging the most system resources. The CPU
view is particularly useful, and provides something like a more powerful version
of Task Manager. If a program has locked up, for example, then right-click its
name in the list and select Analyze Process. Windows will then try to tell you why
it's hanging - the program might be waiting for another process, perhaps - which
could give you the information you need to fix the problem.
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43. Keyboard Shortcuts - Windows 7 supports
shortcuts, as follows:
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several new keyboard

- Alt+P - Display/ hide the Explorer preview pane

Windows Logo+G - Display gadgets in front of other windows
Windows Logo++ (plus key) - Zoom in, where appropriate
Windows Logo+- (minus key)- Zoom out, where appropriate
Windows Logo+Up - Maximize the current window
Windows Logo+Down - Minimize the current window
Windows Logo+Left - Snap to the left hand side of the screen

- Windows Logo+Right - Snap to the right hand side of the screen
- Windows Logo+Home - Minimize/ restore everything except the current

window

44. Drag And Drop To The Command Line - When working at the command line
you'll often need to access files, which usually means typing lengthy paths and
hoping you've got them right. But Windows 7 offers an easier way. Simply drag
and drop the file onto your command window and the full path will appear,
complete with quotes and ready to be used. This feature isn't entirely new: you
could do this in Windows XP, too, but drag and drop support disappeared in
Vista. There does seem to be a new Windows 7 complication, though, in that it
only seems to work when you open the command prompt as a regular user. Run
cmd.exe as an administrator and, while it accepts dropped files, the path doesn't

appear.
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Customize Your Jumplists - Right-click an icon on your taskbar, perhaps
Notepad, and you'll see a jumplist menu that provides easy access to the
documents you've been working on recently. But maybe there's another
document that you'd like to be always available? Then drag and drop it onto the
taskbar icon, and it'll be pinned to the top of the jumplist for easier access. Click
the pin to the right of the file name, or right-click it and select "Unpin from this
list" when you need to remove it.

Faster Redundant Program Launches - If you've launched one instance of a
program but want to start another, then don't work your way back through the
Start menu. It's much quicker to just hold down Shift and click on the program's
icon (or middle-click it), and Windows 7 will start a new instance for you.

Speedy Video Access - Want faster access to your Videos folder? Windows 7
now lets you add it to the Start menu. Just right-click the Start Orb, click
Properties; Start Menu; Customize, and set the Videos option to "Display as a
link". If you've a TV tuner that works with Windows 7 then you'll appreciate the
new option to display the Recorded TV folder on the Start menu, too.

Run Web Searches - The Windows 7 search tool can now be easily extended to
search online resources, provided you create an appropriate search connector.
To add Flickr support, say, visit | Started Something, click Download the
Connector, choose the Open option and watch as it's downloaded (the file is
tiny, it'll only take a moment). A "Flickr Search" option will be added to your
Searches folder, and you'll be able to search images from your desktop. A
multitude of other ready-made searches, such as Google and YouTube, can be
downloaded from the windowsclub.com website.

Schedule Media Center Downloads - You can now tell Windows Media Center to
download data at a specific time, perhaps overnight, a useful way to prevent it
from zapping your bandwidth for the rest of the day. Launch Media Center, go to
Tasks; Settings; General; Automatic Download Options, and set the download
start and stop times that you'd like it to use.

Multi-threaded Robocopies - Anyone who's ever used the command-line
robocopy tool will appreciate the new switches introduced with Windows 7. Our
favorite, /MT, can improve speed by carrying out multi-threaded copies with the
number of threads you specify (you can have up to 128, though that might be
going a little too far). Enter robocopy /? at a command line for the full details.

Load IE Faster - Some Internet Explorer add-ons can take a while to start,
dragging down the browser's performance, but at least IE8 can now point a
finger at the worst resource hogs. Click Tools; Manage Add-ons, check the Load
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52.

53.

54.

55.

56.

57.

Time in the right-hand column, and you'll immediately see which browser
extensions are slowing you down.

An Alt+Tab Alternative - You want to access one of the five Explorer windows
you have open, but there are so many other programs running that Alt+Tab
makes it hard to pick out what you need. The solution? Hold down the Ctrl key
while you click on the Explorer icon. Windows 7 will then cycle through the
Explorer windows only, a much quicker way to locate the right one. And of
course this works with any application that has multiple windows open.

Block Annoying Antivirus or Firewall Warnings - Just like Vista, Windows 7 will
display a suitably stern warning if it thinks your antivirus, firewall or other
security settings are incorrect. But unlike Vista, if you disagree then you can now
turn off alerts on individual topics. If you no longer want to see warnings just
because you've dared to turn off the Windows firewall, say, then click Control
Panel; System and Security; Action Centre; Change Action Centre settings, clear
the Network Firewall box and click OK.

Parallel Defrags - The standard Windows 7 defragger offers a little more control
than we saw in Vista, and the command line version also has some interesting
new features. The /r switch will defrag multiple drives in parallel, for instance
(they'll obviously need to be physically separate drives for this to be useful). The
/h switch runs the defrag at a higher than normal priority, and the /u switch
provides regular progress reports so you can see exactly what's going on. Enter
the command defrag /c /h /u /r in a command window to speedily defrag a
system with multiple drives, or enter defrag /? to view the new options for
yourself.

Fix Explorer - The Windows 7 Explorer has a couple of potential annoyances. For
example, launching your Computer windows will no longer display system
folders like Control Panel or Recycle Bin. And if you're drilling down through a
complicated folder structure in the right-hand pane of Explorer, the left-hand
tree won't always expand to follow what you're doing, which can make it more
difficult to see exactly where you are. Fortunately there's a quick fix: click
Organize; Folder and Search Options, check "Show all folders" and
"Automatically expand to current folder", and click OK.

Faster File Handing - If you hold down Shift while right-clicking a file in Explorer,
then you'll find the Send To file now includes all your main user folders:
Contacts, Documents, Downloads, Music and more. Choose any of these and
your file will be moved there immediately.

Create Folder Favorites - If you're regularly working on the same folder in
Explorer then select it in the right-hand page, right-click Favorites on the left-
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hand menu, and select Add to Favorites. It'll then appear at the bottom of the
favorites list for easy one-click access later.

58. Disable Hibernation - By default Windows 7 will permanently consume a chunk
of your hard drive with its hibernation file, but if you never use sleep, and always
turn your PC off, then this will never actually be used. To disable hibernation and
recover a little hard drive space, launch REGEDIT, browse to:

HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\Power

Set both HibernateEnabled and HiberFileSizePerfect to zero.
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Microsoft Office 2010
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What’s New in Microsoft Office 2010?

Microsoft has announced that it will begin shipping Office 2010 in Spring 2010. This begs
the question, what’s new in Office 2010? The short answer is that there are a dozen or
so interesting improvements each in Word, Excel, PowerPoint, and Access - but for the
most part Office’s core products are unchanged. This is because when Office 2007 was
released in January 2007, the new menus only appeared in 4.5 of the applications —
Word, Excel, Access, PowerPoint and half of Outlook. With Office 2010, Microsoft has
brought the other applications up-to-date with the newer menu style as well. Therefore
don’t expect to see many differences in Word, Excel, Access, or PowerPoint. However,
these are a few improvements Office 2010’s core products, as follows:

What’s New in Excel 2010?

1. Sparklines — Sparklines are small cell-sized charts that you can embed in a
worksheet next to data to get a quick visual representation of the data. For
example, if you had a worksheet that tracked the performance of several dozen
stocks, you could create a Sparkline for each stock that graphed its performance
over time, in a very compact way. Here is an example:

i e S

Column Line Pie Ear

2. Conditional Formatting Improvements — Microsoft has improved and added
more styles and icons regarding the ability to apply a format to a range of cells,
and then have the formatting change according to the value of the cell or
formula.

3. Improved Sharing — As with all of the Office 2010 applications, Excel 2010 has
new and improved tools for sharing data with other people, including multiple
people working on a document at a time.

4. Millions of Rows - Microsoft now offers Project Gemini add-on for Excel 2010
that can handle very large amounts of data -- even worksheets that include
hundreds of millions of rows. It will ship as part of SQL Server 2008 R2 in the first
half of 2010; a community technology preview will be available in the second
half of 2009.

5. Enhanced Ribbon Toolbar - The Ribbon tool bar has been enhanced to be highly
customizable now.

Copyright 2010, All Rights Reserved Page 49



Microsoft Office & Windows 7 for CPAs

www.CarltonCollins.com

Gensral
Formulas

Pracfing

Save
Language

Advanced

Quick Access Toolbar
Add-Ins

Trust Center

Custamize fibbon

||] Customize the Ribbon.

aose commands fram:
ypular Commands

All Chart Types
Calculate Now
Caloulate Sheet
Custom Sort
Delete Cells

" Delete Sheet Columns
Delete Sheet Rows
E-mail
Format Celis
Hyperlink

* Inmsert Cells

" Insert Sheet Columns
Insert Shest Rows
Macros
MNew

[ _Open

El

Customize the Rifbon:
Main Tabs

Main Tabs
= ¥ Home
* Clipboard
# Font
£ Algnment
= Number
¥ Styles
® Cells
= Editing
= || ngert
& [ Pase | syt

| MNewTab | | Hew Group | l Renape... I

Customizations: | Restare Defaults =

6. Compatibility of .xlsx - In Excel 2007, Microsoft introduced a new XML format
(.xIsx) which was not compatible with former .xIs spreadsheet formats. This
problem has been resolved - Excel files created in Excel 2010 may easily be
opened in versions of Excel prior to Excel 2007. Now Excel 2010 will save files
just as safe as the former Excel 2007, and the spreadsheet size is 75% smaller
than the old .XLS version.

7. Protected Mode - Each time you download a document , Microsoft Office 2010
automatically opens it in Protected Mode which means that Excel will not allow you to
edit the documents unless document editing is enabled. To do this, click the Enable
Editing option in order to enable document editing as shown in the following screen

shot.

'F" Protected View  This file originated from an Internet location. w
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7. Slicer - The Slicer feature provides new slice and dice capabilities within
PivotTables — this helps you dynamically segment and filter the data. This feature
is located on the Insert Tab.

Q ﬂ 2 Al wordart - Q

2% Signature Line -
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Links Text Symbols
Insert Shicer |
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8. Macro - Macros in Excel 2010 now support working with shapes, including
creating, moving or editing shapes.

9. Enhanced Chart Diagram - In Excel 2010 double clicking a chart element
automatically opens the chart’s format dialog box.

10. Web Version of Excel 2010 — A new web version of Excel 2010 allows you to
create, edit and save spreadsheet via your web browser directly and share them
online. The web version reportedly will be available for free to everyone who has
Windows Live account. The web version is as same as the Excel 2010 on desktop,
with some of Excel functionality disabled.

11. 64-bit version of Excel 2010 - Excel 2010 is now available in a 64-bit version,
which means that it can take full advantage of your computer’s 64-bit
motherboard and access more than 4 GBs of RAM. The result is even faster
performance.

12. Microsoft SQL Server PowerPivot for Excel - Excel 2010 now includes an add-in
tool called Microsoft SQL Server PowerPivot which is a Business Intelligence tool
that enables you to query multiple SQL Server databases across multiple
corporate systems and web data on a real-time basis to produce PivotTables that
can be shared via SharePoint. You can try this online at the following Virtual Labs
web site: https://cmg.vlabcenter.com/prepare.aspx?moduleid=ad3bd3e9-8d2b-
498d-94fa-e41e1b09730d&ticks=633992819904236083.
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13. Named Sets - Named Sets have been added to Microsoft Excel 2010, allows
you to create your own named sets. Simply locate the Fields, Items, & Sets
button under the Ribbon, and it will allow you to define your own Named Sets.

What’s New in Word 2010?

1. Office Button Is Gone — Microsoft has replaced the Office button in the most
recent Word 2010 beta with the File tab, which | think better fits into the
interface.

2. Print Preview Has Moved — Microsoft moved the Print command to the File Tab
menu. Choosing that command displays a Print window, and the Print Preview is
now located on the right side of the window. | think it is a good improvement,
but a lot of folks will probably wander around Word 2010 looking for the Print
Preview command.

3. Menu Options Disappear - Many of the lesser-used command buttons are gone
or have been replaced. It takes a little getting used to.

4. Navigation Pane - Document Map has been renamed Navigation pane — what a
pane?

5. New Find Command - Instantly highlights all instances of the text you’re
searching for. Unfortunately, Ctrl+F now launches the Navigation pane and not
the Find Dialog Box. Launching the Find dialog box is now a little awkward; you
have to go to the Find & Replace dialog box, then backtrack to the Find dialog
box.

6. Mail Merge - Microsoft has changed the mail merge feature in that the “address
list” is now called the “recipient list.” Also, the main document is no longer the
“main document,” it now has no name.

7. Customize Ribbons - You can now customize the Ribbons in Word. You cannot
change Word'’s tabs and groups, but you can add your own custom group to any
of Word’s tabs, or create your own tab, and place your favorite commands into
those groups.

What’s New in PowerPoint 2010?

1. Office Button Is Gone — Microsoft has replaced the Office button in the most
recent Word 2010 beta with the File tab, which | think better fits into the
interface.
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2. Macro Recorder — Microsoft has brought back the macro recorder capability in
PowerPoint which disappeared in Office 2007.

3. Permissions — PowerPoint 2010 allows you to protect the presentation by setting
permissions on the File tab.

4. Transitions Tab - Slide transitions have always been a part of PowerPoint.
However, the Transitions tab is new to the PowerPoint 2010 ribbon.

5. Animation Painter - Microsoft has created a tool that works similarly to the
Format Painter, which has been around as long as | have been using any Office
products. The Animation Painter will copy all the animation features of an object
to; another object, another slide, multiple slides or to another presentation. This
is a real time-saver as you do not have to add all these animation properties
separately to each object. The added bonus is many fewer mouse clicks.

6. Broadcast Slide Show Feature - PowerPoint 2010 now offers the ability to share
your presentation over the internet to anyone in the world. By sending a link to
the URL of your presentation, your global audience can follow along in their
browser of choice. The viewers need not have PowerPoint installed on their
computer.

7. Minimize the Ribbon - This is a small feature, you can hide the ribbon using a
tiny button to do it with less clicks of the mouse.

8. Embed a Video or Link to a Video - PowerPoint 2010 now offers the option to
embed or link to a video (which is currently located on your computer) into your
presentation, or to link to a video on a website, such as YouTube. Embedding a
video which is located on your computer saves a lot of anguish if you later move
or send your presentation to another location. Embedding the video means that
it always stays with the presentation, so you don't have to remember to also
send the video file along. The video can be of an actual "movie" type or you can
also embed an animated GIF type of clip art.

9. Linking To A Video — Linking rather than embedding greatly reduces the file size
of the overall presentation. However, you take the risk of forgetting to copy over
the video file when you move the presentation to another location. When you
link to a video on the web, such as YouTube, the video is not really in your
presentation, so you will always need an internet connection in order to view the
video.

10. Turn PowerPoint 2010 Presentations into Videos - Microsoft has realized the
need to be able to convert a presentation into a video, without the use of third
party software. Users of PowerPoint have been asking for this for years, and at
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long last the feature is present in PowerPoint 2010. Advantages of Converting a
PowerPoint 2010 Presentation into Video:

Q

The WMV video file format can be read by most computers.

b. You can still use other software to convert the presentation into other file
formats (such as AVI or MOV for example) if you choose.

c. Any transitions, animations, sounds and narration will be embedded into
the video.

d. The video can be published to a website or emailed. It is not editable, so
the entire presentation will always remain as the author intended.
You can control the file size of the video by selecting appropriate options.

f. The targeted audience does not need to have PowerPoint installed on

their computer in order to view the video.

What’s New in Outlook 2010?

1. Ribbon - While the ribbon introduced in Office 2007 is still present, in Outlook
2010, it’s evolved into a cleaner and easier-to-use interface.

2. New Conversation View - A new view in the inbox pane has been created called
the conversation view. With it, messages are sorted not just by date, but by
conversation. When you start a dialog with one or more people, any subsequent
replies to that thread are automatically added to the conversation view for that
topic.

3. MailTips — This is a new feature that provides information to the user before he
or she sends a message. For example, you may have a MailTip to warn users
when they are sending an email to outside the organization or sending to a large
audience. MailTips are not enforced rules, but they do provide some guidance to
users before they send a message, and with Exchange 2010 custom mail tips can
be created on the server and seen by clients when they apply.

4. Quick Steps - You can define custom, or frequently used actions, called Quick
Steps. For example, you could have a quick step to CC your manager, schedule a
meeting, or reply and then delete the message.

5. Automatically Calendar Retrieval - If you receive a meeting invitation that
conflicts with another appointment, Outlook automatically brings up your
calendar, making it easy to find a time that you are available and reschedule.
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What’s New in Publisher 2010?

1.

10.

New Views - New visual page navigation with nice sized page / spread thumbnail
previews.

Template Improvements - Layouts are now preserved when substituting,
cropping, or otherwise manipulating images in a template.

Object Outlines Disappear - Object outlines only appear on hover or when an
object is selected.

Page Margin Guides - Page margin guides can appear as you drag the edge of an
object near them and then disappear when not needed.

Alignment Guides - Automatic alignment guides that only appear when relevant
Images/Type.

Pictures - Picture manipulation improvements including picture insertion,
alignment, panning, cropping.

Text - Text formatting improvements including ligatures (with OpenType fonts)
and Stylistic text with previews for adding flourishes.

Print Preview - Print preview is no longer a separate feature, it's integrated into
the Print functions in the Backstage View.

Two Sided print Preview - Print preview lets you 'flip' 2-sided documents to see
more easily how it will print on each side.

PDF & XPS - Backstage View is where you'll also find the commands for saving
Publisher files as PDF or XPS and commercial printing options.
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Microsoft Office 2007
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Microsoft 2010 Note — At the time of this writing, Office 2010 was not yet shipping, but
is expected to begin shipping in Spring 2010.

What’s New in Microsoft Office 2007?

After five long years of development, the latest edition of the world’s best selling application -
Microsoft Office was finally released two years after it’s expected release date in January 2007.
While there are hundreds of improvements, these changes to Microsoft Office 2010 can be
summarized roughly as follows:

1.

Larger Capacities — Office 2007 sees more processors, more RAM, supports more colors,
shows more recently used files, provides more columns and rows in Excel, sorts by more
criteria, etc.

New Menus — Microsoft Office 2007 looks different. The menus, toolbars and icons have
been removed and replaced with Ribbons. Over the years, the number of Office tool
bars had grown from two toolbars to thirty-one toolbars in Word 2003. The complexity
of navigating this vast array of floating and hidden toolbars continued to increase until
now. Microsoft has engineered a better way to navigate Office using improved toolbars
called ribbons. These ribbons work similar to the toolbars and icons you are used to, but
they are far better organized (although it won’t feel that way if you are used to the old
toolbar design).

Presentation Quality Output — While this may seem dull to you, the improvements to
the output are seriously useful. Office can now produce presentation quality output that
rivals the output of desktop publishing applications.

The Many Editions of Microsoft Office

There are eight (8) different versions of this produce containing different mixtures of the
following ten (15) Microsoft applications:
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Access 2010

Excel 2010

Groove 2010

InfoPath 2010

Language Pack: Spanish

OneNote 2010

Outlook 2010

Outlook with Business Contact Manager 2010
PowerPoint 2010

. Project 2010

. Publisher 2010

. SharePoint Designer 2010
. Visio 2010

. Word 2010

. Communicator 2010
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All together, Microsoft offers five different Office Suites as follows:

1 3 1 il
|| r ]

Office Home and Office Standard Office Small Office Office Ultimate
Student 2007 2007 Business 2007 Professional 2007
2007

P

£$149.95 $399.95 $449.95 $499.95 $679.95
e Cocwis

Word ® ® ® ® L

Create and edit
documents

Excel®

Tools to analyze, ] ] ® ® ®
share, and manage

data

PowerPointE
Create great-locking
dynamic presentations

OneNote®

Gather your notes and ] [ ]
information in one

place

Outlook®
Manage all your e-mail
accounts in one place

Publisher®

Design and publish L] ® [ ]
great-looking

documents

AccessE

Quickly share, ® ®
manage, audit, and

back up data

Groowve®
Work together e
dynamically

InfoPath®
Gather information b
efficiently and reliably

Free*® 2010 Upgrade Office Home and =~ Office Home and | Office Professional | Office Professional  Office Professional
Buy Office 2007, get Student 2010 Business 2010
Office 2010 free®

*Office 2010 downloads will be accessible at general availability. Discs can be ordered for a fze. Eligible Office 2007 software must be purchased
Tom Microseft or an authorized reseller and activated between March 5, 2010 and September 20, 2010, Request your Office 2010 product by
Jctober 31, 2010 using your activated Office 2007 Product Key and dated sales receipt. You will receive an e-mail message frem us letting you
<now when your Office 2010 product is available, One Office 2010 product per qualifying Office 2007 suite or stand-alone product purchase, limit
25 per person, See www.office.com/techg for complete details,

Previously Microsoft included Expression Web 2010 in selected editions of the Office Suite.
However, in 2009 Microsoft released the Microsoft Expression Suite as a separate suite of
products, and Expression Web 2010 is no longer part of the Office 2010 suite of products.
Additionally, Office Accounting 2009 was discontinued in late 2009 and is no longer part of the
Microsoft family of products.
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Microsoft Office 2007 ON Windows XP

Yes, Microsoft Office 2007 will run on Windows XP — but DON’T DO THIS! Why Not?
Office 2007 only sees as many processors and as much RAM as the operating system — if
you use Windows XP you limit yourself to just 1 processor and 3 GBs of RAM. My
recommendation is to purchase a new computer with 4 processors and 8 GBs of RAM,
run Windows 7 64-Bit and use two flat panel monitors. Install Microsoft Office 2007 and
you will have one fantastic computer.

What’s New in Microsoft Office 2007?

As mentioned above, there are many new changes in Microsoft Office 2007, but generally
speaking these hundreds of improvements can be described in just three phrases as follows:

1. New Menu Design
2. Larger Capacities
3. Presentation Quality Output

The aspects of Office are discussed in detail below.
1. New Menus (or more to the point, A New User Interface) — Microsoft Office 2010 looks

different. The menus, toolbars and icons have been removed and replaced with
Ribbons. Here is what the new ribbons look like:

& Bookl - Microsoft Excel Contextual Tabs
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Over the years, the number of tool bars included in Microsoft Office products have
grown from just two (2) toolbars in Word 6.0, to six (6) tool bars in Word 95, to eighteen
(18) toolbars in Word 98, to thirty-one (31) toolbars in Word 2003. Obviously the
complexity has been mounting and navigating these various toolbars has become more
time consuming. Based on this, Microsoft has engineered a better way to navigate the
Office suite called ribbons.

As a practical matter, the ribbons do work similar to the menus, toolbars and icons you
are used to, however they are easier once you get used to them and underneath the
technology is far better. Presented below is an example screen shot of the new ribbon,
and the elements of the tool bar are described after the screen shot.
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1.

Ribbon - The long strip of icons across the top of the page are called ribbons.
Initially there are 6 ribbons visible in Word, and 7 ribbons visible in Excel — however
you can also display the developer tab and even add more ribbons such as the
Adobe Acrobat Ribbon. Unlike the old toolbars, the ribbons cannot be edited,
changed, resized or moved in any way. You can minimize the ribbons by right-
clicking on one of the tabs and choosing minimize.

Tabs - The tabs look like drop down menus but they are not - they are merely used
to switch between ribbons.

Contextual Tabs - Some tabs are always visible. Other tabs are “contextual” and
only show up when you are working with specific elements within your document.
For example the “Table Tab” will appear whenever you click in a Word table and the
“Picture Tools” tab appears whenever you click a picture.

File or Application Menu - The only drop down menu in Office 2010 is accessed by
clicking the Office icon in the upper left hand corner — it is almost identical to the
older “File Menu”. Under that menu there are familiar options, New, Open, Save,
Save As, Print etc. Microsoft has greatly expanded the “Most Recently Used” file list
- this is a nice improvement.

Quick Access Toolbar - This is the only toolbar that is customizable and the
customizations are unique for each application. You can add and delete the
command icons that you frequently use for quicker access. To add items to this
toolbar, right-click and choose the “Customize Quick Launch Toolbar” option.

Groups — Square sections of the ribbon are called “Groups” - a logical grouping of
icons, labels, menus and other controls. Group views are not fixed, they expand
depending on their position on the toolbar and the width of the Office window,
however they cannot be manually re-sized. When there’s a wide window, a more
detailed group is displayed with more options. In a narrower display the same
group can be reduced to a single button — click that button to see a list of the
available controls — hence the official name ‘pop-up chunk’.

The groups on the left of each ribbon are most used (or more important) based on
studies measuring command usage. Therefore when a ribbon’s view is minimized,
the groups on the right will reduce in size before groups on the left. But if you make
a narrow enough window all you’ll see are pop-up groups. Each group has a title at
the bottom and in some cases a little wedge shape with an arrow on the bottom
right. You can click on that wedge to go direct to the full options dialog for that
topic. The group title cannot be hidden and the arrangement of icons within a group
cannot be changed.
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Not every application has changed - Only Word 2010, Excel 2010, PowerPoint 2010, and
Access 2010 have the new menus and user interface. In Outlook 2010 the main shell is
still menu-based, but all other sub-screens (mail, contacts, meeting forms, tasks, etc.)
are Ribbon-based.

2. New File Formats —Microsoft Office 2010 still offers all of the old document formats
such as DOC for Word files, XLS for excel files, and PUB files for Publisher files, etc.
However the newer default format is an XMLS format based on the eXtensible Markup
Language called XML. There are four primary benefits offered by the new Office XML
Formats as follows:

1. Data Sources - The new format enables the creation of documents from
differing data sources, thereby accelerating document assembly, data mining,
and content reuse. For example, the letterhead used by all company personnel
could be linked to a single file. As this file is changed, all documents referring to
that letterhead file change as well. Similar methods could be used to link data
from a database to documents for faster integration of information. This also
translates to easier integration because developers have direct access to specific
contents within the file, like charts, comments, and document metadata.

2. Royalty-Free - Office XML Formats are based on industry standard XML and
ZIP technologies. They support full integration by any technology provider and
are available via a royalty-free license. You can now produce an XLS document —
which is basically the same as an Adobe Acrobat format.

3. Smaller - File sizes are up to 75 percent smaller - Office XML Formats use ZIP
and compression technologies which reduces the disk space required and
decreases the bandwidth needed to send files by e-mail, over networks, and
across the Web.

4. Safer - The new file format is safer because embedded code (such as OLE
objects or Microsoft Visual Basic for Applications code) is stored in a separate
section within the file, so it can be easily identified for special processing. This
approach makes it easier to recover corrupted documents, if needed. It also
makes it easier for IT Administrators to block documents that contain unwanted
macros or controls.

3. Compatibility Issues — The introduction of this new file format will cause problems as
you share files with others who are not yet using Office 2003. However, there is plenty
of good news as follows:

a. Office 2010 can save to the older file formats if needed.
b. Office 2010 can open older file formats.
c. A free utility can be downloaded that enables Office 2000 and Office 2003 uses

to open Office 2010 files. This is an easy process and once installed, the
operation is seamless.

Copyright 2010, All Rights Reserved Page 61



Microsoft Office & Windows 7 for CPAs www.CarltonCollins.com

d. A compatibility checker warns you of any compatibility issues whenever you
save to an older format.

4. Super Tool Tips — The new “Tool Tips” provide longer descriptions for each tool and in
some cases a thumbnail picture too. The following screen shows an example of a Super
Tool Tip.
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5. XPS Documents - XPS, (XML Paper Specification) is Microsoft’s new electronic paper
format for exchanging documents in their final forms. This Office feature provides a
one-way export from Office client applications to an application- and platform-
independent, paginated format. Unlike the Office Open XML Formats, XPS does not
attempt to capture the full structured richness of an Office document. As an electronic
paper format, it is all about a high fidelity representation of the output only. Because of
this, creation of an XPS document from Office is a one-way, export operation.

XPS is an electronic paper format built around the same Open Packaging Conventions
document structure as the new Office file formats. This means a Zip container and XML
content. As such it plays well with other technologies like Microsoft Information Rights
Management (IRM) and is open to developers to read and write, using APIs in the
Windows Presentation Foundation or any other tools capable of working with XML and
Zip. This openness makes XPS convenient for a range of scenarios in which it is useful to
inspect or modify the contents of the “paper” programmatically.

The Windows Digital Documents team is delivering a print driver with Windows
Presentation Foundation that will enable all applications that can print to create XPS
files. The support for XPS output in Office 2010 goes beyond what is typically passed to a
printer, including the supporting information to enable, for example, working
hyperlinks, searching, efficient representation of transparency and gradients, accessible
documents, and document rights when the source document has restricted IRM rights.

Basically this new format works similar to an Adobe Acrobat format, except you do not
need to download a viewer (like the Adobe Acrobat Reader) because Microsoft Word
will display these file formats.

6. Document Look and Feel — Microsoft examined many examples of “professional”
output, drawn from textbooks, business journals, scientific journals, and professional

Page 62 Copyright 2010, All Rights Reserved



www.CarltonCollins.com

Microsoft Office & Windows 7 for CPAs

design firms. Based on this examination they concluded that there are still many
capabilities needed in Office 2010 to enable users to produce these modern looking

documents. As a result, Microsoft has added many new enhancements for controlling
the look and feel of a document including the following:

Microsoft has increased the number of colors allowed a single workbook from
56 to 4.3 billion (32-bit color).

The charting appearance has been greatly improved - rather than explain it with
text, see examples of these improvements for yourself below.
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Improvements to Excel’s existing cell styles feature, and the addition of styles

for Tables, PivotTables, and Charts.

Galleries of professionally-designed styles

A new Page Layout View - to supplement Normal and Page Break Preview.

"Live preview" of formatting.
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Click-and-type headers and footers.

New print-related features.

i. Document Themes (color, font, and effect variations that can be shared
between Office applications)

j.  Updates to Office shapes (think Drawing toolbar) and WordArt

k. 25 great-looking templates available out-of-the-box.

5 m

Carlton’s List of the Top Hidden Tools in Office

Hidden Tools in Microsoft Office — There’s much more to Microsoft Office than just Word and
Excel. In the following lists you will learn about Office’s best hidden features, tools and functions
that can help you complete your tasks quicker and make your job easier. We will dig deep into
the Office applications and accessories to reveal dozens of hidden gems for printing, scanning,
converting and protecting text, merging data, e-mailing, managing pictures, publishing
documents, translating data, etc. These functions which will be demonstrated to you live using
real-to-life examples. Whether you use Office 2003 or Office 2010, these features will help you
expand your proficiency with Microsoft Office.

Carlton’s List of the Top Hidden Tools in Office

1. Microsoft Office Compatibility Pack - Open, edit, and save documents, workbooks, and
presentations in the file formats new to Microsoft Office Word, Excel, and PowerPoint
2010.  http://www.microsoft.com/downloads/details.aspx?Familyld=941B3470-3AE9-
4AEE-8F43-C6BB74CD1466&displaylang=en

2. Mail Merge — Create a series of letters or e-mails, each containing recipient specific data
coming from Excel or Outlook.

3. Smart Art — Create snappy looking art to compliment your reports.

4. Building Blocks — The new building blocks feature in Word 2010 helps you can create
sharp-looking business documents from galleries of predesigned parts. Simply add your
business information and save to create a template that is ready to use as often as
needed.

5. Clipboard — Use PrintScreen to capture the screen in order to document procedures or
to create instructions for using a software program or Excel template.

6. Snipping Tool (Office 2010 Only) — Same as PrintScreen except can capture portions of a
screen — even if the screen image is protected.

7. Picture Manager — In Office 2003, Microsoft Office Picture Manager replaces Photo
Editor. Accessible from the Microsoft Office Tools menu, Picture Manager lets you
locate, manage, edit, and share digital photos. If you've ever helped a friend try to
locate pictures that he uploaded from his digital camera and promptly lost, you'll
understand the value of Picture Manager.
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10.

11.

12.

13.

14.

15.

16.

17.

18.

Share Calendar — To share your calendar with other people across the Internet, you
can use the Internet Free/Busy service (IFB). To access the IFB, go to Outlook and click
Tools, Options, Calendar Options, Free/Busy options.

Document Scanning and Document Imaging — Microsoft Office Document Scanning
and the related Microsoft Office Document Imaging work together. The scanning tool
lets you use your scanner to capture images, and the imaging tool lets you view and
annotate documents, rearrange multipage documents, and send document images
through email. You access both tools from the Microsoft Office Tools menu.

Add Sounds to PowerPoint — Use the Insert Movies and Sounds menu option to add
sound from a CD or a file to your presentation. Go to custom animations to indicate how
many slides the sound should continue.

Record Narration of your PowerPoint presentations — Use the Slide Show, Record
Narration button to record your voice and timings over your PowerPoint presentation.

Equation Editor — Expressing mathematical formulas in documents can be a challenge.
Equation Editor provides a toolbar of symbols and automatically adjusts font size and
spacing as you build an equation. From Microsoft Word, click Insert, Object, then select
Microsoft Equation 3.0 from the Object type menu.

Double Click Excel Cells Before You Paste - To copy and paste content in the same
formatting as what's already in your Excel spreadsheet, double-click the cell before you
paste the content in.

Back up every time you save an Excel File - In the Save As dialog box, click Tools, click
General Options, and then select the Always create backup check box.

XML Task Pane — InfoPath and Excel aren't the only Office tools that can work with
XML—you can also open and edit XML documents by using Word's XML pane. To open
the pane, click View, Task Pane and select XML Structure from the drop-down box in the
upper left corner of the window.

Research task pane—The integrated Research pane lets you easily do research as you
write, without leaving Word. Click View, Task Pane, then select Research from the drop-
down box in the window's upper left corner. With the pane open, you can type words or
highlight document selections and look up information in an online dictionary and
encyclopedia.

Translation Task Pane—The Translation task pane can quickly translate documents and
words into other languages. To open the pane, first open the Research task pane, then
scroll to the Translation section and select the language conversion you want from the
drop-down boxes.

Save My Settings Wizard—The Save My Settings Wizard is great for moving all your
customized Office settings to a new system. Using the wizard (access it through the
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Microsoft Office Tools menu), you can save your Office settings in an .ops file, then
restore that file on another system.

19. Access Snapshot Viewer—Access is included only in Microsoft Office Professional
Edition 2003, but sometimes you want to share database reports with people who don't
have Access. The Access Snapshot Viewer lets a user view Access report snapshots
without installing or using Access itself.

20. MS Query—I use MS Query a lot. This graphical query editor lets you build and execute
queries against most ODBC/OLE DB databases and return the results to Office. You
access MS Query by either running msqry32.exe or using Excel's Data, Import External
Data, New Database Query option. MS Query isn't part of the default Office installation.
If you need to install it, click Start, Control Panel, Add/Remove Programs, then select
Microsoft Office. Click Change, then select Add or Remove Features. Select the Choose
advanced customization of applications check box, click Next, then expand the Office
Tools node. Locate MS Query, click the drop-down arrow next to it, select Run from My
Computer, and click Update.
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21. Outlook’s To Do bar - The Outlook To Do bar, positioned on the right side of the
Outlook screen, provides room for the To Do bar to sit there as you work. If you're using
a small screen clicking the double chevron indicator in its top right corner can collapse it,
but it stays handy so you can access it with a single click. The To Do bar gives you the
tools you need to organize your day all in one place. It contains mini calendars as well as
a list of upcoming appointments and tasks awaiting completion. For the first time the
Outlook task list is where it should be — right in front of you so it's a tool you can easily
use. To add a new task, click in the ‘Type a new task' box, type the task description and
it will be added as a task to be performed today. To configure more detail about the
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22.

23.

24.

25.

task, double-click it to open the task dialog and make your changes. A task that you
don't complete today is automatically rolled forward to tomorrow and will continue to
appear in the list until it is complete — this is a new and much overdue feature. You can
color code your tasks to show the category it relates to (see below) and the Follow Up
flag color indicates the task's urgency — the darker red the flag color, the closer is its
due date.

Quick Flags - Often when you are reading your e-mail you will encounter a message that
needs attention but not right away. You can flag the message for attention using the
Flag Status indicator to the right of the e-mail in the Inbox panel. A single click of the
Flag Status turns the flag red and automatically adds the message to your To Do list for
attention today. In either the To Do list or the Flag Status column you can right click the
flag and choose a different due date for the task. If you'd like to see a reminder, right
click the flag to add a reminder for that task. You're sure to find this integration
between follow up items and the task list invaluable in ensuring that everything that
needs to be attended to is marked as such and is visible and easy to track.

Outlook’s Fast Searches - One of the most lauded improvements in Outlook 2010 is its
search feature. If you use Windows Vista you have it built-in; if you use Windows XP you
must install the Windows Desktop Search 3.01 tool to make use of it. You can download
the app directly here. This tool uses word-wheeling functionality, which means it begins
to search for matches for your text as soon as you start typing. To narrow the search,
type more letters in the search box and the results will show only those that match the
text you've typed. This is a much faster way of searching than in older versions of
Outlook, and because the search results are right in front of you, it's very intuitive and
useful. You can improve the quality of your searches using keywords, so From: Kevin
with To: Helen and Subject: CHA will return messages from Kevin sent to Helen where
the subject contains CHA. Use the options on the drop-down list to the right of the
search box to configure what is searched. You can then click the double down pointing
chevrons to open a small search box to enter a more detailed search. Given the amount
of time that you'll likely save from constantly looking for missing e-mails, Outlook 2010's
new and improved search tool is sure to become your new best friend.

Calendar Sharing - Outlook 2010 supports the iCal calendar format, which allows users
to share your calendar with others, and to import calendars from others. While this
feature immediately reminds us of sharing calendars between people, it also means that
you can import calendars of your favorite TV shows or football games. To subscribe to a
calendar, click the ICS subscription link for the calendar on the calendar Web site and
answer Yes when Outlook asks if you want to subscribe to it. http://icalshare.com/

RSS Feeds - If you like to stay in touch with what's happening in the world and your
industry, chances are that you subscribe to RSS feeds and you use a standalone feed
reader such as FeedReader or SharpReader. Outlook 2010 can now manage your RSS
feeds for you so you have a one-stop shop for all your e-mail and news information. You
configure your RSS feeds as accounts from the same Tools, Account Settings dialog and
the feed will be checked for new items whenever the All Accounts group is checked. You
can also configure feeds as a separate group for checking at a different frequency. Once
a feed item is received it appears in the RSS feeds folder in your Personal Folders list.
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27.

28.

29.

Click a feed item to open it in a window and click the View Article link to view the
original feed if desired.

Category Colors - Categories in Outlook 2010 are more functional than in previous
versions because they are much more visible and configurable. To organize your
categories, click the Categorize (four color square) icon on the toolbar to see a list of
category names and colors. Click "All Categories" and you can rename the categories
and add additional ones if desired. You can also apply a shortcut key to a category,
allowing you to allocate it to an item with a single click. Create categories to identify
items that are important to you and develop a habit of applying them to important e-
mails and calendar items. These category colors are not only highly visible on the screen
but you can sort items in order by category — for example, in the To Do bar to group
like tasks together for easier management.

Account Setup - Outlook can handle multiple e-mail accounts so you can, for example,
use it with your work accounts as well as a home e-mail account. However, adding
accounts to Outlook has always been a bit of an issue because you need to know quite a
bit of information to set them up such as the name of the SMTP and POP e-mail servers
— information you likely seldom need and use but which is critical to successfully
configuring the accounts. Outlook 2010 now supports an automated account setup that
makes setting up accounts on an exchange server much easier. For accounts such as
IMAP and POP3, Outlook attempts to guess what the mail server's configuration should
be based on your e-mail address. In many cases it will get the correct setup
automatically so you don't have to enter any details beyond your e-mail address and
password. There is also the ability for an ISP to provide account setup details in an XML
file that Outlook can locate and use to set up accounts on that service.

Work Across Time Zones - If you make phone calls and attend meetings with people
who are not in your time zone, whether they be across the country or across the world,
you know how tedious it can be to calculate what time it is in Sydney when it is 3pm in
California, for example. Luckily for global workers, Outlook 2010 makes this easy. Create
a new appointment, click the Time Zone icon on the toolbar and, from the time zone list,
choose the other person's time zone. For example, if your meeting is at 10am Sydney
time, select 10am for the time and then choose GMT + 10 Canberra, Melbourne, Sydney
from the list. Your appointment will then be scheduled for the correct time in your
calendar which, if you're in California, is 5pm the day before — but you don't have to
work that out; Outlook does it for you.

Preview Attachments - For most of us receiving Word or Excel files as attachments is a
daily occurrence. In previous versions of Outlook you had to open the attachments
separately to view them. In Outlook 2010 you can display an attachment's contents
inside Outlook. This avoids having to open Word or Excel just to preview the document.
This also works with PowerPoint presentations. If the sender is someone in your safe
senders list, the attachments can be previewed automatically. If the sender is not on
your safe senders list, click the Preview File button to preview the attachment. To add a
sender as a safe sender, right click an e-mail from them and choose Junk E-mail, Add
Sender to Safe Senders List. You can still save attachments as you did with earlier
versions of Outlook, but the ability to view them inside Outlook will save a lot of time.

Page 68

Copyright 2010, All Rights Reserved



www.CarltonCollins.com Microsoft Office & Windows 7 for CPAs

30.

31.

Outlook Your Way - Outlook 2010 includes many of the configuration options you had
in earlier versions. These allow you to configure Outlook so that it works the way you
want it to. As an example, if your work week runs from Sunday to Thursday, choose
Tools, Options, Preferences tab, Calendar Options. Here you can configure your working
week and what day you want to display as the first day of the week. To configure your
time zone, click Time Zone and you can tell Qutlook your time zone and also set up a
second time zone if desired. You might use this, for example, if you work with a head
office or branch office in another time zone as it lets you have that time zone visible on
your calendar alongside your own. Other handy configuration options in Outlook 2010
are on the Mail Format tab where you can create signatures to use on outgoing
messages and even create different signatures for different e-mail accounts. Click the
Editor Options button in Mail Format dialog and you can configure the e-mail editor
with various options, including making choices about how your text is proofed. This
dialog is reminiscent of the new Options dialogs in Word 2010, Excel 2010, and
PowerPoint 2010. Outlook has a lot of new features, many of which are not obvious
from a first glance. There are lots of useful tools to help you organizing your day and to
get your work done. It's all about working smarter and not harder.

Outlook AutoArchiving - AutoArchive moves items from their original location in
Outlook to an archive file folder when they expire, that is, when they pass their aging
period. You can also set options for items to be deleted when they expire.
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Enhancements to Excel

Larger Capacities:

10.

11.

12.

13.

14.

15.

Increased the total number of columns in Excel from 256 (228) to 16,000 (2214).
Increased the total number of rows in Excel from 65,536 (2416) to 1,048,576 (2/20).
Increased the total amount of PC memory that Excel can use from 1GB to the maximum
allowed by Windows (1 GB in Windows XP; 3 GBs in Windows Vista 32 bit; 8 GBs in
Windows Vista 64-Bit).

Eliminated the limit on the number of rows of a column or columns that can be referred
to in an array formula.

Increased the number of conditional format conditions on a cell from 3 conditions to
limited by available memory.

Increased the number of levels of sorting on a range or table from 3 to 64.

Increased the number of items shown in the Auto-Filter dropdown from 1,000 to
10,000.

Increased the total number of characters that can display in a cell by 32-fold. More
specifically, this limit was increased from 1k (when the text is formatted) to 32k or
unlimited (regardless of formatting).

Increased the number of characters per cell that Excel can print from 1k to 32k.

Increased the total number of unique cell styles in a workbook (combinations of all cell
formatting) from 4,000 to 64,000.

Increased the maximum length of formulas (in characters) from 1,000 characters to
8,000 characters.

Increased the number of levels of nesting that Excel allows in formulas from 7 to 64.
Increased the maximum number of arguments to a function from 30 to 255.

Increased the maximum number of items found by “Find All” from 65,472 to 2 Billion.

Increased the number of rows allowed in a Pivot Table from 65,536 (2”16) to 1,048,576
(2720). Increased the number of columns allowed in a Pivot Table from 255 to 16,000.
Increased maximum number of unique items within a single Pivot Field from 32,000 to
1,000,000. Increased the number of fields (as seen in the field list) that a single
PivotTable can have from 255 to 16,000.
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18.

19.

20.
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22.

23.

Increased length of the MDX name for a Pivot Table item; also the string length for a
relational Pivot Table from 255 characters to 32,000.

Increased the length at which fields’ labels are truncated when added to PivotTable; this
also includes caption length limitations from 255 to 32,000.

Increased the number of cells that may depend on a single area before Excel must do
full calculations instead of partial calculations (because it can no longer track the
dependencies required to do partial calculations) from 8,000 to limited by available
memory.

Increased the number of different areas in a sheet that may have dependencies before
Excel must do full calculations instead of partial calculations (because it can no longer
track the dependencies required to do partial calculations) from 64,000 to limited by
available memory.

Increased the number of array formulas in a worksheet that can refer to another (given)
worksheet from 65,000 to limited by available memory.

Increased the number of categories that custom functions can be bucketed into from 32
to 255.

Increased the number of characters that may be updated in a non-resident external
workbook reference from 255 to 32,000.

Increased the number of rows of a column or columns that can be referred to in an
array formula from 65,335 to no limitation.

Improved Tables — Better Looking, Better Behaved

The new table feature in Excel 2010 called “table styles” makes it possible to add formatting
with one click. Table styles is a feature that provides a way to quickly format my entire table
using a preset style definition. It is similar in concept to the AutoFormat feature Excel had in the
past, with a couple key differences:

Dynamic - Table styles are dynamic, not a one-time formatting operation, so the
formatting associated with the style behaves intelligently through many table actions —
addition or deletion of rows or columns, sort, filter, etc.

Hundreds of Styles - There will be a healthy variety available. Excel 2010 will ship with
30-40 table styles out of the box, and users will be able to vary the colors used by the
style, so users will have a couple hundred styles available with one or two clicks of the
mouse. If none of the built-in styles tickle your fancy or suit your presentation, you will
be able to create your own custom styles which are sharable with others.

Applying Styles - The Ul for applying styles — galleries in the ribbon — is a big step
forward. This is a great example of the kinds of benefit the ribbon brings to Excel.
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e Themes - They are part of a broader set of work that includes cell styles, chart styles,
PivotTable styles, and document themes. More on that in later posts, but the goal of all
this work is to make it fast and easy to create professional-quality, consistent-looking
documents.

Table styles are easy to apply — just create a table and a default table style is applied as
soon as a table is created (don’t worry though; it doesn’t remove your existing
formatting). If you don’t like the table style, you can pick something different or remove
it altogether. The gallery of table styles is available directly from the table style
ribbon. By default, we show you a single row of styles (the number depends on the
resolution of your screen — more resolution, more space for styles).

H
HHHHE
HHHHE
HHHHE
HHHHE

If you want to see other styles, you can either scroll, or click on the drop-down to see all
the styles available.

Built-In

T

As you hover over each table style with the mouse, Excel displays a preview of what the
table looks like with that style. The preview appears directly on the table in my
spreadsheet — it is not a separate image. This is another of the user interface
advancements we have made with the new ribbon feature in Office. If you like the way
the preview looks, simply click on it to apply it to the table.
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To sum, one of the benefits of this feature is that professional-quality formatting is one
click away. The fun is only starting, however. Once a table style is applied, it will grow
and shrink with the table as the table changes. Additionally, certain elements of table
style formatting have other intelligent behaviors. For example, if a table style specifies
what we call “banded row” formatting, meaning that every odd row be one color and
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every even row be another color, then that banding rule will always apply no matter
what | do to the table. This means | can add and delete rows and my table still appears
properly banded. | can sort and filter a table and my rows will still appear properly
banded. (Note — filtering is one place where the technique of using “=MOD(ROW(), 2)"
in a conditional formatting rule to generate bands doesn’t work — since filtering hides
rows, the banding effect is destroyed.) For example, if my table looks like this before
filtering ...

A B C
8l column1 B3 column2 B3| columnz B3
2 Doug Georgia 5,667.00
3 Tom South Carolina 3,445.00
4 Sam Sowuth Carolina 2,236.00
5 |Bill Georgia 8,877.00
6 Chris Florida 5,568.00
7 Phil South Carolina 9,964.00
8 Brenda Georgia 4,555.00
9 |Martha South Carolina 4,677.00
10 Tammy South Carolina 7,755.00
11 Karen Georgia 12,777.00 ,
Before Filter

... and we filter to show only South Carolina rows, here is what my table will look like
after we filter it:

A B C
8 Column1 B column2 K column3 B3|
3 Tom South Carolina 3,445.00
4 |Sam South Carolina 2,236.00
7 Phil South Carolina 9,964.00
9 Martha South Carolina 4,677.00
10 Tammy South Carolina 7,755.00 ,
After Filter

Table styles have several different options that can be turned on and off, and all of them
have similar intelligent behaviors. For example, a table style might define that the first
column should always appear a certain way. If the “first column” option is enabled,
then Excel will always make sure the first column is formatted appropriately no matter
which column is in the first position. You can see the other table style options in the
screenshot below — header and total rows, first and last columns, and banding on either
rows or columns. You can toggle these on and off for each table style.

v| Header Row Last Column
Totals Row v| Banded Rows

v | First Column Banded Columns
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One question we hear a lot when we are showing off table styles is how it relates to
“direct” (user-applied) formatting and conditional formatting. If a table style is applied,
you are still free to format your table using either
formatting. Formatting that you directly apply to a table will always appear “above”
formatting that is defined by a table style, and conditional formatting will always appear
“above” direct, or user-applied formatting (bold for example).

PivotTable Enhancements

conditional or

direct

One of the nice exploration features of PivotTables is the ability to expand and collapse items in
In Excel 2010, Microsoft has added
expand/collapse indicators to the PivotTable to make it easy to discover when there are more
details to explore (and to make it obvious that this feature even exists!). The expand indicator is
a “+” and the collapse indicator is a “-”. Let’s look at an example. In the PivotTable below, the
user has added three fields to the row area and the sales amount field to the values
area. Currently only items of the first field, year, are showing. To display the details below 2001,

order to view values at different levels of detail.

click the expand indicator:

Filter rows B3 Sum of Sales Amount

#2001 105880.18
KGDZ 92868.60
H2003 110935.53
H2004 88794.51
Grand Total 398478.81

Now we are looking at the sales amount for each product category in 2001:

C dle L C

=12001 105880.18
__#Mountain Bikes 37324.89

j#oad Bikes 68555.29
+2002 92868.60
+2003 110935.53
+2004 88794.51
Grand Total 398478.81

To go to a lower level of detail, we can expand mountain bikes as well and we get the

sales amount for each bike model:
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Filter rows B2 sum of Sales Amount

=2001 105880.18
= Mountain Bikes | 37324.80
Mountain-100 Black, 44 3374.99
Mountain-100 Black, 48 6749.98
Mountain-100 Silver, 38 6799.98
Mountain-100 Silver, 44 20399.94

+ Road Bikes 68555.29
2002 92868.60
+2003 110935.53
2004 88794.51
Grand Total 398478.81

Note that we are now at the lowest level of my “hierarchy”, so there are no expand or
collapse indicators. The indicators do not print by default, and they can be turned off

altogether once you are done exploring the data and are getting ready to present the

result.

Compact Axis

The PivotTables in Excel 2010 look more “compact” than a PivotTable in current Excel
versions. Probably the easiest way to explain this is with a few pictures. Here is an Excel

2010 PivotTable with three fields on the row axis.

Filter rows = Ssum of Sales Amount

=12001 105880.18
= /Mountain Bikes | 37324.89
Mountain-100 Black, 44 3374.99
Mountain-100 Black, 48 6749.98
Mountain-100 Silver, 38 6790.98
Mountain-100 Silver, 44 20399.94

+ Road Bikes 68555.29
HZ2002 92868.00
H2003 110935.53
2004 88794.51
Grand Total 398478.81

And here is the same PivotTable in Excel 2003.
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|
Sum of Salg I
Year [+ |Product Category [~ |Product Name [+ |Total
2001 Mountain Bikes Mountain-100 Black. 44 3374 .99
Mountain-100 Black. 43 G749 93
Mountain-100 Silver, 38 G799 93
Mountain-100 Silver, 44 20399 94
Mountain Bikes Total 37324 89
Road Bikes | GA555 2892
2001 Total 105880 182
2002 92868 5974
2003 110935 5256
2004 88794 5092
Grand Total 398475 8142

To significantly improve the readability of PivotTables, Microsoft added a new layout
option for displaying items in the row area, which the team refers to as “compact”. In
the Excel 2010 screenshot above, you will notice that items from all of the three
different fields in the row area are displayed in a single column. To distinguish between
items from different fields, Mountain Bikes is indented under 2001 and the individual
mountain bike models are indented even further under Mountain Bikes. One of the key
benefits of this feature is that PivotTable row labels take up far less room on your
screen, so that there is much more room for your numbers. This compact form is the
new default layout for PivotTables in Excel 2010. That said, we have provided three
different “row area layout options” to choose from. The layout settings can be
controlled for each field individually but it is very easy to set them for all fields at
once. Thisis done in the Report Layout drop down on the PivotTable Styles tab.

Goyoutoptions |

Repaort slank
layout ™ Fows ™

!

Show in Compact Form

Show in Qutline Form

Show in Tabular Form

In addition to the compact form that we have already looked at, the tabular form
displays one column per field displayed and leaves space for field headers. Here is what
the tabular form looks like for the same PivotTable — much like current versions of Excel.
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Year \d Product Category E3 Pr
= 2001 = Mountain Bikes M
M
M
M
Mountain Bikes Total
=l Road Bikes Ra
Rg
Rg
| = Fa

The outline layout is very similar to tabular except that you can have subtotals at the top
of every group, since items in the next column are displayed on row below the current
item. To illustrate the difference, the screenshot below shows outline form where
Mountain Bikes is one row below 2001:

Year i Product Category B3 Pr

=2001

= Mountain Bikes

S EE=

=l Road Bikes

=]

As the screenshots above illustrate, the great advantage of the new compact form is
that the PivotTable utilizes space a lot better, making it much easier to read. Tabular
and outline form include a lot of white space making the report wider and the result is
that the values are pushed out of view in many cases.

PivotTable Styles - Table styles provide a way a way to quickly format entire tables using
a preset style definition. They are dynamic, meaning as your data change the style is re-
applied smartly, there is a lot of variety, the Ul for applying table styles is very visual and
easy, and they will be professionally designed, so that out-of-the box people will be able
to create presentation-level quality. Well, the good news is that Microsoft has done the
same for PivotTables. In Excel 2010, Microsoft has added PivotTable styles, which are
another important part of our work to make PivotTables easier to read and
understand. In the same way as table styles, the PivotTable Ul offer styles in a gallery.
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PotTable Taol:

out Formulas Data Feview

Opticns

= Styles

Built-In

HHEE BE E

Clicking a style in the style gallery will immediately apply the style to the entire
PivotTable. Below are two examples of PivotTable styles. The first example is a style that

highlights the top part of the report while formatting everything below similarly:

Filter rows n Sum of Sales Amount

=12001
='Mountain Bikes
Mountain-100 Black, 44
Mountain-100 Black, 48
Mountain-100 Silver, 38
Mountain-100 Silver, 44
-IRoad Bikes
Road-150 Red, 44
Road-150 Red, 48
Road-150 Red, 52
Road-150 Red, 56
Road-150 Red, 62
Road-650 Black, 44
Road-650 Black, 58
Road-650 Black, 62
Road-650 Red, 48
Road-650 Red, 52
=12002

105880.18
37324.89
3374.99
6749.98
6799.98
20399.94
68555.29
10864.29
28971.44
7242.86
7242 .86
7242 .86
699.10
1398.20
1398.20
1398.20
2097.29
92868.60

Excel 2010 offers a large set of predefined PivotTable styles that you can pick and
choose from. In addition, just like table styles, you can create your own styles that fit
your specific needs whether that might be corporate guidelines or individual
preferences. PivotTables, however, are more complex than tables, so there are more
table elements available for users to define formatting on. For example, you can define
formatting for multiple levels of subtotals, you can define striping at different levels in
the PivotTable. Microsoft believes that users will really enjoy this feature — once a style
has been applied to a PivotTable, the PivotTable continues to look good through sorts,
filters, pivots, addition or removal of fields, etc.
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Excel Tips

1. Paste Special Trick - When you want to copy content from a Word document,
a Web page, or whatever into Excel, and you want that content to have the
same formatting as what's already in your Excel spreadsheet, double-click the
cell before you paste the content in.

2. Select Data Trick - To select a large range of data, click the cell at one corner
of the range, scroll to the opposite corner, and then hold down SHIFT while
you click the cell at that corner.

3. Transpose Data - To change rows into to columns (and vice versa, for that
matter): Select the row or column you want to change, press Ctrl+C to copy it
(or Ctrl+X to cut it), and then put your cursor in the top cell where you want to
transpose the content. On the Edit menu click Paste Special and then click
Transpose.

Selecting Data

4. Select Nonadjacent Cells - Select nonadjacent cells or ranges by selecting the
first cell or range, and then holding down CTRL while you select other cells or
ranges.

5. Select Blanks Within a Range - To select only the blank cells in a region, select
the region, click Go To on the Edit menu, click Special, and then click Blanks.

6. Selecting A Large Range - Selecting a large range is easy. Just click the cell at
one corner of the range, scroll to the opposite corner, and then hold down
SHIFT while you click the cell at that corner.

7. Turn off Move on Enter - You can specify the direction you want the selection
to move after you enter data in a cell (for example, to the right if you work in
rows). Click Options on the Tools menu, make sure the Move selection after
Enter check box is selected on the Edit tab, and then click a direction in the
Direction box. For my money, | recommend turning this feature off.

8. F5 or GoTo - Move to a specific area of the worksheet (such as the current
region or the last cell) by clicking Go To on the Edit menu. Click Special, and
then select the option you want.

Editing Data

9. Ignore the Formula Bar - Instead of using the formula bar to edit the contents
of a cell, you can edit directly in the cell by double-clicking it or by pressing F2.

10. Numbering Trick - To increment a single number, hold down CTRL while you
drag the fill handle at the corner of the selection.

11. Weekday Trick - To increment weekdays, quarters, or other series, select the
first item and then drag the fill handle at the corner.

12. Custom Lists - Create your own custom fill series. Click Options on the Tools
menu, and then click the Custom Lists tab.
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13. Quick Menu - Right-clicking a cell, object, or chart item displays a shortcut
menu with useful commands.

14. The Fill Options Box - Specify how data in a selected cell or range should be
filled into other cells by dragging the fill handle at the corner of that cell or
range with the right mouse button, and then clicking a fill option on the
shortcut menu that appears.

15. Filling Dates - When automatically filling cells, Excel can increment both the
guarter and the year at the same time. For example: 1Q93, Q193, 1st Qtr 93,
1st Quarter 1993.

16. Delete a Range - Delete a range of selected cells by holding down SHIFT while
you drag the fill handle (located at the lower-right corner of the selection) up
and to the left.

17. Parsing Trick - You can distribute the contents of a cell (or column of cells)
across multiple columns. Select the cell or column, and then click Text to
Columns on the Data menu.

18. Insert Empty Cells - Quickly insert a range of empty cells by holding down
SHIFT while you drag the fill handle at the corner of a selection.

19. See All Range Names - Review all named cells or ranges in a workbook by
clicking the down arrow next to the Name box on the Formula bar.

20. Spellcheck - Start the spelling checker by pressing F7.

21. Drag and Drop Cells - To move cell contents, drag the border of the selected
cells to another location. To copy, hold down CTRL while you drag.

22. Edit Sheets Simultaneously - You can edit the contents of more than one
sheet at a time. Hold down CTRL while you click the tabs of the sheets you
want to edit, and then modify the data.

23. Back Up Every Time You Save - In the Save As dialog box, click Tools, click
General Options, and then select the Always create backup check box.

Formatting Data

24. Indent - To indent text in a cell, you can use the Increase Indent and Decrease
Indent buttons on the Formatting toolbar.

25. Transfer Cell Formats - Include a custom style from another workbook by
copying cells formatted with that style and pasting into the new workbook.

26. Right-clicking a column or row header displays a shortcut menu with the
Column Width, Row Height, Hide, and Unhide commands.

27. If you double-click the Format Painter button on the Standard toolbar, it will
stay selected so that you can apply the same format to multiple areas.

28. To freeze a row at the top of the window, select the row below it, and then
click Freeze Panes on the Window menu.

29. To apply a built-in table format to a range of cells, click AutoFormat on the
Format menu.

30. You can set the default font for future workbooks. Click Options on the Tools
menu, and change the Standard Font and Size options on the General tab.
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31. To change the default text format for the entire workbook, click Style on the
Format menu, and then change the format of the Normal Style.

32. To convert preformatted HTML text to a table, select it, and then click Text To
Columns on the Data menu.

33. Group rows and columns to easily show and hide them. Select the rows and
columns, point to Group and Outline on the Data menu, click Group, and then
click Rows or Columns.

34. To display numbers in thousands or millions, create a new number format.
Click Cells on the Format menu, and then click the Custom category. In the
Type box, type 0, or #, for thousands, and 0,, or #,, for millions.

35. Enter a value in dollar format by typing a dollar sign ($) before the value.

36. Enter a value in percent format by typing a percent sign (%) after the value.

37. Display negative numbers in red by clicking Cells on the Format menu. On the
Number tab, click the Number or Currency category, and then select a red
format under Negative numbers.

PivotTables and PivotChart reports

38. Change the name of a PivotTable” field by selecting the field button, and then
typing another name.

39. Move the legend on a PivotChart” report by clicking Chart Options on the
Chart menu. On the Legend tab, select the placement option you want.

40. Customize a PivotTable by clicking Format Report on the PivotTable toolbar.

41. Pivot fields directly on the sheet without starting the PivotTable Wizard by
dragging the field buttons.

42. You can reduce the amount of space a PivotTable report needs by dragging
some row or column fields to the page field drop area.

43. Show or hide detailed data for a cell in the data area of a PivotTable report by
double-clicking that cell in the table.

44. You can reposition an item within its PivotTable field by dragging its border.

45. Any changes you make to the source worksheet data can be included quickly
in your PivotTable report. Simply click Refresh Data on the PivotTable toolbar.

Functions and Formulas

46. If you need help choosing a function and entering its arguments, click fx
(Insert Function) on the Formula bar.

47. Instead of clicking AutoSum, you can also press ALT+EQUAL SIGN (=).

48. To copy the formula in the active cell to all cells in the selected range, press
F2, and then press CTRL+ENTER.

49. Insert subtotals into a range by clicking any cell in the range, and then clicking
Subtotals on the Data menu.

50. To decrease all values in a range by 10 percent, type .9 in an empty cell. Copy
the cell, and then select the range. On the Edit menu, click Paste Special, and
then click Multiply.
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Enhancements to Word 2007

The 2007 Microsoft Office system products present a streamlined, uncluttered workspace that
minimizes distraction and enables people to achieve the results they want more quickly and
easily. The goal of the new Microsoft Office user interface (Ul) is to make commands better
organized and presented in a way that corresponds to how people work. Microsoft Office users
will be able to easily find and utilize new advanced Microsoft Office capabilities. The streamlined
look and dynamic results-oriented Galleries in the 2010 Microsoft Office system products enable
users to produce better results faster. An example of the new Word look and feel is shown in
the screen shot below.
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Design Goals & Approach - In previous releases of Microsoft Office, people interacted with the
applications through a system of menus, toolbars, task panes, and dialog boxes. While this
system successfully provided access to a wide variety of features, it became increasingly
challenging to add capabilities in a way that made it easy for people to take advantage of them.
The overriding design goal for the new Ul is to enable users to be more successful finding and
using the advanced features of Microsoft Office. An additional important design goal was to
preserve an uncluttered workspace that reduces distraction for users

Key Features - While the overall look of the redesigned applications is new, early testing
indicates that users rapidly become accustomed to the new way these applications work. The
ease with which people use the new interface is due to the simplicity of the new interface
features:

1. Command Tabs - The traditional menus and toolbars have been replaced by a set of
Command Tabs. Presented graphically, Command Tabs display the commands that are
most relevant for each of the task areas in Microsoft Office Word, PowerPoint, Excel, or
Access. For example, Word has Command Tabs for writing, inserting, page layout,
working with references, doing mailings, and reviewing documents. Excel has a similar
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set of Command Tabs that make sense for spreadsheet work: creating worksheets,
inserting objects like charts and graphics, page layout, working with formulas, managing
data, and reviewing. These Command Tabs simplify accessing application features
because they organize the commands in a way that corresponds directly to the tasks
people perform in these applications.

-
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2. Contextual Command Tabs - Certain sets of commands are only relevant when objects
of a particular type are being edited. For example, the commands for editing a chart in
Excel are not relevant until a chart appears in a spreadsheet and the user is focusing on
modifying it. In current versions of Microsoft Office, these commands can be difficult to
find or become elusive. In the next release of Excel, clicking on a chart causes a
Contextual Command Tab to appear with commands that are relevant for chart editing
right next to the other Command Tabs in Excel. These Contextual Command Tabs only
appear when they are needed and make it much easier to find and use the commands
needed for the operation at hand while making it easy to switch back to working on
your document.

Wadget Maodal

Bask 83063, 550 #igi, 548 ] 202,455
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Contextual Command Tabs bring needed functionality to the user's attention at the
most appropriate time.
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Galleries - Galleries are at the heart of the redesigned applications. Galleries provide
users with a set of clear results to choose from when working on their document,
spreadsheet, presentation, or Access database. By presenting a simple set of potential
results, rather than a complex dialog box with numerous options, the Galleries simplify
the process of producing professional looking work. The traditional dialog box interfaces
are still available for those wishing a greater degree of control over the result of the
operation.
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Galleries simplify many operations by presenting a set of results that users can simply
"pick and click" to achieve the desired results.

Live Preview is a new technology that shows the results of applying an editing or
formatting change as the user moves the pointer over the results presented in a Gallery.
This new, dynamic capability streamlines the process of laying out, editing, and
formatting so users can create excellent results with less time and effort.
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Top 5 Most-Used Commands in Microsoft Word

Just for fun, what would you say are the five most frequently used commands in Microsoft
Word? According to Lead Programmer of Microsoft Office Jensen Harris, here they are:

1. Paste
2. Save
3. Copy
4, Undo
5. Bold

Harris goes on to say that together, these five commands account for around 32% of the total
command use in Word 2003. Paste itself accounts for more than 11% of all commands used,
and has more than twice as much usage as the #2 entry on the list, Save. Paste is also far-and-
away the number one command in Excel and PowerPoint, accounting for 15% and 12% of total
command use, respectively. Beyond the top 10 commands or so, however, the curve flattens
out considerably.

Here's an example of where Microsoft used this data to help make design decisions regarding
Office 2010. Early on, Microsoft was toying with the idea of not having buttons for
Cut/Copy/Paste in the Ribbon. Everyone "knew" that people mostly used CTRL+X/C/V to do
most clipboard actions (which was true.) And that mouse users used the context menu to
access these clipboard commands (which was also true.) What Microsoft didn't know until they
analyzed the data was that even though so many people do use CTRL+V and do use "Paste" on
the context menu, the toolbar button for Paste still gets clicked more than any other button.
The command is so incredibly popular that even though there are more efficient ways of using
it, many people do prefer to click the toolbar button.

According to Harris, the data kept Microsoft from making a crucial mistake. Once Microsoft
recognized the importance of the Paste toolbar button, it was promoted to the first big button
on the left side of Word's first tab. As trivia, the top "actions" performed in Word 2003 are:
Cursor Right, Cursor Left, Cursor Down, Backspace, Cursor Up. Even the last of these (Cursor
Up) is done about 8 times more than Paste, so people are doing a lot of cursoring around in the
document (as you'd expect.)

Word Tips

1. To view a document's organization and jump to different sections, on the View menu,
click Document Map.

2. Toinsert a page break, press CTRL+ENTER.

3. To create a line, press and hold the hyphen key to make at least three hyphens, and
then press ENTER. To create a thicker line, hold the SHIFT key down at the same time,
making at least three underlines before pressing ENTER. (Who knew?)

Viewing And Navigating Documents
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9.

10.
11.

To see two parts of a document simultaneously, drag the split bar at the top of the scroll
bar.

To view a document's organization and jump to different sections, click Document Map
on the View menu.

To see the same document in two different views, click Split on the Window menu, and
then choose the views you want.

To display page margins, click Options on the Tools menu, and then on the View tab,
under Print and Web Layout options, select the Text boundaries check box.

To move to the previous or next word, press CTRL+LEFT ARROW or CTRL+RIGHT
ARROW.

To go to the beginning or end of a document, press CTRL+HOME or CTRL+END.

To select an entire document, press CTRL+A.

To close all open documents, press SHIFT, and then click Close All on the File menu.

Formatting Documents

12. To change the margin or column settings for part of a document, first create section
breaks.

13. Toinsert a page break, press CTRL+ENTER.

14. To add a row at the end of a table, click the last cell, and then press TAB.

15. To delete a table and its contents, select the table, point to Delete on the Table menu,
and then click Table.

16. To merge table cells to make a table title, select the cells, and then click Merge Cells on
the Table menu.

17. Toinsert a tab character in a table cell, press CTRL+TAB.

18. To number rows in a table, select the left column, and then click the Numbering button.

19. To number columns in a table, select the top row, and then click the Numbering button.

20. To move a table row up or down, select the row, and then press ALT+SHIFT+UP ARROW
or ALT+SHIFT+DOWN ARROW.

21. To preserve formatting when you move or copy a paragraph, include the paragraph
mark.

22. To center, left-align, or right-align a selected paragraph, press CTRL+E, CTRL+L, or
CTRL+R.

23. To add a tab stop, click the ruler where you want to set the stop.

24. To delete a tab stop, drag it off the ruler.

25. To view the text of a footnote or endnote, rest the pointer on the note's reference
mark.

Working With Text

26. To add a check box to a document, point to Toolbars on the View menu, click Forms,
and then click Check Box Form Field on the Forms toolbar.

27. Note To use the check box, click Protect Form on the Forms toolbar.

28. To return to the location of the last edit, press SHIFT+F5.

29. To look up synonyms in the thesaurus, select a word and press SHIFT+F7.

30. To restore selected text to its original formatting, press CTRL+SPACEBAR.

31. To sort dates, numbers, and other text in ascending or descending order, click Sort on
the Table menu.

32. To editin print preview, click Magnifier on the Print Preview toolbar.
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33.

34,
35.
36.
37.

To hyphenate a document automatically, click Language on the Tools menu, and then
click Hyphenation.

To select a rectangular block of text, press ALT and drag.

To turn overtype mode on or off, double-click OVR on the status bar.

To insert symbols and other special characters, click Symbol on the Insert menu.

To count the number of words in a document or selection, click Word Count on the
Tools menu.

Automatic Text Options

38.

39.

To turn on AutoFormat for creating lines:

In Word 2003 and Word 2002, click AutoCorrect Options on the Tools menu, click the
AutoFormat As You Type tab, and then select the Border lines check box.

In Word 2000, click AutoCorrect on the Tools menu, click the AutoFormat As You Type
tab, and then select the Borders check box.

To create a line, press and hold the hyphen key to make at least three hyphens, and
then press ENTER. To create a thicker line, hold the SHIFT key down at the same time,
making at least three underlines before pressing ENTER.

Working With Graphics

40.
41.

42.
43.

44.

To use a button on the Drawing toolbar multiple times, double-click the button.

To restore an imported graphic to its original size, press CTRL and double-click the
graphic.

To resize an imported graphic and keep its original proportions, drag a corner handle.
When you resize a graphic, you can see the percentage of the graphic's original height
and width by clicking Picture on the Format menu and then clicking the Size tab.

To wrap text around a graphic, click the graphic, and then click Text Wrapping on the
Picture toolbar.

Mass Mailings

45.

46.

47.

To preview how Word will merge data, click the View Merged Data button on the Mail
Merge toolbar.
To create form letters:
In Word 2003, point to Letters and Mailings on the Tools menu, and then click Mail
Merge.
In Word 2002, point to Letters and Mailings on the Tools menu, and then click Mail
Merge Wizard.
In Word 2000, click Mail Merge on the Tools menu.
To specify options for setting up and printing envelopes:
In Word 2003 and Word 2002, point to Letters and Mailings on the Tools menu, and
then click Envelopes and Labels.

In Word 2000, click Letters and Mailings on the Tools menu.

Working With Labels

48.

To make a sheet of identical labels:
In Word 2003 and Word 2002, point to Letters and Mailings on the Tools menu, click
Envelopes and Labels, click the Labels tab, and then click Full page of the same label.
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In Word 2000, click Envelopes and Labels on the Tools menu, click the Labels tab, and
then click Full page of the same label.

Sharing Information

49.
50.

51.

52.

To track changes, double-click TRK on the status bar.

To view deleted text with strikethrough formatting, clear the Use balloons in Print and
Web option on the Track Changes tab of the Options dialog box (Tools menu). (Applies
to Word 2002 only.)

To review or incorporate tracked changes, click Track Changes on the Tools menu, and
then click Accept Change or Reject Change on the Reviewing toolbar.

To cancel creating an e-mail message, click the E-mail button on the Standard toolbar.

Word And The Web & XML

53.

54.

55.

56.

57.

58.

Note XML features, except for saving documents as XML with the Word XML schema,
are available only in Microsoft Office Professional Edition 2003 and stand-alone
Microsoft Office Word 2003.

When an XML schema is attached to your document, press CTRL+SHIFT+X to display
XML tags.

File Open Advanced - Using this feature, you can find a document that contains
specific text. For example, if you know that you have a file on your computer
containing the words "2005 budget", you can search for all documents
containing this text.

File Save As HTML - This feature allows you to save any Word document as a
web page by converting your Word document to an HTML (Hyper Text Markup
Language) file. Upon using this option, Word's menu's will automatically change
slightly to reveal several HTML menu options and to hide other menu options
which do not apply to HTML documents. In Word, a user can insert animations,
sound, hyperlinks, lines, video, forms, ActiveX controls, and a background into
their web page document.

File Versions - This feature allows you to save an unlimited number of versions
of the same document. For example, you might have one file containing three
versions called "original draft", "Carlton’s edit changes" and "Final Document".
This eliminates the need to save three different documents, thereby saving hard
disk space and better organizing your files. A good example might be a single file
containing a document that was sent to twenty people in which each version
was slightly different, but the majority of the text was similar.

File Send To Mail Recipients / Fax Recipients or Route - Why bother wasting
time and paper to print your document and hand feed it into a fax machine?
With this feature, you can print your Word documents directly to any fax
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59.

60.

61.

62.

63.

64.

65.

66.

machine in the world from your desk, directly to any e-mail address in the world,
or directly to any group of fax numbers and e-mail addresses.

An even better feature is to route the messages, which allows them to be sent to
multiple recipients one after another.

File Properties Summary / Statistics - This feature allows you to record
important information regarding a document such as who created it, keywords,
and comments. The statistics records how much time you actually spent creating
the document. This might be useful in billing your client for services rendered.

Edit Paste Special Paste Link - Not only can you paste text and pictures to/from
Word, but you can paste link them as well. In this manner, as the text or picture
changes in one document, it is automatically updated in the target document.

Edit Find & Replace (trick for converting text data) - Text copied or downloaded
from the web often have a page break at the end of each line of text. In Word,
you can fix this fast by following these steps. First replace all occurrences of two
consecutive paragraph marks with an obscure sting of text such as "88888".
Next, replace all remaining paragraph marks with a space. Finally, replace all of
your obscure strings such as "88888" with two consecutive paragraph marks.
Presto - your data is clean. If your have columns of numbers that don't line up,
try applying a mono-space font such as courier.

View Toolbars Customize - This feature allows you to add or delete icons on
your tools bars. It can be helpful to take 5 minutes to edit your toolbars so that
they display only those icons you use most frequently. In this manner, you may
be more efficient as you work.

View Document Map - This view allows you to see a table of contents on the left
side of your screen and the complete body of text on the right. The table of
contents is hyperlinked automatically making it much easier to scroll and work
with large Word documents.

View Full Screen - This view utilizes the whole monitor, temporarily hiding the
tool bars and other visual elements of Word.

View Zoom (10% view) - This view is great for spot checking the layout of a
document with multiple pages prior to printing.

Insert Comment - Just like a yellow sticky note, this feature allows you to attach
comments to specific words or sentences.
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67.

68.

69.

70.

71.

72.

73.

74.

75.

76.

77.

78.

Insert Picture WordArt - WordArt is both powerful and easy to use. With this
tool, you can create simple graphical images.

Insert Picture From File - This option allows you to insert any photograph,
picture or clipart image into your document. This feature works great with the
new digital camera technology.

Insert Picture Autoshapes - This feature allows you to insert a wide range of
shapes that can dress up your document.

Insert Object Wave Sound / Media / etc. - Word also allows you to insert sound
clips and even movies directly into your word document. Clicking these wave
sound clips or movies causes them to play.

Insert Bookmark - Similar to a named range in Lotus 1-2-3 or Excel, Word allows
you to apply a name to any word or place in your document. This can be useful in
creating hyperlinks within your document, or from outside your document.

Insert Hyperlink - Word allows you to insert a hyperlink that upon clicking, will
automatically take you to a new location in your document, any document on
your computer, any document on your local area network, or any document on
the world wide web.

Format Font Animation (marching Ants / Sparkle) - Word provides several
affects that add animation to any group of words in your document.

Format Bullets & Numbering Customize - You can use this feature to custom
select the bullet you want, including size and color.

Format Columns Apply to this point forward - This feature provides a quick
method for inserting columns that apply only to a portion of your document.

Format Drop Cap - This feature might be useful in dressing up a newsletter. It
allows you to make the first letter in a paragraph fancy and large.

Format Text Direction (works only in tables) - This feature allows you to change
the direction of text.

Format Style - This feature allows you to assign a name to a set of specific font
attributes such as font, size, color, etc. Thereafter, you can assign all of these
attributes to text with a simple click on the style drop down list. By using styles,
you can later modify your set of font attributes and those modifications will
automatically flow throughout your document.
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79.

80.

81.

82.

83.

84.

85.

86.

Format Background Fill Effects Picture - Used a great deal on web pages, you
can also apply backgrounds to your word documents. Backgrounds can consist of
colors, patterns, or pictures. It works best with washed out pictures (pictures
that have been lightened) as this does not interfere as much with the readability
of the document.

Tools AutoSummarize - This feature will attempt to create a summary of your
entire document. It might be useful in creating an executive overview - useful as
an introduction to your document or as a method of reading only a "Cliff Notes"
version of a document. Results will vary from good to poor, depending on the
writing style of the author.

Tools AutoCorrect - This tool allows you to use abbreviations to represent longer
phrases. For example, you could use this tool to write out the entire phrase
"James Carlton Collins" each time you type the letters "jcc". This feature is also
useful in automatically correcting words that you frequently mis-type.

Tools Tracking Compare Documents / Accept Reject Changes - This tool allows
you to compare a revised document against the original to produce a document
containing a "strike through" and "bolded" view of all additions and deletions to
the revised document. You can use the Accept/Reject dialog to automate the
process of reviewing and approving all changes.

Tools Merge - This feature allows you to open a new document within your
existing document, which you may find easier than opening a new document,
cutting and pasting the text, then closing that document.

Mail Merge - This tool works best when used in conjunction with database
information or a table of information. A good example for using this feature
would be to merge a letter with the name, address, and other information for
one hundred people. The result is multiple copies of the same letter, each
addressed to a different person.

Tools, Options (several key settings here) - You can customize several settings
that can make it easier and more efficient to use Word. For example, you can set
up the default data directory, your default font, default paper tray, autosave
settings etc. Each user should take time to review all features.

Table Draw Table - This tool allows you to draw a table by hand and can be
useful when creating intricate tables with many cells of different heights and
widths.
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88.

89.

Table Insert / Merge / Distribute - A table is the best method for displaying
numbers and financial information. All CPAs should practice using tables
including the merge and distribute features.

Microsoft Free Stuff - Word's "help on the web" feature takes you directly to
several good Microsoft web sites where you can download free Word add-ons
and templates, or access the Microsoft knowledge base to get your questions
answered.

Control + Y Repeat Steps (AKA F4 Key) - This keyboard shortcut will repeat the
last Word command you invoked. | often find it easier to apply styles all at one
time using the CTRL Y short cut in a zoom 25% view.
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Enhancements to Outlook 2007

One of the first things you'll notice about the new Outlook is some differences in the interface.
The navigation pane on the left is largely the same as Outlook 2003 but now you can click the
double-arrow to quickly minimize it and tuck it out of your way. The other big new thing is the
To Do Bar -- on the right side of the screen a quick view of your calendar and, most importantly,
a task list that shows you immediate To-Do items which includes E-mails that you have flagged.

Mail To Do - Clicking the follow-up flags now lets you essentially make to-do items out of your
mail items and it adds them to your To-Do Bar. This makes it much easier to organize your
workflow and keep up with work that needs to be done. Essentially when you right-click the
follow-up flag you specify the time-line: i.e. it's due Today, Tomorrow, This Week, etc. Or you
can specify a custom date. That becomes the Due Date which controls how the e-mail item is
displayed on the To-Do Bar.

Calendar - The Calendar gets a new look too with tasks due on a particular day being listed in a
box at the bottom of the Calendar page as if part of that day. It's hard to describe but it makes
sense when you see it. You can also overlay two calendars upon each other to make it easier to
sync them up and find conflicts and available times.

RSS - (Really Simple Syndication) is meant to provide users with an easy way to monitor multiple
sources of news, blogs, and other content which has headline-style delimitations and is updated
frequently. It is an open, publicly-defined and developed format based on standard XML and
hosted by the publishers’ web servers. A user ‘subscribes’ to an RSS ‘feed’ using an application
with RSS aggregation capabilities.

RSS Aggregation in Outlook provides users with a consistent look and feel compared to the
traditional Outlook functions. From the beginning process of connecting to a feed using the RSS
subscription process through managing the feeds and their associated folder hierarchies, and
potentially sharing feeds with others, Outlook provides a consistent look and feel for managing
these areas. Further, Outlook 2010 has officially

adopted the Mozilla Firefox Orange RSS Icon as | Ttems
the standard icon for the RSS Feeds folder in
[ 4 - Outlook o
Outlook 2010. & 3 5 -Mewsgator
H [J 6 -intraViews
a] Deleted Ttems {134)

&

Interacting with RSS feeds will be similar to

&

. . . . 7| Drafts [1]
managing your mail items now. Since we will = Inbox
have RSS live within the mail module we will keep _5 InfoPath Forms i
the standard look and feel of folders, hierarchies, 63"““5"““'"'[22';
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times.

Microsoft Outlook 2003 does not directly access or display RSS or Atom content. However, there
are several add-ons by third-party companies that incorporate RSS and Atom viewing in
Outlook. When Microsoft Outlook 2010 is released with RSS aggregator, companies like
Newsgator, intraVnews and Attensa that develop Outlook RSS plug-ins may have to roll out
more creative features soon to compete with Outlook RSS reader. Same holds true for
standalone aggregators like Feeddemon or RSSBandit.

Bye Bye Outlook Editor - The Word editor is now the only editor and it's been nicely enhanced
for Outlook. You don't need to have Word to use the editor because it comes as a special DLL
file with Outlook. The speed is nice and the capabilities are rich.

Power Search - The indexing power of MSN Desktop Search is built-into Outlook now. It
constantly indexes in the background meaning that searching, even across multiple folders, is
much faster and more powerful than before. It even does type-ahead searching where you can
start typing in the field and you can watch the results-set narrow as you type.

Presented below are several screen shots for Outlook 2010.
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Signatures

A signature is a block of text that is appended automatically to each new message or
reply. The signature usually contains the title and name of the organization of the
sender as well as alternative contact details, such as a postal address and telephone and
fax numbers. Signatures can also include a closing quote.

Most e-mail packages allow for multiple signatures. One signature will be designated
the “default”, however, the others will be available from a menu option. Using
signatures saves time and increases accuracy. You could also create additional
signatures which are extra disclaimers to add to the bottom of the e-mail in certain
situations.

Signatures and Stationery @Iéj

E-mail Signature | Personal Stationery

Select signature to edit Choose default signature

catton P E-mail gecount: | carlton @ASAResearch.com E
New messages: Carlton
Replies/forwards: | -ariton E

| peete | [ New | _ Rename

Edit signature

Calibri (Boddy) E 1 E B I U _E = = | [adbusnesscard | |& &

Sincerely, -

S Canitl_ Zaz s

J. Carlton Collins
ASA Research
Atlanta, Georgia
770.734.0550

Attaching Files to E-mail

The success of sending attachments to e-mail messages depends on the capabilities of
the client software used by the individuals that are sending and receiving the message
and the mail transport services provided by both your and their respective Internet mail
service providers.

The Internet is a 7-bit network. The problem is caused by the relative incompatibility of
the coding schemes used to encode 8-bit files for transport over a 7-bit network. The
most popular methods used today are MIME (Multi-purpose Internet Mail Extensions)
and UU Encode/Decode. Although this was a very common problem in the past, most e-
mail clients will now handle these formats automatically and transparently send them to
the user. Accordingly, attaching a file to an e-mail is much easier than it used to be and
almost always works just fine. As shown in the screen below, it is possible to send
multiple attachments to a single e-mail message.
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™ Files you requested - Message (HTML) E@E|
File Edit Wiew Insert Format PGP Tools  Actions  Help -
Mormal - Arial - 10 - é B I U

=lgend  Accounts - [ S @ R0 m@e ' 4 ¥ [zoptons. 4

To... |Drew@accountingsoftwareadvisor.com
ce ||
Bec... |

Subject: |Files wou requested

&
Tl
&7l
-

Attach... | | nICs doc (237 KE); B chips.doc (68 KEY; B Code Names.doc (83 KB); B8] Computer Trivia.doc (26 KBY; ~
B Cover Pages.doc (998 KEY; B CPU.doc (62 kB); ] database .doc (55 KEY; B ]Digital Images.dac (1 MEY;
Ergonomics.doc (570 KE); @Event Triggered Reporting.doc (123 KB); @hubs.doc (60 KBY; @Instant messaging.doc (48 KB ;
®Imice.dac 66 kEY: 12 Mice drew (205 kB1: B IMeritor, daoc (73 KEY s

Dear Drew:
Here are the files you requested

Sincerely,

J. Carlton Colling, CPA
ASA Research - www. asaresearch.corm
Accounting Software Advisor - www. accountingsoftwareadvisor.corm

AdvisorCPE - wew. advisorcpe. cormn
770.734.0950
Atlanta, Georgia 30092 ¥

One common problem is attaching very large files. Many e-mail servers will strip
attachments larger than 2 to 10 MBs. Furthermore, users may have limits on the sizes
of their mailboxes on the mail server. If they receive several large attachments they
may exceed these limits and be unable to receive the attachments. Changing settings
on the mail servers can solve both of these problems. Unfortunately, you often have no
ability to control the settings on the mail servers of those you are sending mail.
Depending on your environment, you may not even have the ability to get the person
who administers your mail server to change these settings. This is certainly one of the
advantages of hosting your own mail in-house.

Large file attachments also require additional time to send and receive if you have a low
bandwidth connection (i.e. a modem connection). A one-megabyte report may take as
many as 10 minutes to send to your mail server and 10 minutes for the recipient to
retrieve the file from his or her mailbox. If you have a relatively slow Internet
connection and you frequently send large files, you may want to consider compressing
the files before you send them using a compression utility such as WinZip or WinRAR.
Binary files can usually be compressed to 10-25% of their normal size, speeding effective
transfer rates by 4 to 10 times the uncompressed rate.

Junk Mail

Junk mail is not only an aggravation, but a waste of valuable business time. Even if you
never sign up for junk mailings, your e-mail address will eventually fall into the hands of
junk e-mailers.

In response to increasing spam hazards and attacks the 108th Congress passed S. 877,
also known as the CAN-SPAM Act of 2003. The law signed into effect by President Bush
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on December 16, 2003 states that the FTC has the authority to establish a “do not
email” list similar to the do-not-call list to combat telemarketing. The law also prohibits
the use of deceptive subject lines and false headers and states that unsolicited
commercial messages must include opt-out instructions and the sender’s physical
address.

As an alternative to legislation, many of the new, more powerful Internet e-mail clients
have features built-in that allow you to filter out junk e-mail. Microsoft Outlook,
Netscape Messenger, and Microsoft Outlook Express all provide for junk mail filtering as
well as other e-mail filtering.

New Junk messages will appear Gravy, £

15
@ Automaticaly | color > | Adult Content messages |Maroon _+ Turn on

click here
Junk E-Msi

Junk Mail Filtering Using Outlook

Junk Mail - Junk mail is not only an aggravation, but a waste of valuable business
time. Even if you never sign up for junk mailings, your e-mail address will eventually fall
into the hands of junk e-mailers. In response to increasing spam hazards and attacks
the 108th Congress passed S. 877, also known as the CAN-SPAM Act of 2003. The law
signed into effect by President Bush on December 16, 2003 states that the FTC has the
authority to establish a “do not email” list similar to the do-not-call list to combat
telemarketing. The law also prohibits the use of deceptive subject lines and false
headers and states that unsolicited commercial messages must include opt-out
instructions and the sender’s physical address.

As an alternative to this legislation, Microsoft Outlook now provides junk mail filtering
as well as other e-mail filtering.

[ “al

Junk E-mail Options @

Options | Safe Senders | Safe Recipients | Blacked Senders | International

E‘—l Qutlook can move messages that appear to be junk e-mail into a special
@ JunkE-mail falder,

Choose the level of junk e-mail protection wou want;

() Mo Aukornatic Filkering. Mail from blacked senders is still maved to
the Junk E-mail Folder,

(%) Low: Move the most obvious junk e-mail ta the Junk E-mail Folder.

(") High: Most junk e-mail is caught, but some regular mail may be
caught as well, Check your Junk E-mail Folder often,

(7 5afe Lists Only: Only mail from people or domains on your Safe
Senders List or Safe Recipients List will be delivered to wour Inbosx,

[w]Permanently delete suspected junk e-mail instead of moving it to the :
Junk E-mnail folder
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Using Outlook’s Junk Mail Filtering

You should review the Junk E-Mail Options box in Outlook and make sure that the
settings meet your needs. In the future if you receive junk e-mail, you can right mouse
click on that e-mail and tell Outlook that this is junk e-mail. Outlook will capture the
sender’s information and use it to identify new junk mail in the future.

Leaving Mail on Your Server — If you normally read e-mail from more than one
computer, you should consider setting the less frequently used computer’s settings to
leave a copy of the mail on the mail server. To do this, select Tools, E-Mail Accounts,
More Settings, Advanced, Leave a copy of the message on server as shown in the
screen below.

Internet E-mail Settings

General || Outgoing Server | Connection | Advanced

Server Port Mumbers

Incoming server (POP3): 110 Use Defaulks

[ This server requires an encrypted connection (5500
Qutgaing server (SMTP): ras]
[ This server requires an encrypted connection {5513
Server Timeouts

short ] Long 1 minute

Delivery

[?lieave a copy of messages on the server!

[ remove From server after days

[CJremove From server when deleted from 'Delsted Thems'

Tip for Accessing E-Mail from Multiple Computers —
Leave a Copy of the Mail on the Mail Server

This measure will allow you to read your mail from your less frequently used computer
without deleting the mail from the mail server so it can also be read by your primary
computer system as well. Using this approach, you will have a complete record of all of
your mail on one computer system.

Maintain multiple e-mail addresses — It is a good idea to use more than one e-mail
account — one for business purposes and another for situations that may expose you to
spam or junk mail. There are many services that offer free e-mail accounts, such as
Microsoft Hotmail, that could be used for this service with no additional costs. This
would allow you to use the free e-mail account to gain access to chat rooms, or
subscribe to newsletters for example.

Reading Multiple E-mail Accounts — If you have multiple e-mail addresses, Outlook can
be configured to read all of them at the same time. Just set up each mail account using
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the Tool, E-Mail Accounts option on the Outlook main menu. You can also create groups
of e-mail addresses using the Tools, Options, Mail Setup, Send/Receive Groups option
in order to better control these groups. For example, you may set up Outlook to check
your primary e-mail accounts for new mail every three minutes, while other e-mail
accounts (such as older unused e-mail accounts that attract large volumes of spam and
junk mail) are checked manually.

Play a Sound when Mail Arrives — Outlook automatically plays a sound when mail
arrives to notify you of incoming e-mails. This feature can be a nice feature that allows
you to respond to e-mail instantly. However, this feature can also be distracting to you
or others around you. For this reason, you should consider turning off this feature by
selecting Tools, Options, Preferences, E-Mail Options, Advanced E-Mail Options from
the Outlook main menu.

Receiving E-Mail Timely — Some people turn their e-mail and computers off, and then
turn their computers on and launch their e-mails in order to check their e-mail. This can
be a very inefficient method. A better approach to receiving e-mail might be to leave
your computer running 100% of the time, and leave Outlook open 100% of the time.
You could also set Outlook to check for new messages every three minutes or so by
selecting Tools, Options, Mail Setup, Send Receive from the Outlook main menu and
setting the system to check e-mail every three minutes. In this way, your computer
system will constantly check and receive e-mail on your behalf, and this e-mail will be
available to you immediately when you are ready to check your e-mail. The alternative is
to wait on your computer to launch, wait on your e-mail application to launch, and wait
on the system to retrieve your e-mail each time you want to read mail. Obviously the
latter approach is timely and inefficient. Like wise you can use these same instructions
to configure your system to send messages immediately whenever you are connected to
the Internet. This setting will ensure that your e-mails are being sent as soon as possible.

HTML Text — Outlook can receive mail in plain text, rich text or HTML formats. Using the
plain text setting can be a critical mistake for several reasons. Today, many people send
mail using HTML text which is formatted to be easier to read. When HTML e-mails are
received as plain text e-mails, they are converted in such a way that they can be
extremely difficult, if not impossible to read; for example, HTML e-mails that contain
table information or pictures. In both cases, the table structure is destroyed and the
pictures are eliminated. The result is that the recipient does not get the full benefit of
receiving the e-mail in its intended format.

Default Fonts and Stationery Picker — It is a good idea to take a few minutes to
configure Outlook to use default fonts and stationary that meet your particular taste. To
do this, select Tools, Options, Mail Format, Fonts and Stationary Picker from the
Outlook main menu. This step will ensure that the e-mails you send have the look and
feel that you want.
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Spell Check — Outlook can be set to automatically spell check each mail message prior to
sending. To set up this option, select Tools, Options, Spelling from the Outlook main
menu and make the appropriate selections to check spelling automatically using the
language and grammar rules you specify.

Digital IDs — To send and receive encrypted e-mail messages, select Tools, Options,
Security, Digital IDs from the Outlook main menu. Follow the instructions to purchase
and install your own digital ID, and then send your digital ID to all of the people you
correspond with on a regular basis. In addition, the people you correspond to will also
need to obtain their own digital IDs and send a copy to you. Thereafter, Outlook will
organize and mange your digital IDs, and will automatically encrypt e-mail messages you
send and decrypt messages you receive.

Appointment Scheduling

It is possible to send e-mails from Outlook requesting that the recipients attend a
meeting or conference call. To do this, simply select New Appointment from the
Outlook main menu as shown in the screen below.

Inbox - Microsoft Outlook

! Fle Edt Miew Go  Tools  Ackig

HIESE v|| =4 (2 X | i Reply

e Mail Message

KB

Post in This Folder I

Folder...
Search Falder. ..

Mavigation Pane Shaorkout, .

Appointrment

Meeting Reguest

Contack

Ll 5 D 11

Diskribution Lisk

Next enter the recipients you would like to invite to attend the meeting, indicate a date
and time and send the e-mail. The resulting e-mail will appear as follows:
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P program SBA tuterial training - Recurring Meeting
i File Edit ‘Miew Insert Format  Took  Actions  Help

" Agcept | D Teptative | X Decling \ Propose Mew Time | mCalendar... | Q | X | &+ - T - \ 1% \ @ !

Sent:  Tue 4f12(2005 8:32 PM

Frarn: A Tsaias Rodriguez (Think Act) [v-isairo@rmicrosoft.com]

Required:  w-dind@microsoft.com; carlkon@accountingsoftwareadvisar, com; maryou@accountingsoftwareadvisor, com
Optional:  Terry Murdock; Betsy Totten (Training Associates); Patrick Yiernes

Subject: AP program SBA tutorial training

Location:  Conf Call (§66-500-6735 Pass Code:4472354)
Wwhen: Oceurs every Wednesday effective 471372005 until 518/2005 From 11:00 AM ko 11:30 AM (GMT-08:00) GMT -0800 (Standard) { GMT -0700 (Daylight).

Setting up a reocurring meeting to review:
Status
lssues

Patrick, Betsy and Terry, | put you as optional

Thanks,
lzaiag

Notice the Accept, tentative, and Decline buttons at the top of the e-mail? All the
recipient needs to do is click on the appropriate button and not only is the sender
notified of you answer, if you accept the meeting, it is automatically inserted inn your
Outlook Calendar. If you try to accept the meeting and you have a conflict on your
calendar, Outlook will notify you of this conflict. The resulting appointment in your
calendar appears as follows.

[®] Calenda osoft O
i Fle  Edi Miew Go Tools Actions Help  Adobe PDF Type aquestion For help =
Mew = | (= Today | [T Day [5]uork week | 7] week | 31 Month || 20 Find Type a contact ko Find o !
| Pt +| 4 X (il G Today | ()0 (5] work wesk (7] ek [STManth]| % Find | (4 Tv0e o con -9
ﬁOpen Morton AntiSpar .This s Spam .Th\s Is nat Spam @Empty The Spam Folder ! @ fess} @ !
b —
Calendar Calendar April
« March 2005 S Maonday | Tuesday | wednesday Thursday Friday Satfsun
SMTWTFS March 21 2 2
EFE 1 2 3 4 2:00pm_Review NASEA
6 7 8 9101 s - A s F i g |
e R P program SBA tutorial training - Recurring Meeting E]@Hi] =
22 g; Zzg gg g‘: 9 ¢ File Edit Yiew Insert Format  Tools  Actions  Help Dy (United Statd
i accept | 2 Tentative | ¢ Decline | < Propose Mew Time | @Ca_\_erjc_lay..._ =S| x | & » & ~|a} | @) !
‘8nRl; Appointment l Scheduling | 2
M T T8
kil 5 from 11:00 M to 1 {iEM ndard) { GMT -0700
345 67 3
10 11 1213 14 1 e
17 1920 21 2 Warner's Birthday
27 2; G 2-: 2? 2 Organizer:  Isaias Rodriguez (Think Act) [v-isairo@microsoft, com] Sent:  Tue 4122005 8:32 PM -
- Subject: |AP program B4 tutarial training | 7
My Calendars
- Location: |Cnnf Call (B66-500-6738 Pass Code:4472354) | Label: ||:| one v| =
[ calendar -
1
Open & Shared Calendell  Startbime; | Wed 4/13/2005 v| 2oopm v Al day event
End time: [wed 471312005 v| [zzoem v
16
Fustin's Birthday
[ remindsr: Wiz show time as:
17
Meeting Worksy Thiz is an online meeting using: |.‘ i
~ 23
Setting up a rencurting meeting to review: L
Status
Issues w 24
[ Contacts,.. J | | [Categoriesm] | ‘ Private
-

Ee- Bs- 3Ad [ En

Not only does this appointment include the date, time and duration of the meeting, it
also includes a list of all attendees as well as call in or driving instructions automatically.

Copyright 2010, All Rights Reserved Page 105



Microsoft Office & Windows 7 for CPAs www.CarltonCollins.com

By clicking on the scheduling tab, you can also see the availability of all participants as
shown below, just in case you want to try to reschedule. Pretty cool.

i ap program SBA tutorial training - Recurring Meeting,

i Fle Edit View Insett Format  Tooks  Actions  Help

o Accept | 2 Tentative | »¢ Decline | & Propose New Time | jca[endar... =3 | | & - % - % | @ H

Appoinktment Scheduling

Zoom: | 100% (Day Yiew) + v, April 13, 2005 Thursday,
9:00 10:00 11:00 12:00 1:00 2:00 3:00 4:00 200

‘ Al Attendees

]
© [Isaias Rodriguez (Think Act)] [ T T T L R D T T T I I T
479 ‘m@mmnmm Y ; S NSNS
@ |carlton@accountingsoftwart

B [marylou@accounting o bral |X T R P S T I I I I,
a 3
a
a

o

ey rdosk imurdorkda] S R R
ety Totten (Tramng Asso] A Y
o Verns <Diernes@] [ R

7

L | | ]

< >

Mesting stak bime: | Wed 4/13/2005 | | 2:00 PM E¥)
AutaPick Mext >2 Meeting end time: | Wed 4/13/2005 | |2:30 PM v

M Busy B Tentative M Outof Office 0 Mo Infarmation

Managing Mail Folders — If you keep a copy of every e-mail you send and receive,
eventually your mail folder will grow to an unreasonable size which can slow down the
performance of your system, hamper backup efforts, and potentially cause instability
issues — especially when PST file sizes begin to exceed 12 Gigabytes. To alleviate this
problem, you should create new PST files periodically and move older e-mail messages
to these PST files. This approach will result in the creation of multiple mail folder files,
instead of one large mail folder file. All sent and received email will still be available to
you, it will just be available through separate mail folders instead one mail folder.

To do this, select File, Data File Management from the Outlook main menu. Click the
Add button and follow the instructions to create a new PST file. For example, if you have
two years worth of e-mail messages from the years 2004 and 2005, you might consider
setting up a new PST file called “2004 PST”. Once this folder is created, you can then
drag and drop your older 2004 e-mails from your current inbox to the 2004 PST folder.
This action will help you keep your current inbox file size smaller and more manageable.
This particular tip is more applicable to people who maintain thousands of e-mails and

numerous large attachments. An example of the navigation pane depicting multiple mail
folders is shown below.

1l Loyl Search Folders
H =y 2003 PaT
H 3§ 2004 P5T
# =y 2005 Inbox PST
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Creating Multiple PST Folders in Outlook to Keep the Size of Folders Manageable

Outlook Rules and Alerts — Outlook provides an extensive capability to create rules and
alerts related to incoming and outgoing e-mails. To create a new rule select Tools, Rules
and Alerts, New Rules from the Outlook main menu. Rules may be created from scratch
or by starting with a rules template. The screens below depict a portion of the process
for setting up a rule that automatically deletes e-mails containing the word “insurance”.

r

Rules Wizard

(") Stark creating a rule from a template

Which condition(s) do wou want ko check?
Step 1: Select gondition(s)\

[ from

[ thraugh the specified accadgt
[ sent only ko me

[] where my name is in the
Step 2: Editthe ll [ marked as importance
Apply this rule f [ marked as sensitiviey
[ Alagged For action

Ru'es Wizard

What do wou want ko do with the message?
Step 1: Select action(s)

E w:ere iy ame !s !n E:e 1 [] move it to the specified Folder -
WINBrE i name 1> In the ] assign it ko the cateqory category

[ where my name is notk in i
[] sent o people or distrib
with specific words in the

delete it

[ permanently delete it
[ mowve a copy ta the specified Folder

[ Forward it ko people or distribution list

[ Forward it to people or distribution list as an attachment
Apply this rule after the me: [ reply using a specific templake

withinsurancedn the body | | Flag message For action in a number of dayvs

) ["] flag message with a colored Flag

[] clear the Message Flag

[ mark it as importance

[ print it e

Step 2: Edit the rule descripti

Step 2: Edit the rule description (click an underlined walue)

Apply this rule after the message arrives
@ with insurance in the body

delete it

’ Cancel ][ < Back ” Mext = l[ Finish

Creating Rules and Alerts in Outlook

Rules can be used to accomplish a large number of tasks automatically. For example,
you could create a rule to automatically delete e-mail messages that contain specific
words or arrive from specific senders. They can also be used to identify specific email
messages for marking as a priority, or for automatic forwarding. For example, you may
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create a rule in Outlook to automatically send a copy of any e-mail that contains the
words sales order to your sales manager. As another example, you may create a rule to
automatically reply to all senders announcing that you are out on vacation and will
return the following week. The number of rules you can create in Outlook are unlimited.
The clever user can configure Outlook using the built-in rules and alerts feature to
accomplish many objectives.

Outlook Tips

1.

Create a task from a file containing details about the task with minimal effort on your
part: Drag the file to the Tasks button in the Navigation Pane. A new task opens with
the file attached. Fill in the rest of the information about the task, and then click Save
and Close.

Use the Bcc line (instead of the To or the Cc line) when you want to send out mail to lots
of people but don't necessarily want to advertise everyone's e-mail address to everyone
else. See, the people whose names are in this box get a copy of your message, but their
names and addresses aren't visible to the other recipients of the message. It's quick, it's
easy, and it's the right thing to do.

To find related messages, right-click the message, and then on the shortcut menu, point
to Find All and then click Related Messages. The Advanced Find dialog box appears with
a list of related messages.

Mail Tips

4.

10.

Set a reminder to reply to a message Right-click the message you want to set the
reminder for, point to Follow Up, and then click Add Reminder. In the Due By list,
click the date when you have to complete the reply. In the second list, click a time. In
the Flag color list, click the flag color you want, and then click OK.

Add your own words to a follow-up flag for a new message Click the Message Flag
button and then type the text you want in the Flag to box.

Send a message to multiple people without revealing other recipients’ identities To
send a message to someone without other recipients of the message knowing, use the
Bcc line in the message. Bcc stands for blind carbon copy. If you add someone's name
to the Bcc line, a copy of the message is sent to that person, but his or her name is not
visible to other recipients.

Find related messages To find related messages, right-click the message, and then on
the shortcut menu, point to Find All and then click Related Messages. The Advanced
Find dialog box appears with a list of related messages.

Jog your memory with a follow-up flag Create a follow-up flag as a reminder to
follow up on a message. On the Actions menu, click Follow Up and click the flag color
of your choice.

Save searches that you use often. On the Tools menu, point to Find and then click
Advanced Find. In the Advanced Find dialog box, specify your search criteria and click
Save Search on the File menu. You can share the search results with others by sending
the search results file as an attachment in an e-mail message.

Search for and move items or files to different folders. On the Tools menu, point to
Find and then click Advanced Find. In the Advanced Find dialog box, specify your
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11.

12.

13.

14.

15.

16.

17.

18.

19.

20.

21.

22.

23.

24.

25.

26.

27.

search criteria and click Find Now. After the results are displayed in the search results
window, move them to the folder of your choice.

Use a file shortcut instead of an attachment to reduce the size of a message. Right-
click the file and drag it to the Inbox. On the shortcut menu, click Send with Shortcut.
Sort messages alphabetically by sender name To sort, click Arranged By and then
click From. To reverse the alphabetical order, click From again. To sort by Subject line,
click Subject. You can sort this way in any table in Outlook.

Receive notifications when messages you send are delivered or read On the Tools
menu, click Options, and then click the Preferences tab. Click E-mail Options, and
then click Tracking Options.

Verify that the message is authentic If you have security set up, you can verify that a
message you receive with a digital signature has not been tampered with. In the
message, click the Verify Digital Signature button.

Quickly mark a message as read Right-click the message and then click Mark as
Read.

Make a folder available for online and offline use Right-click the folder, click
Properties, and then click the Synchronization tab. The folder must be on your
network, not on your hard disk.

Want to move an Inbox item to a folder in the Navigation Pane but can't see the
folder? Drag the item to the top or bottom of the group and pause until the correct
folder scrolls into view. Subfolders must be expanded to view them.

Quickly see the next or previous mail message in a conversation or thread In a
message, click the small arrow next to the Previous Item button or Next Item button,
and then click Item in Conversation Topic.

Quickly print search results from your Inbox To print a list of your search results
from the Advanced Find dialog box, press CTRL+P.

Recall that message! To recall or replace a sent message, open the message in the
Sent Items folder, and on the Actions menu, click Recall This Message.

Automatically add a signature or logo to each message you send On the Tools
menu, click Options, and then click the Mail Format tab. If you have more than one
account, select the account you want to create the signature for, and then click
Signatures.

Show blocked images in an e-mail message Click the InfoBar at the top of the
message, and then click Download Pictures.

Keep track of messages that require action Instead of just using rules to move
messages to folders, use rules to assign a category to a message. Then the messages
will be arranged in groups in your Inbox.

See more messages in your Inbox with single-line view Change from multiline view
to single-line view. On the View menu, point to Arrange By, and then click Custom.
Click Other Settings. Clear the Use multi-line layout in widths smaller than n
characters check box.

Quickly test the hyperlink in the message you just wrote Press CTRL while you click
the hyperlink.

Speed up exporting and archiving items Make exports and archives of your Outlook
mailbox faster by emptying the Deleted Items folder first. Right-click the Deleted
Items folder, and then click Empty "Deleted Items" Folder.

Does your mailbox need a quick cleanup? On the Tools menu, click Mailbox
Cleanup. Select options to find items that are old or large and then move or delete
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28.

29.

30.

31.

32.

33.

34.

35.

36.

37.

38.

39.

40.

41.

them. Click AutoArchive to move old items to Archive Folders, or click Empty to
permanently delete items from your Deleted Items folder.

Choose which e-mail account to use If you have multiple e-mail accounts in Outlook,
you can choose which to use when sending messages. For example, choose your
Hotmail account, and recipients receive the message from that account, complete
with your Hotmail return address. In a new message, click Accounts, and then click the
account you want from the list.

The mail folder list is just a click away To quickly view the Folder List, click Folder List
in the button tray at the bottom of the Navigation Pane.

Delete names from the AutoComplete list Select the unwanted name by using the
UP ARROW or DOWN ARROW key and then press DELETE.

Keep a Desktop Alert on the desktop To keep a Desktop Alert visible so that you have
more time to read it, pause your insertion point over the alert before it fades from
view.

Want to turn off New Mail Desktop Alerts? On the Tools menu, click Options, click
the Preferences tab, click E-mail Options, and then click Advanced E-mail Options.
Under When new items arrive in my Inbox, clear the Display a New Mail Desktop
Alert (default Inbox only) check box.

Change in priorities? Quickly change the color of a message's Quick Flag Locate the
flagged message in the message list. Right-click the flag, and then click the flag color
that you want on the shortcut menu.

Quickly read messages without opening them To see the first three lines of each
message in the message list, on the View menu, click AutoPreview. To see the
complete message to the right of the message list, on the View menu, point to
Reading Pane, and then click Right.

Make sending a file through e-mail even easier You can send a file on your computer
through e-mail by right-clicking the file, pointing to Send To, and then clicking Mail
Recipient. Text is automatically added to the body of the message; however, you can
delete the text and add your own text by clicking in the message body and pressing
CTRL+A.

Reduce spam by not replying to suspicious e-mail messages Replying tells a
spammer that your e-mail address is valid and probably won't remove you from their
mailing list.

Create a Search Folder quickly from the Find bar Press CTRL+E to open the Find bar,
type what you want to find in the Look for box, specify which folder to look in by using
the Search In box, and then click Find Now. When the search is complete, click
Options on the Find bar, and then click Save Search as Search Folder.

Find all messages sent by the same person Right-click a message from that person,
and then on the shortcut menu, point to Find All. Click Messages from Sender. The
Advanced Find dialog box displays a list of all messages in a folder from that person.
Get a different view of the way that Outlook groups messages By default, Outlook
groups messages by periods of time such as Today, Yesterday, and Last Week. To
collapse a section to see only the group heading, select any message and then press
the LEFT ARROW key. The RIGHT ARROW key expands the group.

Quickly add an attachment to a new message Locate the file, for example a .doc file
in your My Documents folder, and then drag it to your Inbox. Outlook opens a new e-
mail message with the file attached. You can also drag multiple files.

Flag that message fast Select a message in the message list, and then press INSERT.
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42.

43.

44.

45.

46.

47.

48.

49.

50.

Was an important message sent to the Junk E-mail folder? If an item gets moved to
your Junk E-mail folder by mistake, select the message, and then press CTRL+ ALT+J.
Save multiple attachments at one time Open the message. On the File menu, click
Save Attachments. Click OK, and then click the folder where you want to save the
attached files. Click OK.

View all your unread messages in the Inbox On the View menu, point to Arrange By,
point to Current View, and then click Unread Messages in This Folder.

Create a rule from a message Right-click the message, and then click Create Rule.
Select the conditions and actions you want to apply, and then click OK.

Start fresh! Clear your address history To clear your AutoComplete cache, open the
C:\Documents and Settings\user name\Application Data\Microsoft\Outlook folder,
and then delete the profile_name.nk2 file. Outlook recreates this file as you type new
addresses.

Check an e-mail alias against the names in your address books To immediately
resolve an e-mail alias in the To, Cc, or Bcc box, press CTRL+K.

Make a message unavailable to recipients after a specific date To set the expiration
date on a message you are composing, click Options . Under Delivery options, select
the Expires after check box, and then in the lists, select the date and time you want
the message to expire.

Save a message thread in a text file Select the messages by pressing CTRL and
clicking the messages you want. On the File menu, click Save As. Your messages are
saved to a .txt file. Only message headers (To, From, Sent, and Subject) and body text
are saved; attachments and and HTML formatting are not included in the text file.
Open several messages at the same time Hold CTRL while you click each message.
After you select the messages, on the File menu, point to Open, and then click
Selected Items.

Calendar Tips

51.

52.

53.

54.

55.

56.

57.

Automatically add holidays to your Calendar On the Tools menu, click Options, click
Calendar Options, and then click Add Holidays.

Quickly display several days side by side in Calendar In the date picker, drag over
the dates that you want to view.

Contact meeting attendees with a reminder or other message Open the original
meeting request, click the Actions menu, and then click New Message to Attendees.
Show Saturday and Sunday in separate boxes in your monthly calendar To show
weekend days in separate boxes in the Month view, right-click anywhere in Calendar
view, and then click Other Settings. Clear the Compress weekend days check box.
Change your time zone To quickly change the time zone in your calendar, change
your calendar view to Day or Work Week, right-click the time bar, and then click
Change Time Zone.

Need to schedule a meeting with someone in another time zone? Just add the time
zone to Outlook. On the Tools menu, click Options, and then click the Preferences tab.
Click Calendar Options, click Time Zone, and then select the Show an additional time
zone check box. Click the time zone you want in the Time zone list.

Abbreviate when entering meeting times When you enter appointments in the
Calendar, you can save time by typing abbreviations and allowing Outlook to fill in the
rest. For example, if you want to enter a 6:00 P.M. meeting, open a new meeting
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58.

59.

60.

61.

62.

63.

64.

65.

66.

67.

68.

69.

70.

71.

72.

73.

74.

request and then type 600p. You can also use phrases such as "tomorrow" or "next
Monday," and Outlook automatically inserts the correct date.

Quickly create an appointment in Calendar Click the day, drag over the block of time
when the appointment occurs, and then type a description.

Quickly switch to viewing by month in Calendar Click in Calendar, and then press
ALT+EQUAL SIGN.

To set an appointment to repeat, designate it as recurring In the appointment, click
the Actions menu, and then click Recurrence.

Use your e-mail signature for meeting requests On the Insert menu, click Signature
and then click the signature that you want to use.

Let Outlook find a meeting time when all attendees are available On the Scheduling
tab, type the names of the attendees in the All Attendees list, and then click AutoPick
Next.

Quickly see when conference rooms in your building are available On the
Scheduling tab of a new meeting request, add all rooms as resources to the All
Attendees list. After you find a conference room that is available, delete the others.
Quickly create an all-day event in Calendar Click the day heading that you want, and
then type the name of the event. If the event lasts several days, click the first day
heading, drag across all days, and then type the event name.

Quickly switch between viewing a day, week, or month in Calendar Click the day,
click to the left of the week row, or click the day of the week heading.

Quickly move an appointment Drag it to a new date or time in your Calendar or in
the date picker.

Change the subject of a meeting or appointment In Calendar, click the meeting and
then type the new subject.

Change the time periods in the Calendar grid You can change the default setting for
30-minute time slots to 5-, 6-, 10-, 15-, or 60-minute time slots. Right-click the
Calendar, click Other Settings, and then click the number you want from the Time
Scale list.

Need consensus on a meeting time? Let invitees propose new meeting times On the
Tools menu, click Options. Click Preferences and then click Calendar options. In the
Calendar options section, select the Allow attendees to propose new meeting times
for meetings you organize check box.

Change the number of days shown in Calendar In Calendar view, press ALT+number,
where number represents the number of days to show in the view between 1 and 9.
Use 0 for a 10-day view.

Manage multiple Calendars? Create a group to store Calendar shortcuts At the
bottom of the Navigation Pane, click the Shortcuts button to display the Shortcuts
pane, and then click Add New Group.

Track all attendees even if you can't send them a meeting request On the
Scheduling tab, in the All Attendees list, click the envelope next to the name, and
then click Don't send meeting to this attendee.

Quickly change an appointment into an all-day event In the Calendar, in Day view,
drag the appointment to the day heading.

Quickly turn an appointment into a meeting Open a new appointment, and on the
toolbar, click Invite Attendees. Type attendees' names in the To box.
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75.

76.

77.

78.

79.

80.

81.

82.

83.

Attach an agenda or meeting minutes to a meeting request |If the agenda or
minutes are in a file, you can attach the file to a meeting request. In the meeting
request, on the Insert menu, click File, and then locate the file you want to attach.
Quickly share meeting notes with attendees Open the meeting request in Calendar,
add the notes, save it, and then drag the item to your Inbox. Drag the meeting
attendees' names from the body of the message to the To box, and then send the
message.

Quickly create a meeting request from a meeting agenda Drag the file that contains
the agenda to the Calendar button in the Navigation Pane, and then complete the
meeting request.

Remove a name fast from Other Calendars To remove a name from the Other
Calendars list, right-click the name, and then click Remove from Other Calendars.
Change the time interval of a reminder to give you more time to prepare On the
Tools menu, click Options. Click Preferences, and then, under Calendar, you can
choose a reminder to alert you from minutes to weeks ahead of time.

Want to see your Calendar while you're looking at the Inbox? In the Navigation
Pane, right-click the Calendar button, and then click Open in New Window on the
shortcut menu.

Automatically open someone else's Inbox or Calendar If you have permission, you
can have Outlook automatically open another person's Inbox or Calendar when you
start Outlook. Just leave the other person's folder open when you exit Outlook.
Quickly copy an appointment in your Calendar Hold down CTRL and drag the
appointment to a new time or date.

Avoid meeting request responses If you're sending a meeting request to a large
group and don't need or want responses, in the open new meeting request, on the
Actions menu, click Request Responses. Specify your meeting information, and then
send the meeting request.

Contacts Tips

84.

85.

86.

87.

88.

89.

90.

Quickly dial a phone number for a contact Right-click the contact, and then on the
shortcut menu, click Call Contact.

Add a new contact from an e-mail message Open the message. In the From field,
right-click the name you want to make into a contact. On the shortcut menu, click Add
to Outlook Contacts.

Create a task related to a contact Click the contact, click the Actions menu, and then
click New Task for Contact.

Are there phone numbers that you have Outlook call frequently? Add them to a
speed dial list. On the Actions menu, point to Call Contact, click New Call and then
click Dialing Options.

Quickly move through contact address cards with the arrow keys Press HOME to
move to the first card. Press END to move to the last card. Use the arrow keys to move
up, down, and across the columns.

Create a contact card from a message Drag the message to the Contacts button in
the Navigation Pane, and then fill in the rest of the information for the contact.

Send a message fast to a contact Click the contact and then on the Actions menu,
click New Message to Contact.
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91. Quickly change the number of columns of contacts in your Contacts list Just drag
one of the vertical dividers that separate the columns.

92. Quickly schedule a meeting with a contact Click the contact and then on the Actions
menu, click New Meeting Request to Contact.

93. Remove a name fast from Other Contacts To remove a name from the Other
Contacts list, right-click the name and then click Remove from Other Contacts.

Notes Tips

94. Send that note fast! Click the note icon in the upper-left corner of the open note and
then click Forward.

95. Quickly create a note from text in another program Select the text and drag it onto
the Notes button in the Navigation Pane.

96. Make your notes more eye-catching Change the color of an Outlook note by right-
clicking the note icon in the Notes pane, pointing to Color, and then clicking a new
color.

97. Assign a note to a category Click the note icon in the upper-left corner of the open
note, and then click Categories.

Tasks Tips

98. Quickly mark a task complete Right-click the task and then click Mark Complete on
the shortcut menu.

99. Quickly assign a task Right-click the task, and then on the shortcut menu, click Assign
Task and type a name in the To box.

100. Remove a name fast from Other Tasks list To remove a name from the Other Tasks
list, right-click the name, and then click Remove from Other Tasks.

101. Change the order of tasks in a task list In the Task pane, when tasks aren't grouped
or sorted, just drag the tasks up or down in the task list.

102. Quickly create a task from a file containing details about the task Drag the file to
the Tasks button in the Navigation Pane. A new task opens with the file attached. Fill
in the rest of the information about the task, and then click Save and Close.

103. Quickly send a new message about a task Drag the task to the Mail button in the

Navigation Pane. This creates a new message with the task name as the subject and
the task details in the body of the message.

Journal Tips

104.

105.

106.

107.

Try the quick way to open Journal entries To open the item, document, or contact in
a Journal entry, double-click the icon in the Journal entry.

Quickly record any file in Journal Drag the file from My Computer to Journal view in
the Navigation Pane.

Quickly record any item in Journal Drag the item to Journal view in the Navigation
Pane.

Quickly go to another date in Journal Click the date heading at the top of the
timeline, and then click the month and day that you want to view.
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Customization Tips

108.

109.

110.

111.

112.

113.

114.

115.

116.

117.

118.

119.

120.

121.

122.

Start Outlook in a folder other than Inbox On the Tools menu, click Options, and
then click the Other tab. In the Advanced Options dialog box, set the startup folder
that you want.

Do you travel between time zones? Add a second time zone and switch between
time zones for all Windows-based programs. Click Swap Time Zones in the Time Zone
dialog box (Tools menu, Options dialog box, Calendar Options dialog box).

Quickly change the time zone for all Windows-based programs Right-click the space
at the top of the time bar when you view days in Calendar, and then click Change
Time Zone on the shortcut menu.

Reuse custom views If you change a view by adding columns or changing the format
and want to save it for reuse, type a new view name in the Current View box on the
Advanced toolbar, and then press ENTER.

Quickly add contact information that isn't represented by existing fields To add
custom fields, in the contact, on the All Fields tab, click New and then specify the
field's name, type, and format.

Quickly create a contact with the same company name and address as another
contact Select the existing contact in your Contacts list, and then on the Actions
menu, click New Contact from Same Company.

See details about the view you are using For details such as which fields are in place
and if the view is filtered or sorted, right-click the table header and then click
Customize Current View.

Missing some items? Adjust your view filter settings Items that don't match the
filter settings won't appear. To remove the filter, on the View menu, point to Arrange
By, point to Current View, and then click Customize Current View. Click Filter, and
then click Clear All.

Want a custom view of your information, sorted or filtered in a different way? On
the View menu, point to Arrange By, point to Current View, and then click Define
Views.

Customize the names of the voting buttons On the View menu in the message, click
Options. In the Use voting buttons box, type the names you want on the buttons,
separated by semicolons.

Save time when you change print styles If you frequently change a print style before
printing, create a custom print style instead. On the File menu, point to Page Setup,
and then click Define Print Styles.

Customize the buttons in the Navigation Pane for one-touch access To add or
remove buttons that appear in the button tray at the bottom of the Navigation Pane,
click Configure buttons, click Add or remove buttons, and then click the button you
want.

Customize the name of a duplicate .pst file to avoid confusion You can change the
name of the Outlook data file (.pst) that appears in the Navigation Pane from
Personal Folders to something more identifiable. Right-click Personal Folders, click
Properties, click Advanced, and then type a new name in the Name box.

Customize how Outlook archives items On the Tools menu, click Options, click the
Other tab, and then click AutoArchive.

Change the size of the buttons at the bottom of the Navigation Pane You can make
the large buttons in the Navigation Pane smaller by dragging the splitter bar down
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123.

124.

125.

126.

127.

128.

129.

130.

131.

toward the bottom of the Navigation Pane. The large buttons turn into small buttons
in the button tray.

Move Desktop Alerts to a different monitor If your desktop spans more than one
monitor, you can make Desktop Alerts appear on any monitor you use. When an alert
appears, rest the pointer over it and then drag it to the part of your desktop that is
displayed on the monitor where you want to view the alert.

Turn off New Mail Desktop Alerts Right-click the Outlook icon in the Microsoft
Windows notification area. To clear the check mark, click Show New Mail Desktop
Alert.

Access any Outlook folder from your Windows desktop Create a shortcut to an
Outlook folder on the Windows desktop by dragging the folder from Outlook to your
Windows desktop. Make sure you press CTRL before you release the mouse button.
When you double-click the new shortcut, Outlook will open to that folder.

Make New Mail Desktop Alerts less visible You can change the transparency level
and duration of the New Mail Desktop Alerts. On the Tools menu, click Options. On
the Preferences tab, click E-mail Options and then click Advanced E-mail Options.
Click Desktop Alert Settings. Change the duration and transparency levels to the
settings you want.

Shade group headings When you turn on shaded group headings, it makes it easier to
distinguish the different groups, such as Yesterday and Last Week. In Mail, on the
View menu, point to Arrange By, click Custom, click Other Settings, and then select
the Shade group headings check box. Click OK twice.

Display folders at the top of the mail folders view To group a set of folders at the top
of the mail folders list view in the Navigation Pane, precede each folder name with
the underscore (_) symbol.

Alphabetize the order of the mail folders in the Navigation Pane By moving the
folders that you want up to the Favorite Folders pane, you can place them in any
order that you want. To move a folder up to the Favorite Folders pane, just drag it
there.

Shrink the Favorite Folders pane Remove all the folders in the pane, making it
smaller and allowing the All Mail Folders list to move up in the Navigation Pane. To
remove a folder in the Favorite Folders pane, right-click the folder and then click
Remove from Favorite Folders.

Quickly remove a column from the view Drag the column title away from the
column heading row until an X appears, and then release the mouse button.

Keyboard Shortcut Tips

132.

133.
134.
135.
136.
137.
138.
139.
140.

To show the menu to download pictures, change automatic download settings, or add
a sender to the Safe Senders List, press CTRL+SHIFT+W.

To switch the Navigation Pane on and off, press ALT+F1.

To display the Advanced Find dialog box, press CTRL+SHIFT+F.

The fastest way to compose a new message is to press CTRL+SHIFT+M.

Need to jot a quick note? Press CTRL+SHIFT+N.

To create a new contact, press CTRL+SHIFT+C.

To go to Mail view, press CTRL+1.

To go to Calendar view, press CTRL+2.

To go to Contacts view, press CTRL+3.
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141. To go to the Tasks list, press CTRL+4.

142. To go to Notes view, press CTRL+5.

143. To reply to the current e-mail message, press CTRL+R.

144. To forward the current e-mail message, press CTRL+F.

145. To delete the current e-mail message, press CTRL+D.

146. To quickly record selected items in the Journal, press CTRL+J.

147. To quickly remove formatting from selected text, press CTRL+SPACEBAR.

148. To reply to everyone who received the selected message, press CTRL+SHIFT+R.

149. To select several adjacent items, click the first item, and then hold down SHIFT and
click the last item.

150. To select several nonadjacent items, click the first item and then hold down CTRL and
click each additional item.

151. To select all the items in a folder, click one of the items and press CTRL+A.

152. To send an open message, press ALT+S.

153. To quickly check spelling in an open item, press F7.

154. To select the next or previous item on the timeline in Journal, even if it isn't visible,
press the LEFT ARROW key or RIGHT ARROW key.

155. To quickly switch to your Inbox, press CTRL+SHIFT+I.

156. To quickly switch to your Outbox, press CTRL+SHIFT+O.

157. When viewing an open item, you can move to the next item or previous item by
pressing CTRL+SHIFT+> or CTRL+SHIFT+<.

158. To quickly switch to viewing by weeks in Calendar, click in Calendar and then press
ALT+HYPHEN.

159. To quickly mark a message as read, press CTRL+Q.

160. To quickly move between the schedule area and TaskPad view in Calendar, press
CTRL+TAB.

161. To quickly create a new item of the same type as the folder you are in, press CTRL+N.
For example, CTRL+N creates a new message in the Inbox or a new task in Tasks.

162. To quickly create a new Journal entry, press CTRL+SHIFT+J.

More Tips

163. Try the quick way to print an item Right-click the item, and then click Print on the
shortcut menu.

164. Quickly attach a file to a message, task, appointment, meeting request, journal
entry, or contact Open the item, and then on the Insert menu, click File. Locate the
file you want to attach.

165. Access your newsgroups from Outlook 2003 To access the newsreader from
Outlook, on the View menu, click Toolbars, and then click Customize. Under
Categories, click Go, and then under Commands, click News and drag it to one of your
toolbars.

166. Quickly assign tasks, contacts, or appointments to categories On the Advanced
toolbar, in the Current View list, click By Category, and then drag each item to one or
more categories.

167. Set up automatic archiving for your Outlook folders Outlook can automatically

archive old items by moving them to another file or deleting them. To set up
archiving, right-click a folder, point to Properties and then click the AutoArchive tab
for archiving options.
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168.

169.

170.

171.

172.

Not sure where your archive folder is? To see where your archive folder is stored,
right-click the Archive Folders folder in your Folder List. Click Properties for Archive
Folders. Click Advanced, and then look at the File name box.

Create a document, worksheet, or presentation If you have other Microsoft Office
programs installed, you can quickly create a new Microsoft Word document,
Microsoft Excel worksheet, or Microsoft PowerPoint presentation by pressing
CTRL+SHIFT+H.

Hide Outlook when minimized You can make the Outlook icon appear only in the
Windows notification area when you minimize Outlook. While Outlook is running,
right-click the Outlook icon in the notification area, and then click Hide when
minimized.

See where Outlook stores your Mail, Calendar, and Contacts data On the Tools
menu, click Options. Click the Mail Setup tab, and then click Data files. Folder
locations are listed in the Outlook Data files dialog box. Select a data file, and then
click Open Folder.

Check your spelling in Outlook On the Tools menu, click Options. Click Preferences,
and then on the Spelling tab, select options to allow Outlook to correct your spelling,
including creating a custom dictionary of frequently used terms and choosing a
dictionary in another language to check your spelling.
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Enhancements to Publisher 2007

Microsoft Publisher is widely considered to be the best application developed by Microsoft.
Throughout Microsoft, product managers are directed to look to Publisher for design ideas and
guidelines. For those of you who have not used Publisher before, it is an application for
producing newsletters, newspapers, and specialized documents other than a letter. It is a little
more difficult than Word, but far more powerful. Additionally, with the built-in wizards, even
novice users can begin using Publisher immediately without much effort. Presented below is a
listing of features that are new in Publisher 2007.

1. View All Available Templates With Your Customizations Applied - New professionally
selected color schemes and font schemes; or add your own; also add your logo, address,
and other contact information and see what this will look like in all of the available
templates.

2. Contextual Guidance To Common Publisher Actions - Use Publisher Tasks as a guide
and resource for creating, authoring, and distributing marketing materials.

3. Enter Information Once And Use It Anywhere - Type your contact information once and
have it automatically pre-populated whenever you create a publication using Publisher's
improved Business Information feature. Save your objects, logo, pictures, or paragraphs
for use in any other publications with the Content Library, a permanent, categorizeable
clipboard.

4. Improved E-Mail - Create professional-quality 2D marketing e-mail layout, add
personalization with Email Merge, and get better results with improved HTML
generation; also hyperlink within your email using new HTML bookmarks.

5. Change Your Layout And Let Publisher Do The Heavy Lifting -Start with an existing user-
created or template-based publication and apply a new template. Publisher will look at
your content and lay it out into the new template; including newsletter, web, and email
templates.

6. Better Mail-Merge And Catalog-Merge - Merge text and pictures from multiple lists;
sort and filter to find the right set of recipients, edit your list and save it back to the
original location, and complete by printing or sending as e-mail.

7. Save As Pdf - Export your publications in PDF for full-fidelity distribution or taking to a
commercial printer.

8. Color Sampling - Sample colors directly from images and other publication objects to
apply to lines, fills, text, and other items.

9. Design Checker Integrated With Send-As-Email And Pack-And-Go - Now, when
exporting as HTML Email or for Pack-and-Go, Publisher's design checker will look for
common mistakes and offer an opportunity to fix these so that your email will have less
bitmapping or the printing process will run more smoothly.

Page 120 Copyright 2010, All Rights Reserved



www.CarltonCollins.com Microsoft Office & Windows 7 for CPAs

10. Two-Sided Printing Wizard - Publisher will guide you on how to print two-sided even if
your printer does not include a duplexing unit.

Presented below are screen shots of Publisher 2010.
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Publisher Tips

1.

3.

Startup And Settings

4.
5.
6.

To select multiple objects one at a time, hold down
SHIFT as you click each object.

Get carried away with crazy formatting? To restore
selected text to its original formatting, press
CTRL+SPACEBAR.

To see a publication as it will print, click the Print
Preview button. Press ESC to return to draft view.
(Applies to Publisher 2003 and Publisher 2002 only.)

Publisher

(072 [T STy ea————

£

B ot e s Rt
. P ey

To display the name of a toolbar button, point to the button.

To move a toolbar button, press ALT while dragging the button.

To copy a button, press ALT+CTRL while dragging the button. (Applies to Publisher 2003
and Publisher 2002 only.)

To remove a button from a toolbar, press ALT and drag the button into the publication
window. (Applies to Publisher 2003 and Publisher 2002 only.)

To close a dialog box, press ESC.

Creating A Publication

9.

10.

11.

12.

13.

14.

15.

16.

To create a new publication using the keyboard, press CTRL+N.

To add navigation bars to a Web newsletter in Publisher, click Design Gallery Object on
the Insert menu, click Web Navigation Bars on the Objects by Category tab, and then
choose the design that you want to use in your publication. (Applies to Publisher 2003
and Publisher 2002 only.)

Update name, address, & phone automatically in any publication that you base on a pre-
designed publication by clicking Personal Information on the Edit menu.

To add just one personal information set component, such as your fax number to a
publication, on the Insert menu, point to Personal Information, and then click the
component you want to add.

To import a Word document into Publisher so that you can apply a Publisher design to
it, click Import Word Document on the File menu. (Applies to Publisher 2003 and
Publisher 2002 only.)

To insert the current date in your publication, press ALT+SHIFT+D. (Applies to Publisher
2003 and Publisher 2002 only.)

To open one of the last publications you worked on, click the file name at the bottom of
the New Publication task pane (at the bottom of the File menu in Publisher 2000).

To select verse to add to a greeting card, click Select a suggested verse at the bottom of
the Greeting Card Options task pane, and then pick the verse options that you want.
(Applies to Publisher 2003 and Publisher 2002 only.)

Page Layout

17.
18.

To add a page after the current page using the keyboard, press CTRL+SHIFT+N.

To add a page to your open publication, go to the page that will either come before or
after the pages you want to add, click Page on the Insert menu, select the options you
want, and then click OK.
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19.

20.

21.

22.

23.

24.

25.

26.

To move a page, click the page on the page sorter and drag it to a new location on the
page sorter. (Applies to Publisher 2003 only.)

To duplicate a page, hold down the CTRL key while clicking the page you want to copy
on the page sorter and dragging it to a new location on the page sorter. (Applies to
Publisher 2003 only.)

To repeat specific design and layout elements on every page of your publication, such as
a watermark, add these design and layout elements to the master page by clicking
Master Page on the View menu. (Applies to Publisher 2003 and Publisher 2002 only.)

To move rulers around, press SHIFT and use the mouse to drag them. (Applies to
Publisher 2003 only.)

To switch between viewing one page at a time, and viewing a two-page spread, click
Two-Page Spread on the View menu.

To quickly launch the Measurement toolbar, double-click anywhere in the status bar at
the bottom of the page except on a page icon.

To create a grid to help you position text and graphics evenly on the pages of your
publication, click Layout Guides on the Arrange menu.

To hide or show layout guides, ruler guides, and object boundaries, press
CTRL+SHIFT+0O.

Working With And Customizing The Workspace

27.

28.
29.

30.

31.

32.

33.

34.

35.

36.

To use a button on the Objects toolbar multiple times, double-click the button. (Applies
to Publisher 2003 and Publisher 2002 only.)

To zoom in on text that you are typing or any selected object, press the F9 key.

To fit a publication to the width of your screen, click the Zoom box on the Standard
toolbar, and then click Page Width.

To display paragraph marks, tab characters, spaces, and table cell markers, click the
Special Characters (Show Special Characters in Publisher 2000) button on the Standard
toolbar.

Move the entire page within the workspace using a 5-button mouse - hold down the
Forward mouse button as you drag the Hand pointer. (Applies to Pub 2003 only.)

Zoom in on a specific part of a page using a 5-button mouse, click and drag with the
Back mouse button on the area you want to zoom in on. (Applies to Pub 2003 only.)

To fill the workspace with the entire page using a 5-button mouse, click once on the
Back mouse button. (Applies to Publisher 2003 only.)

To undo the change you applied to a publication (for most changes), click the Undo
button on the Standard toolbar.

To undo or redo several changes at the same time, click the arrow next to the Undo
button or Redo button. (Applies to Publisher 2003 and Publisher 2002 only.)

To display a shortcut menu, click the right mouse button.

Working With Graphics And Objects

37.

38.

To measure an object, click the object you want to measure, and then look in the lower-
right corner of the status bar at the bottom of the screen.

To copy all attributes of an object to several objects, double-click the Format Painter
button, and then select several objects in succession. Click Format Painter again when
you're done.
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Moving And Grouping Graphics

39
40
41

42.

43.

44.

45.

46.

47.

48.

. To select multiple objects one at a time, hold down SHIFT as you click each object.

. To select all of the objects on a page, click Select All on the Edit menu.

. To rotate an object freely in 15-degree increments, select the object you want to rotate,
hold down SHIFT, point to the green rotation handle, and drag the mouse in the
direction you want the object to rotate. (Applies to Publisher 2003 and Publisher 2002
only.)

To rotate an object freely in 15-degree increments, hold down both CTRL and ALT as you
drag the object with the Rotator. (Applies to Publisher 2000 only.)

To align objects down the center of a page, select the objects you want to align, point to
Align or Distribute on the Arrange menu, and then click Relative to Margin Guides,
then point to Align or Distribute on the Arrange menu, and then click Align Center.
(Applies to Publisher 2003 and Publisher 2002 only.)

To align objects down the center of a page, select the objects, click Align Objects on the
Arrange menu, click Centers under Left to right and Top to bottom, and select the Align
along margins check box. (Applies to Publisher 2000 only.)

To keep the center of an object in the same place when resizing the object in your
publication, click the object, then hold down CTRL while you resize the object. Release
the mouse button before you release CTRL.

To resize an object while maintaining its original proportions, click the object and then
hold down SHIFT while you resize the object from one of the corners. Release the
mouse button before you release SHIFT.

To move an object forward or backward within a stack of objects, point to Order on the
Arrange menu, and then click the option that you want. (Applies to Publisher 2003 and
Publisher 2002 only.)

To move an object forward or backward within a stack of objects in Publisher 2000, click
the Bring or Send command you want on the Arrange menu.

Creating graphics

49

50.

51.

52.

53.

54.

. To quickly create a mock-up using an empty picture frame as a placeholder for a
graphic, click the Picture Frame button on the Objects toolbar, click Empty Picture
Frame, and then drag the mouse on your publication until you have the size you want.
(Applies to Publisher 2003 only.)

To replace a placeholder graphic in a pre-designed publication, right-click the graphic
(you might have to click it twice if it's part of a group), point to Change Picture, and then
click the option that you want. (Applies to Publisher 2003 and Publisher 2002 only.)

To create a perfect circle, hold down SHIFT while dragging a shape on your publication
using the Oval tool from the Objects toolbar.

To save a group of objects as a picture, right-click the frame of the group you want, and
then click Save As Picture. (Applies to Publisher 2003 and Publisher 2002 only.)

To add a Publisher-designed object from the Design Gallery to your publication, click
Design Gallery Object on the Objects toolbar.

To add slanted, arched, or stretched words to your publication, point to Picture on the
Insert menu, and then click Word Art. (Applies to Publisher 2003 and Publisher 2002
only.)
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55.

To add slanted, arched, or stretched words to your publication in Publisher 2000, click
Object on the Insert menu, click the Create New option, and then click Microsoft
WordArt.

Working with text, Fonts

56.

57.

58.

59.

60.

61.

62.

For a quick way to make your publication look professional with fonts that look good
together, select a font scheme by clicking Font Schemes on the Format menu, and then
clicking a font scheme in the Font Schemes task pane. (Applies to Publisher 2003 and
Publisher 2002).

To select a different font using the keyboard, press CTRL+SHIFT+F and then enter or
select the font you want (in the Font list on the Formatting toolbar.)

To quickly change the fonts in a pre-designed publication, click Font Schemes on the
Format menu, and then click the font scheme you want in the Font Schemes task pane.
(Applies to Publisher 2003 and Publisher 2002 only.)

To select a different font size using the keyboard, press CTRL+SHIFT+P and then enter or
select the size you want (in the Font Size list on the Formatting toobar.)

To use the keyboard to increase or decrease the size of selected text by 1 point, select
the text you want to change, and then press CTRL+] or CTRL+].

To use the keyboard to increase or decrease your font size to the next smaller size in the
Font Size box, highlight the text you want to change, and then press CTRL+SHIFT+> or
CTRL+SHIFT+<.

To use the keyboard to increase or decrease space between letters in a word (kerning),
select the text you want to change, and then press CTRL+SHIFT+} or CTRL+SHIFT+{.

Formatting

63.

64.

65.

66.

67.

68.

To remove all text formatting, select the text you want, click Styles and Formatting on
the Format menu, and then click Clear Formatting in the Styles and Formatting task
pane. (Applies to Publisher 2003 and Publisher 2002.)

To restore selected text to its original formatting, press CTRL+SPACEBAR.

To copy formatting from one object or paragraph to another, select the item with the
format you want to copy, click the Format Painter button on the Standard toolbar, and
then click the object or paragraph you want to format.

To change the color of text, click the arrow next to the Font Color button (click the Font
Color button in Publisher 2000) on the Formatting toolbar, and click the color you want.
To apply or remove bold, italic, or underline formats on selected text, press CTRL+B,
CTRL+I, or CTRL+U.

To create a numbered or bulleted list, click the Numbering or Bullets button on the
Formatting toolbar.

Editing

69.

70.

71.

To insert a manual line break, click where you want to break a line of text, and then
press SHIFT+ENTER.

To insert an indented line of text under an item in a bulleted or numbered list without
having a bullet or number appear , press SHIFT+ENTER at the end of the preceding line,
and then type the text.

To quickly replace text, select it and type.
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72.

73.

74.

75.
76.

77.

To create and format a table, point to Insert on the Table menu, click Table, and then
click an option in the Table format list. (Applies to Publisher 2003 and Publisher 2002
only.)

To go to the beginning or end of a line, press HOME or END.

To create superscript or subscript text, select the text and press CTRL+PLUS SIGN or
CTRL+EQUAL SIGN.

To move selected text between windows, drag it to another window.

To copy selected text between windows, press CTRL while you drag it to another
window.

To select all of the text in a story, press CTRL+A.

Printing

78.

79.

80.

81.

To quickly find a commercial printer prepared to handle Publisher files, click Microsoft
Office Online on the Help menu, click Publisher on the Office Online home page, and
then click Find a local printer on the Publisher home page.

To ensure that you don't leave any essential files behind when you deliver a publication
to a commercial printer or move it to a new computer, point to Pack and Go on the File
menu, and then click the option you want.

To see a publication as it will print, click the Print Preview button. Press ESC to return to
draft view. (Applies to Publisher 2003 and Publisher 2002 only.)

To print specific pages of a publication on your desktop printer, click Print on the File
menu. Under Print range, click Pages, and then type the page numbers of the first page
and last page of the range you want to print in the From and To boxes.
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Enhancements to Access 2007

One of the most basic tasks in Access is creating somewhere to put data - designing
schema. Access 2010 can create schema by example, where the user simply starts typing into a
grid (the "datasheet") and Access guesses the data types automatically. This is ideal for
beginning users, and Access 2010 automatically creates an ID column for each table, so there's a
unique index for the table, and the user has something to build joins on as she gets more

sophisticated. The basic schema by datasheet experience looks like this:

7 Tablet

#*

Issue = Assigned to =

Due Date

-

Status

- My Field|

To perform this operation, the user simply starts typing in the header row to set column names,
then types data in the rows below to fill-in the table. Access guesses the data types as the user

does this.

™ =
Table Templates — While simple tables are rather easy to create, one of Z
the key problems that new users have in Access is creating well-
The tracking apps will
normalized schemas for the most common applications, but many users
will need to build their own databases without starting from the
tracking apps. In this case, Table Templates provide a way for users to
get well-structured single tables that they can easily add to their own
applications. To accomplish this, Access 2010 provides a simple entry

structured databases.

point on the ribbon as shown to the right:

The entry provides a list of five (5) basic common table types that the user can simply drop into
her application and extend or use as is. An example would be the Issues table, which looks like

this:

ij Tablel ‘ 2E2 Tahie.z\"-\._.

help by creating

Templates ™ List

LContacts

=

CEEEE

Tasks

Issues

Events

BE| | Assets

L]
Table SharePoint

5T
!

| —

-

| Title » Assigned To - Opened By - Opened Date .| Status
2 14-Mar-06 Active

| # 14-Mar-06| Active
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The full list of fields is easier to see in the table designer:

] Tablet..| 7 Issues |
Field Name Data Type
P AutoMumber
| Title Text
Assigned To Mumber
Opened By Mumber
' Opened Date Date/Time
Status Text
Category Text
| Priority Text
Comment Memo
'Due Date Date/Time
Related Issue Mumber

SharePoint List Templates - Access 2010 also provides a set of templates for SharePoint lists
similar to that for local tables. This list is available from a button in the ribbon right next to the
Table Templates:

Data Insert Page Layout Externa
= = = I ]
| 8 |= '::-:-: | T
| | = e | e
L) == e == s 1
Table {SharePoint || Simple Split  Mul
emplates ™ Lists ™ Form™ Form Itg
ables and L - Ie
3 Contacts -
s =
= | Task
) Lad] Tk
les: Table _| Tosties
- I:II Events
111 Custom
FH
T Existing SharePoint List
[ Setno
|

It has a similar list of tables, with the exception of Custom (which creates a simple SharePoint
list that you can then extend) and it also provides an alternate way to link to an existing
SharePoint list. Selecting one of these lists brings up a prompt for the appropriate server and a
name for the list:
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Create New List

Issues

Create an issues list when you want to manage a set of issues or problems, You can assign, prioritize, and follow the progress of issues from
start to finish,

Spedfy a SharePoint site:

Site Address )
httP: ffaccesf12/access 12/
bt

Spedfy the name of the new SharePoint list:
‘My Issues| ‘

Description:

Open the list when finished

[ OK ] [ Cancel l

The schemas for these lists are similar to those for the local tables, the only difference being
that the SharePoint lists are created on the server and linked to Access.

Field Templates - Users who want to create their own tables can still get help building well-
structured fields (i.e. with appropriate data types and lengths) from the Field Templates. Here
the user selects the field templates button on the ribbon and gets a list of potential fields. This
list contains a set of generic fields, and then all the individual fields from the Table Templates
above. Click the image below to see the list of available fields for Issues.

Lookup Add Existing
Field | Column Fields

Fields and Columns

The user then simply drags and drops the appropriate field into their table.
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| Field Templates b4
Select one or more fields to insert
into your table
[ Basic Fields
[+ Assets
[+ Contacts
+| Events
| Issues
D
Title
Assigned To
Opened By
Opened Date
Status
Category
Priority
Drescription
Due Date
Related Issue
Comments
[+ Tasks

Lookup Fields and Complex Data - Access has supported "Lookup Fields" for several versions
and has added power to the feature for Access 2010 by allowing for multi-valued
lookups. Lookup fields are simply fields that present a different value in their control than they
store in the table. In the Issues example we've been using, "Assigned to" and "Opened by" are
both lookups. The Issues table stores the ID of the entry in the Contacts table, but whenever
the user sees the Issues table, they see the Contact Name rather than the number. This is
simply good database practice (normalized data, joined on unique identifiers), but made easy
enough for non-developers.

Access 2010 extends the lookup concept by enabling multi-valued lookups. Where a lookup is
really just a join made easy, a multi-valued lookup is simply a many-to-many join made easy. In
XML terms this would be represented as an optional repeating value, which is why we think of
this internally as support for complex data. SharePoint uses these data structures in a number
of places (e.g. support for multiple attachments for each item in a list), so Access needed to add
similar support to provide schema symmetry, but the concept is broadly useful outside the
context of SharePoint. In our Issues example, the user may want to assign an issue to more than
one person. This was do-able before, but required a lot of work (building the join table, setting
up the relationships) and a lot of knowledge (i.e. how to build the join table, etc.). The Lookup
Wizard now does all this for the user.

The user simply starts by clicking the Lookup Column button on the ribbon (with a column
selected in the datasheet):
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-2 | =p
e= i cRnEE |
Mew |Lookup |Add Existing
Field Column Fields

Fields and Columns

Then the user goes through the wizard as they did before:

Lookup Wizard

This wizard creates a lookup column, which displays a list of values
you can choose from. How do you want your lookup column to get

j i 7
[r— = its values?

HERHRRHH RS
L (#)il want the lookup column to look up the values in a table or

iquery.

() I will type in the values that I want.

Lookup Wizard

Which table or query should provide the values for your lookup
column?

| Table: Issues

I HEHHRE 'I

View

(%) Tables () Queries (") Bath

[ Cancel l [ < Back. l Mext = ]

On the last pane of the wizard, select "Allow Multiple Values" and hits finish. This automatically
builds (and hides) the join table and sets up the relationships, so the experience is just the same

as for a standard lookup.
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Lookup Wizard
What label would you like for your lookup column?
|Assigned to il

Do you want to store multiple values for this lookup?

[w]:llow Multiple Values

Those are all the answers the wizard needs to create your lookup
column,

[] Cisplay Help on customizing the lookup column.

e

The key difference, though, is that the user can now select multiple people in the Assigned to
column:

lssuies "!{j Contacts ":\:_
- Assignedto -| DueDate -
b
[ chris Horner
[/ Erik Rucker
[/ Fred Jones
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Microsoft Office
PowerPoint 2007

Creating Professional Presentations
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Introduction

Communication is frequently identified as the primary key to the success of any
business. All businesses must continually communicate with employees, customers,
shareholders, prospects, vendors, etc. Given this premise, one should naturally ask
“what tools exist to help our organization communicate better?” The answer is
Microsoft PowerPoint. PowerPoint is designed to help you convey information, and it
does so in a surprisingly wide variety of ways. This article will broaden your perception
of PowerPoint and inform you about some of the simple but powerful features that can
help you use this product more efficiently.

The “Projection System Required” Myth

Many people are under the wrong impression that you must use a computer and
projection system to deliver a PowerPoint presentation- this is not the case. While
PowerPoint is ideally suited for a computer projection system, there are many ways in
which you can deliver a PowerPoint slide show without the use of a projection system,
as follows:

Printed Pages — PowerPoint slide shows can be printed to paper with
your choice of 1, 2, 4, 6 or 9 slides per page. If desired, you can suppress
the slide show background to make the slides more readable, especially
when printed on a black and white printer. Assuming duplex printing (2-
sided page printing), you could print a 36-page PowerPoint slide show on
just 2 pieces of paper (using 9 slides per page). This would allow you to
provide handouts to all meeting participants, hence they will not have to
frantically take notes to capture the content of your slide show.

Print what: Handouts
|Han|:||:|uts ﬂ Slides per page: |6 %
Colorfgrayscale: Order: % Harigg vertical | [3][&)
|Gra';.-'5u:a|e -

[ Scale o fik paps [

v Frame slides

Printing 9 slides per page

Transparencies - PowerPoint slide shows can be printed to transparencies, which
can then be used on an overhead projector. Of course transparencies can be
printed in black and white or color. This approach allows you to use a simple
overhead projector to deliver your presentation, a low tech approach that may
offer less risk compared to using a laptop and computer projection system. Such
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a solution might be preferable for travelers who prefer to leave their laptop
computers at the home or for use as a backup delivery method.

Publish As a Web Page — PowerPoint slide shows can be published to the web
instantly using the built-in web publishing wizard. This option allows you to make
your PowerPoint slide show instantly available to your meeting group, as well as
the rest of the world. A key benefit of this approach is that your complete slide
show, including animations and sound will automatically work on the published
web site.

Publish as Web Page

Publish what?

+ Complete presentation

" slide number || 2 through 3:
e | =l
W Display speaker notes Web Options. ..

Browser support

{* Microsoft Internet Explarer 4.0 or laker (high Fidelity)
" Microsoft Internet Explorer 3.0, Metscape Mavigator 3.0, o later

" gl browsers listed abowve (creates larger files)

Publish a copy as

Page title:  PowetPaint Pressntation Change...

File: name: |C:'|,Documents and SettingsCarlkan Collins| My Documents Browse. ..

El [™ open published Web page in browser Publish | Cancel |

Packaged for CD - The Packaged for CD wizard will package your PowerPoint
presentation to run on another computer, including linked files, animations,
TrueType fonts, etc. You can also choose to include the Microsoft PowerPoint
Viewer which will allow the Packaged for CD file to run on a computer that
doesn't have Microsoft PowerPoint installed.

Package for CD E|

;"'; Copy presentations bo & CO that will play on computers
H:‘[a:; running Microsoft YWindows 95 Second Edition or later, even
without PowerPoint.

Mame the CD: | SlEEEg ey o]

Files to be copied:

Presentationl.ppk Add Files. ..
Linked files and the PowerPoint Viewer are -
included by default, To change this, click Options, Lol
Copy to Eolder. .. Copy ko CD l [ Close ]
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E-Mail — Of course we should not overlook the fact that PowerPoint slide shows
can be e-mailed directly to a recipient, or group of recipients. PowerPoint
provides this capability from the File menu as shown below.

| Send To » ||@ Mail Recipient (For Review)...
Propetties =] Mail Recipient {as Attachment)...
1 hkkpe [y, accountingsoftwaready . Routing Recipient. ..
2. \ACCPAC Partnership 2003 Gre,.. “] Exchange Folder...

Advancing Slides Tip

When delivering a PowerPoint presentation, you already know the left mouse button
will advance the slide show with each left mouse click. However, as a default, the right
mouse button pops up a menu, rather than displaying the previous slide. This can result
in an awkward moment in the presentation when the presenter truly wants to slip back
to the previous slide. Instead of fumbling with this dialog box, | find it is better to set the
presentation to display the previous screen on right mouse click. To do this, in the Tools
menu, select Options, select the View tab, and clear the Popup menu on right mouse

click box as shown below.

Options

Security
zeneral |

Show
|v Starbygp Task Pane

W Status bar
[v Wertical ruler
[v ‘Windows in Taskbar

Slide show
[ Popup menu on right mouse click

W Show popup menu butkon
[v End with black slide

Default view
Open all documents wsing this wiew

[v Slide Layout task pane when inserting new slides

)]

|  Spelingandstyle |
Edit | Print |

|The: wigw saved in the file

=l

[ ox |

Cancel
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Controlling the Master Slide

PowerPoint provides a slide master page which allows you to set up the background,
fonts, and formats to be used for every page throughout your slide show. Setting up the
slide master page first makes it easier to then position your text and objects in an
attractive manner as you create your presentation. The slide master page is accessed
under the View menu. In the sample screen below, you can see | have inserted a
washed-out image of myself as part of the background—this image will now appear on
all slides.

[ Micresoli PownePoind - [Foessnalinl | f-_'ri Tl
] Ble [t | Wew | reet  Fomak  Jook  Side Show  Window Heb  Acchat pack gov S
) & @ | 4B tomd I s -t n W A A e sk Master "
T | Shie Sovber i
: B de Shewr N
1 B notes Page |
mee vl Master title style
Tt Aoy For Aol ayouts
T ik, Pawren Pty Maker
Tookbars + Click to edit Master text styles
Loar - Second level
el e Gusedes. .,
e * Third levea
e - Fourth level
| Header aned Footes.... « Fifth leval
e Maater View -
- e 0y Chese Master Vigw
Ohject Ares for Aol syouks
. [ s
Cunle ferey Foohm fas Humber Area
=T
Do (B apostapes~ . W OCH A EHE d-L-A-E=ER .
e Master Dotk Dz Englsh {LL5.) [*%}

TEDEGSe 2 x TDs = =3 = Bu. [8n "8z 507 xazm

Custom Animations

By selecting the Slide Show menu and clicking on Custom Animation, you can create
motion paths that cause text and pictures to move across the screen. However, a rather
professional effect can be achieved by using a motion path on an object larger than your
slide, such as a photograph. In the example presented in Figure 1.3, | have inserted a
picture of clouds which is larger than the slide, and applied an animation in which this
image crawls slowly across the screen. When displayed, the text remains stationary as
the background image seems to slowly float by. This illusion makes this slide play more
like a movie and results in an interesting affect.
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Recording Narration

Microsafl Prsarfoint - [Presentationt ] |
B B [ Wew jreet Fomet Took S Shom  Wiedow Heb  Acubet peack g - %
Nl & =@ S Y e T B [EEE AL D i
..
E BI-RE. @ ¢ Costom Amimation T+ X
52 ' "
Cariten's Budget for 2004
1 L
H, .................................. ...1
] +
| | * ﬂw| ' e Show
Bmvy : Chek 10 584 notes L ——
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Once you have completed your PowerPoint presentation, you can run the slide show on
your computer and use a microphone to record your comments, advancing the slides as
you speak. The resulting product is a self-running slide show, complete with your voice
embedded in the presentation. This file can then be sent to others who can view the
slide show and hear your voice walk them through the various slides. To use this
feature, in the Slide Show menu, click Record Narration. As you speak, your voice is
saved as a sound clip which is associated with each slide—you can re-record any

individual slide's narration as needed.

Record Marration

Current recording quality

Quality: [unkitled]

Disk use: 10 kb/second
Free disk space: 41941 MB {on C:)
Max record time: 56483 minutes

Tip

™ Link narrations in:  C:l...\Carlton CollnsiMy Documents!,

performance.

ok |

Cancel

|
Set Microphone Level, .. |
Change Quality. .. |

Adjust quality settings to achieve desired sound quality and disk usage, Higher
recording quality uses more disk space. Large narrations should be inked For better

Erowse. ..
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Custom Shows

You can create different versions of your PowerPoint presentation, and save them as
"custom shows." For example, the screen below shows how | pared down my primary
PowerPoint presentation, which runs 90 minutes in length, to create a custom 10-
minute version of this presentation using only five slides. With this approach, | can
maintain multiple versions of my presentation, but | need only update a given slide once
to have those updates automatically reflected in all of my custom shows. In the Slide
Show menu, click Custom Shows to take advantage of this option.

Define Customn Show @E]

Skde show pame: |Car|t-:|n's white House Lecture |

Shides in presentation: Slides in cusbom show:
12, Indrect (MRC 1. Supports Inkernal |
13. Supports Inke 2, Multiple “Ship To &
14, Multiple “Ship 3. Purchase Order Ch
15. Purchase Ord Add >> 4, Automatic Inker-Co

16, Post ko GfL Pr
17, Automatic Int
19, 1099 Backup
20, Supporks OFfs ¥

5. Distributes Freight

i

[ ok | conel |

Conclusion

PowerPoint can help you develop, organize and present information. | find that
developing materials in PowerPoint can be five times faster than developing materials in
my word processor. Why? Because PowerPoint invites you to develop your material
using bullets, lists, charts, and pictures whereas your word processor begs for complete
paragraphs including introductory and conclusion sentences. With a word processor you
end up writing more, reviewing more, and then summarizing more in order to deliver
your presentation.

PowerPoint also helps you organize your presentation. Once the data is assembled, you
can reorganize slides by simply clicking and dragging them to a new position. You can
even lasso multiple slides and move them with one drag of the mouse. This type of
organization is much more difficult to accomplish in a word processing environment.

PowerPoint also helps you deliver a presentation because the slides act as your lecture
notes. These notes keep you on course. Audience participants whose minds naturally
drift away can use the slides to catch up to you in your presentation. Presenters who
have a natural fear of speaking in public are comforted somewhat because PowerPoint
draws the audience’s eyes more toward the screen, and away from the presenter. In
this manner, the reluctant presenter does not feel quite as nervous. PowerPoint is also a
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great platform for presenting pictures and charts which plays into the old adage that a
picture is worth a thousand words.

Of course, death by PowerPoint is an all-too-frequent occurrence at many conferences,
and presenters should be mindful to avoid boring their audience to tears with dozens of
slides. Presenters should also avoid building slides which contain complete sentences
because this often results in the presenter simply “reading” the slides to the audience —
a situation which always comes across negatively. As a general rule, use one PowerPoint
slide for every five minutes of lecture.

In conclusion, PowerPoint is a great tool which helps you deliver information. As we
have learned, PowerPoint is not only good for live presentations, but it also is useful for
developing and delivering presentations through e-mail, the web and even the printed

page.
PowerPoint Tips

1. When you're running an automatic slide show, to stop or restart it, press S or PLUS
SIGN.

2. To increase the default size for sounds you can embed (and therefore not have to link
to), on the Tools menu, click Tools, and then, on the General tab, increase the Link
sounds with file size greater than __ Kb setting to a size just larger than your largest
sound file, up to 50,000 KB (50 MB). Click OK. This one has come in might handy more
times than | can remember.

3. Go to the first or next hyperlink on a slide by pressing TAB.

Navigating
4. Stop or restart an automatic slide show by pressing S or PLUS SIGN.
5. End aslide show by pressing ESC, CTRL+BREAK, or HYPHEN.
6. Go to slide number by pressing number+ENTER.
7. Go to the next hidden slide by pressing H.
8. Return to the first slide by pressing 1+ENTER (or press both mouse buttons for 2
seconds).
Pausing
9. Display a black screen, or return to the slide show from a black screen by pressing B or
PERIOD.
10. Display a white screen, or return to the slide show from a white screen by pressing W or
COMMA.
Rehearsing

11. Set new timings while rehearsing by pressing T.
12. Use original timings while rehearsing by pressing O.
13. Use mouse-click to advance while rehearsing by pressing M.
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Annotating

14. Erase on-screen annotations by pressing E.
15. Show or hide ink markup by pressing CTRL+M.

Working With The Pointer During A Slide Show

16. Show or hide the arrow pointer and Slide show toolbar by pressing A or =.

17. Hide the pointer and Slide show toolbar immediately by pressing CTRL+H.

18. Hide the pointer and Slide show toolbar in 15 seconds by pressing CTRL+U.

19. Redisplay hidden pointer and/or change the pointer to a pen by pressing CTRL+P.

20. Redisplay hidden pointer and/or change the pointer to an arrow by pressing CTRL+A.

Working With Animations
21. Perform the next animation or advance to the next slide by pressing N, ENTER, PAGE
DOWN, RIGHT ARROW, DOWN ARROW, or the SPACEBAR (or click the mouse).
22. Perform the previous animation or return to the previous slide by pressing P, PAGE UP,
LEFT ARROW, UP ARROW, or BACKSPACE.

Working With Hyperlinks

23. Go to the first or next hyperlink on a slide by pressing TAB.

24. Go to the last or previous hyperlink on a slide by pressing SHIFT+TAB.

25. Perform the "mouse click" behavior of the selected hyperlink by pressing ENTER while a
hyperlink is selected.

26. Perform the "mouse over" behavior of the selected hyperlink by pressing SHIFT+ENTER
while a hyperlink is selected.

Displaying Additional Tools
27. View the Windows task bar by pressing CTRL+T.
28. Display the All Slides dialog box by pressing CTRL+S.
29. Display the shortcut menu by pressing SHIFT+F10 (or right-click).
30. See a list of keyboard shortcuts by pressing F1.

Working With Autoshapes In Normal View

31. Copy the formatting style of the currently selected shape by pressing CTRL+SHIFT+C.

32. Paste the formatting style of the currently selected shape by pressing CTRL+SHIFT+V.

33. Paste only text formatting by selecting only the text in the text box, and then pressing
CTRL+SHIFT+V.

34. Use the More AutoShapes command (click the AutoShapes button on the Drawing
toolbar) to display the Clip Art task pane, where you can search for and insert clip art.

35. Quickly convert one AutoShape to another without losing formatting changes by
selecting the shape you want to change, clicking the Draw button (on the Drawing
toolbar), pointing to Change AutoShape, and then clicking the new AutoShape.
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Microsoft Live Meeting

O (e Mieeting

Surveys show that most business professionals consider some meetings to be
important, most meetings are simply a large waste of time, particularly when extensive
travel is involved. In today’s world technology has changed the face of meetings from
long and expensive ordeals that eat cash and rob companies of productivity, into quick
and inexpensive tasks that make meetings almost as simple as a phone call. Using the
internet and your computer, you can now meet with one to one thousand people from
the comfort of your own desk. The software that makes this work is Microsoft Live
Meeting, and it promises to be the next great technology break through that will change
the way business does business. The live meeting screen is shown below.
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Not only does Live Meeting allow you to hold meetings without incurring heavy travel
and travel expenses, but it is changing the core structure of the businesses operate. For
example, not too long ago, it was common for companies to hire employees that lived
locally and provide them with office space in a centralized building. This meant that
either the pool for hiring talent was limited to the immediate area or that large costs
would be incurred to relocate employees and their families. Today, things are different.
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It is now practical for companies to hire employees who live thousands of miles away,
and work closely with those employees using technologies such as e-mail, remote
access, and Live Meeting to make them an integral part of the organization. This means
that companies can now hire from around the world in order to find the best talent at
the lowest salaries. Outsourcing is one example of an industry that has risen in recent
years based largely on these new technologies. While the media tends to discuss
outsourcing in the context of losing American jobs, it is true that many foreign countries
have outsourced jobs to the United States.

The continued march of technology advancement has left millions of companies and
many industries in the dust. For example, Wal-Mart used superior supply chain
technology to bury the competition and force K-Mart, JC Penny’s and federated
Department stores into bankruptcy. Internet based meetings are having a similar impact
as those companies that conduct numerous small and inexpensive meetings daily are
leaner and meaner than those older traditional companies that rely on expensive travel
intensive, long lasting meetings that occur only periodically. Some of the highlights of
Live Meeting are as follows:

1. Meet with colleagues, customers, and suppliers, no matter where you are.

2. Meet with just one person, or as many as two thousand people at the same
time.

3. You can edit files together such as a Word document or excel worksheet.

4. You can collaborate on a whiteboard, drawing a diagram or laying out a critical
path chart — and the whiteboard image can be captured, saved, and shared with
others.

5. The entire Live Meeting event can be recorded and archived or shred with
others. Record your presentation as easily as clicking the mouse, without any
special equipment required. It is easy for people who missed the meeting (or
class) to view recordings on-demand using Microsoft Windows Media Player or
by downloading the recording for viewing at their convenience. You can leverage
your presentation many times with full-quality recordings.

6. Secure Sockets Layer encryption means that your meetings are absolutely secure
from prying eyes.

7. Live meeting is integrated with Outlook to make scheduling as simple as sending
an e-mail.

8. Live Meeting leverage the full capabilities of Microsoft Office PowerPoint
presentations with high-resolution support for all types of animations and slide
transitions, and enable participants to better engage by switching in or out of
full-screen view as they choose.

9. Live Meeting allows participants to share any printable document on-the-fly for
online review or editing. With the high-resolution viewer, participants can zoom
in or zoom out without losing the quality of text and graphics.

10. Live Meeting allows participants to share control of software on your desktop
without losing sight of participant feedback or text questions.
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11. Meeting participants can request control, and presenters can quickly grant
control to any participant. This is useful for demonstrating a complex system
such as Great Plains Software to a potential purchaser.

12. Live Meeting a Question Manager that enables any of the presenters to view and
respond to questions by replying to individuals or to all participants.

13. Live Meetings interactive tools include: Real-Time Polls, Mood Indicator, Chat,
Annotations, Whiteboard, Text Slide, and Web Slide.

14. Internet Audio Broadcast enables presenters to stream audio over the Internet
so participants only need the speakers on their PC to participate.

15. Live Meeting incorporates the Microsoft Office look and feel which means that
this tool is very intuitive for Microsoft Office users.

The presenter can even run a camera so that participants can see the presenter,
including facial expressions, hand gestures, or even visual aides as shown below.

> QuickCapture

QuickCapture B|E'[g|

-

-
B40x 450w Syw

f40x 480 Sy
= Take a Picture

‘ 4@ Record a Yideo ‘ @ Fecord aVideo
¥

[ Close } [ Close ]

Options ¥ Options ¥

‘ 2] Take a Picture

3 4

»

Top 10 Benefits of Live Meeting

According to Microsoft, Live Meeting can help you participate in meetings around the
world, at a moment's notice, and at a fraction of the cost. On the Live Meeting web site,
Microsoft lists the following top 10 benefits of Live Meeting.

1. Travel Less - Save time and money by meeting online and avoid all the hassles of
business travel.

2. Increase Productivity - Spend your time wisely and avoid downtime associated with
getting to and from your meetings. You can meet more frequently with customers,
colleagues, and business partners, thereby increasing your business output in the same
amount of time.
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3. Reduce Costs - By conducting online meetings, online training, and online events, Live
Meeting helps you save money compared to the cost of conducting business face-to-
face.

4. Easily Collaborate - All you need is a computer with an Internet connection to
conduct your online meetings. Live Meeting works directly with your other business
productivity applications, such as Microsoft Office and Windows Messenger.

5. Use One Service For All Your Online Meetings — Live Meeting supports all types of
online meetings, from small collaborative team meetings, to training, and even events
with thousands of participants.

6. Deliver Effective Online Presentations - With Live Meeting, you can deliver remote
presentations with the same effectiveness as being in person. With full support of
Microsoft Office PowerPoint animations and transitions, and the ability to receive real-
time feedback from your audience, you can successfully get your point across without
having to be in the same room.

7. Extend Your Customer Base—Without Geographical Limits - Widen your potential
client and customer base. Easily access people—no matter where they are. Reach more
people, in less time.

8. Collaborate In Real Time - Share, collaborate, and discuss your projects in real time.
Windows of opportunity are short, and you can’t afford to wait for everyone to be in the
same place, at the same time. Make critical decisions quickly, with all the stakeholders,
regardless of geography.

9. Get Easy Administration And Deployment - Whether you are a company with 5
employees or 50,000 you can easily enable everyone in your organization to conduct
effective online meetings. With a variety of administration tools, you can comply with
corporate policies and easily manage users of the Live Meeting service.

10. Instant Meetings - Live Meeting enables you to conduct your online meetings,
training, and events at a moment's notice, anytime, anywhere.
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SharePoint Designer 2010

When groups of people need to share files or information, the Internet provides the
best platform of all for achieving this goal. This is often true even when only tow people
are involved and when they are seat close together in the same building, but it is
especially true when large numbers of people are involved and they are located in
different locations. To accomplish this task, you could secure a domain name and create
a web site from scratch, but this is not the best approach because you will need to build
the web site pages, hyperlinks and implement security to prevent others from accessing
your information. There is a better way.

SharePoint provides a ready to use, Internet based project management platform.
Simply add the participants who are authorized to access the site, list the tasks, and you
are off and running. SharePoint then allows all participants to post their shared files to
the SharePoint site, and others can check out those files like checking out a book from
the library. This enables you to share files, but prevents users from working on the same
file at the same time. The SharePoint system also enables users to keep track of their
progress, indicate tasks that have been completed, post notes, and in general maintain
all relevant information about a job or project in a centralized location for all authorized
person to see. An example of this system is shown below.

File Edit “ew Favorites Tools  Help ﬂ'
G Back v () |£| |§| ;\J /..7 ) Search :1\7‘ Favorites {‘7 o = - El ‘i‘
Google = |micrasoft live mesting v | bsearchweh - gD TageRank Fd options & &) microsoft [ lve  [&) meeting
Links g‘] 1 Google @1 Home - SEA Team Web Site @ Administration g‘] One-Liners @'] AdvisorCPE @1 ASH @LI boortz @LI carlton @'] Consulting @ Control Center Sign In ki
.'15’? Home Documents and Lists Create Site Settings Help
SBA Teamn Web Site P
@ Tasks
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SMew Itern | EFilter | ZAEdit in Datashest
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Chapter 13 -- Month End and vear End Procedures Mot Started (23 Normal 342342005 12:00 PM
Chapter 14 -- Backup and Utilities rogi Campleted (2 Normal  3/23/2005 12:00 PM
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Chapter 15 -- Budgeting and Planning Mot Started (2) Mormal 3/23/2005 12:00 PM
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In this SharePoint web site shown above, the tasks have been set up to prepare 24
chapters on an accounting software system. You can see all the chapters listed as
separate tasks, along with an indicator as to percentage complete. Below you see the
home screen in which the participants are listed, the shared documents are available,
the tasks to be completed are accessible, and links to relevant information is provided.

42X http:Hportal. boxlink.com - Home - SBA Team Web Site - Microsoft Internet Explorer "._HE”Z
Fil=  Edit “iew Favorites Tools  Help -:f
A 7Y vy ’ > T
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Chapter 02 -- New User & Seourity agi Cormpleted
Chapter 10 -- Sales Orders and Invoicing Carlton In Progress
Chapter 09 -- Purchase Orders, Bills & Checks Carlton In Progress
Chapter 24 -- Business Services Mot Started
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Visio 2010 is a diagramming program for creating business and technical diagrams that
document and organize complex ideas, processes, and systems. Diagrams created in
Visio 2010 enable you to visualize and communicate information clearly, concisely, and
effectively in ways that text and numbers cannot. Visio 2010 also automates data
visualization by synchronizing directly with data sources to provide up-to-date diagrams,
and it can be customized to meet the needs of your organization. The Visio product is
used to create business and technical diagrams to think through, organize, and better
understand complex ideas, processes, and systems. Product features include:

v ok W

o

The ability to assemble diagrams by dragging predefined Microsoft
SmartShapes® symbols.

Tools designed for specific professional disciplines.
Generate diagrams from existing data.
Task-specific templates are updated regularly from the Web.

Track reviewers' comments and changes to shapes and digital ink using the new
review mode.

Publish diagrams with Save as Web Page functionality.

Import and export diagrams in Scalable Vector Graphics (SVG) format, a new
Extensible Markup Language (XML) standard for Web graphics.

Integrate business processes and systems by extracting data from your Visio
diagrams and importing it to Access, Excel, Word 2003, SQL Server™, XML, and
other formats.

Convert a Microsoft Outlook® calendar to a Visio calendar that can be formatted
and shared with others.

Following are some documents that were created using Visio.

i

Visio conférence multipoint l
avec pont MCU H323

Emetteur

v!_ﬁ Récepteur

INTERNET

Récepteur
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New in Visio 2010 — PivotDiagrams are similar to PivotTables in Excel. They allow you to
work with data where you want to see groups and subtotals. An example of
PivotDiagram is shown below:

Product Sales

All Rev 5 2,316,069
Units 20,579

Diresct Part.

@ All Rev $ 50,877 All Rew 118,511 All Rew $ 469,472 @ All Rew 5744212
' Units 287 Units 386 Units 3,957 ' Units 7.400
|
Direct Part Direct Part. Direct Part Direct Part.

PivotDiagrams are great when you need to communicate the key pieces of information
in your data to other people in a very visual way. It's also easy to drill into your data
with PivotDiagrams and find exactly the right parts of data that you want to
present. PivotDiagrams can take advantage of all of the power of Data Graphics that
I've been showing you in previous posts, so you can create some graphically rich ways to
show your data.

To create a PivotDiagram select the PivotDiagram template in the startup screen. This
triggers the Data Selector wizard that lets you choose which data source you want to
connect to (PivotDiagrams are always connected to external data). PivotDiagrams can
connect to Excel, Access, SQL Server, SQL Server Analysis Services, SharePoint lists, and
other OLE/DB or ODBC data sources. When you select your data source, you end up
with a single shape in your PivotDiagram that shows you the sum total of all of the rows
in your data.
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Choose the totals that you want to display, and then choose how you want to break out
your data into groups and subtotals. To do this you use the "Add Category" control in
the task pane. Click on one of the categories to break out the currently selected
shape. In this example, I'm breaking out the totals by the different types of
calls: Hardware, Software, etc:

Calls 70,450

SolveRate 17.61

IO O OO S

Calls 10,587 Calls 30,420 Calls 15,210 Calls 14,273
SalveRate 3 SolveRate 5482 SolveRate 3 SolveRate 579

You can continue to break out subtotals; for example in the screen shot below we have
selected the "Software" shape, and broken these totals out:

Software 38

Calls 14,273
SclveRate 579
Calls 12,243 Calls 2,030
SolveRate 29 SolveRate 2.89

We can also add some Data Graphics to show the data in richer, more visual ways. In
the example below, the Customer Satisfaction with the different call centers can be
visualized as a speedometer data bar, and we can also show a trend arrow indicating if
customer sat is going up or down:

Calls 70,450
SolveRate 17.61

CSat
-
73%
Dalas x ——F SERN o Angales. CA m Seatte. WA
Calls 19,774 Calls 6,383 Calls 30,242 Calls 14.081
SalveRate 472 SalveRate 349 SolveRate 4.03 SolveRate 5.37
o oo
- - 4 -
55% 3% TT% 8%
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We could leave the PivotDiagram like this -- it's already showing us some important
information in a visual, easy-to-understand way. But since this information is
geographically related, it might be even easier to understand if we placed it on a
map. This brings us to another important point about PivotDiagrams: you can easily
customize the layout to better communicate the data. While they start out looking like
a tree diagram, similar to an organizational chart, this is just a starting point for you to
customize to suit your needs. In this case, you can simply select and delete the
connectors between the shapes, drag out a U.S. map shape to the page, and place the
different PivotDiagram shapes in their appropriate locations around the map:

Support Center Customer Satisfaction

Last Updaled Februsry 24, 2006

Once you end up with a graphic that you are happy with, you can save it and refresh it
on a regular basis as data changes. This is an easy way to create a graphical report that
can be distributed to keep people updated on current status.

Visio Tips

1. If you want to select multiple shapes, use the Lasso Select tool to drag a selection net
around the shapes you want. (To find that tool, click the arrow next to the Pointer
tool on the Standard toolbar. (It's usually hanging around with the barrel racing and
chute doggin' team....)

2. Zoom in on a specific point in your drawing by clicking while pressing CTRL+SHIFT.

3. To see what's in files before you open them, in Windows Explorer click the Views
button and then click Thumbnails.

Positioning Shapes
4. Have your shapes gone awry? Select the shapes you want to align and then, on the
Shape menu, click Align Shapes.
5. Space your shapes uniformly by selecting three or more shapes and then, on the
Shape menu, clicking Distribute Shapes.
6. To move shapes vertically or horizontally, hold down SHIFT while you drag the
shapes.
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7. Backto top

Resizing Shapes
8. Make shapes the same size by selecting them and, in the Size & Position Window
(from the View menu), typing the Width and Height you want.
9. Backto top

Moving Around

10. Zoomed in too close? Center and resize your drawing to fit in the available space of
your Visio window by pressing CTRL+W.

11. Zoom in and out of your drawing fast by pressing ALT+F6 to zoom in and
ALT+SHIFT+F6 to zoom out.

12. To magnify part of a drawing, on the View menu, click Pan & Zoom Window, and then
in the Pan & Zoom window, click and drag to create a red box around the part of the
drawing you want to magnify. Drag the red box to pan the drawing.

13. Zoom in on a specific point in your drawing by clicking while pressing CTRL+SHIFT.

14. Zoom in on an area by holding down CTRL+SHIFT and dragging a selection net around
the area.

15. Zoom out and move another part of your drawing to the center by right-clicking while
pressing CTRL+SHIFT.

16. See your drawing in full screen mode, minus Visio menus, task panes, and stencils, by
pressing F5. Press ESC to return to the Visio program.

17. To fine tune the position of a shape in your drawing, select the shape and then use
the arrow keys on your keyboard to nudge it in the right direction. For even more
control, press SHIFT while using the arrow keys.

18. To position your drawing exactly where you want it on the screen, just press
CTRL+SHIFT, right-click, and drag the drawing.

19. Back to top

Selecting Shapes

20. Want to quickly select all shapes on a page? Press CTRL+A.

21. To select multiple shapes, use the Lasso Select tool to drag a selection net around the
shapes you want. To find the tool, click the arrow next to the Pointer tool on the
Standard toolbar.

22. To select more shapes without starting over, click the Multiple Select tool, and then
drag a selection net around or click the shapes you want to add. To find the tool, click
the arrow next to the Pointer tool on the Standard toolbar.

23. To deselect part of a multi-shape selection without starting over, press SHIFT and
click the shape you want to remove from the selection.

24. Back to top

Connecting Shapes

25. In many drawing types, you can connect shapes automatically as you drag them onto
the drawing page. First select the Connector tool and then drag a shape onto the
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page. Then, with the first shape still selected, drag another shape onto the drawing

page.
26. Back to top

Working With Stencils

27. To save a Visio shape to a custom stencil, right-click the shape on the stencil, point to
Add To My Shapes, and then click Favorites or a stencil you have named.

28. To save the search results stencil, right-click the search results stencil title bar, and
click Save As. In the File name box, type a name, and then click Save. By default,
stencils are saved in your My Shapes folder.

29. To quickly access stencils in the My Shapes folder, on the File menu, point to Shapes,
and then point to My Shapes.

30. Back to top

File Basics

31. To see what's in files before you open them, in Windows Explorer click the Views
button and then click Thumbnails.

32. Want to quickly open a drawing you recently worked on? Open the File menu and
look between the Properties and Exit commands to see and then open the most
recently used files.

33. Want to keep track of more files on the recently used file list? On the Tools menu,
click Options. On the General tab under General options, type the number of
filenames you want to see, and then click OK. Visio can list up to nine files.
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Microsoft Project

Standard

Microsoft Office Project
Standard 2007

Microsoft Office Project Standard 2010 provides project management tools designed to help
you manage projects more efficiently and effectively. Project helps you stay informed and
control project work, schedules, and finances, keep project teams aligned, and be more
productive through integration with familiar Microsoft Office system programs, powerful
reporting, guided planning, and project planning tools.

Project Tips
1. To quickly find out how complete a task is, click the 25%, 50%, 75%, or 100% button
on the Tracking toolbar.

2. To quickly link tasks, select the two tasks and press CTRL+F2. To unlink tasks, select
them and press CTRL+SHIFT+F2.

3. To quickly view details about tasks or resources, double-click the item to change it.

Moving Around In Projects
4. Do you want to quickly edit text in the Gantt chart or any sheet view? Press F2 to
activate the entry bar to edit text in the selected cell.
5. Can't see the Gantt bars for your selected tasks? Click Go To Selected Task.
6. If you want to move the timescale portion of the view in small increments, press
CTRL+LEFT or CTRL+RIGHT.

7. If you want to see a form view along with another view for quick entry of task or
resource details, hold down SHIFT while clicking the view on the View Bar.
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Viewing Project Information

8. If you have applied a filter to your view to show only specific tasks, you can quickly
see all your tasks again by pressing F3.

9. Do you want a quick way to select all the rows and columns in the Gantt chart or any
sheet view? Press CTRL+SHIFT+SPACEBAR.

10. Don't know how a column or field is used? Point at the header of the column, and
click the Help link.

11. To quickly create a Gantt Chart that looks the way you want, click Gantt Chart Wizard
on the Standard toolbar.

12. To show or hide a toolbar, right-click one of the currently displayed toolbars, and
then click the toolbar you want to show or hide.

Working With The Calendar

13. Want to quickly create a task in the Calendar? Simply place your cursor within the
Calendar, and drag your mouse right or left for the duration of the task.

14. You can change or add task information in the Calendar view. Double-click the task to
display the Task Information dialog box. For example, you can change the
predecessors or attach a note to the task.

Working With Tasks

15. To quickly link tasks, select the two tasks and press CTRL+F2. To unlink tasks, select
them and press CTRL+SHIFT+F2.

16. Do you want to format an individual Gantt bar? Double-click the Gantt bar to open
the Format Bar dialog box.

17. Want to format a category of Gantt bars? Double-click a blank area of the chart
portion of the Gantt Chart to open the Bar Styles dialog box,

18. Do you want to edit a cell by typing within the cell? Click the text to select it, and then
click it again to place the editing cursor in the text.

19. Link two tasks quickly using the mouse. In the Gantt Chart view, point to one of the
bars until you see a four-pointed arrow, then drag it to the task you want to link to.

20. Did you make a mistake? Quickly undo mistakes by pressing CTRL+Z.

21. You can create new tasks by dragging left or right in a blank area on the right side of
the Gantt Chart.

22. To quickly start the spell checker, press F7.

23. To enter identical information for more than one task, select the tasks, and then click
the Task Information button on the Standard toolbar.

24. Change the duration of a task by dragging the right end of the Gantt bar left or right.

Working With Resources And Assignments
25. You can quickly view resource availability using a graph as you assign resources to
tasks. From the Assign Resource dialog box, click Graphs.
26. To quickly enter resource information in the Resource Sheet view, double click the
resource name, and enter information in the Resource Information dialog box.
27. To quickly start the spell checker, press F7.
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Collaborate

28. You can quickly collaborate with your team about assignments. In any sheet view,
simply select a specific task, assignment, or resource and right-click to display the
shortcut menu. Depending on the collaboration activity, click Publish New and
Changed Assignments or Request Progress Information.

29. Want to create an effective presentation? Copy your Gantt chart or other view using
the Copy Picture to Office Application button on the Analysis toolbar.

30. If you have Microsoft® Office Outlook® 2003 or another MAPI-compliant, 32-bit e-
mail system, you can route projects to reviewers from Project. On the File menu,
point to Send To, then click Mail Recipient.

31. You can include a copy of the Gantt Chart view in an e-mail message or Microsoft
Office Word 2003 document. With the Gantt Chart view displayed, click Copy Picture
on the Standard toolbar, and then paste the picture into an e-mail message or
Microsoft Word document.

Tracking Progress

32. Milestones are checkpoints you can use to track progress. You can make any task a
milestone by setting its duration to zero or by selecting the Mark task as milestone
check box on the Advanced tab in the Task Information dialog box.

33. You can save a copy of a baseline plan for later reference. On the Tools menu, point
to Tracking, and then click Save Baseline. All the scheduled information is copied into
baseline fields. Later you can compare this plan to your actual results.

34. To quickly find out how complete a task is, click the 25%, 50%, 75%, or 100% button
on the Tracking toolbar.

35. To update how much work has been completed on a task, drag the left end of the
task's Gantt bar to the right to display the correct completion percentage.

Ole And Graphics

36. You can include a copy of the Gantt Chart view in an e-mail message or Microsoft
Word document. With the Gantt Chart view displayed, click Copy Picture on the
Standard toolbar, and then paste the picture into an e-mail message or Word
document.

Managing Costs
37. Project can track costs for you. When you update a project by entering the actual
duration of a task, the costs automatically are updated based on the cost of the
resources and the fixed cost entered for that task.

Printing
38. Want to create an effective presentation? Copy your Gantt chart or other view using
the Copy Picture to Office Application button on the Analysis toolbar.
39. Preview a view before printing it by clicking Print Preview on the Standard toolbar.
40. You can scale your project to print on one page. On the File menu, click Page Setup,
and then click the Page tab.
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OneNote 2007 is used to gather and share information in meetings, presentations,
brainstorming sessions, phone conferences, and classes—just about anywhere you work
with ideas and notes. Listed below are 10 features of OneNote.

Capture All Information In One Place - Better manage, prioritize, and act on the
deluge of information you gather from e-mail, meetings, presentations, classes, the
Web, and other sources. Capture virtually any type of information—ranging from
typed notes to hand-drawn pictures to audio.

Organize Notes - Move, rearrange, separate, or combine notes and other content
anywhere on the page. OneNote works like a paper notebook, except you can create
as many folders, sections, and pages as you want and then customize and organize
them according to your needs.

Find Information Quickly - Quickly search across all notes to find key information,
whether it's a client's phone number or another important reminder. (This helps
users avoid the frustration of searching through paper notebook or sticky notes for a
crucial piece of information.)

Prioritize Important Items - Highlight key ideas, reminders, or follow-up tasks in
OneNote with Note Flags. View all Note Flags at once, customize them to highlight
key categories (such as questions from your manager or customers you have to call),
or add them to your task list in Outlook.

Drag Information — OneNote allows users to drag pictures, charts, text, or other
content into a OneNote document. OneNote automatically includes the original Web
site address or file location as a handy reference.

Integration — Data in OneNote can be migrated to Word or PowerPoint.

E-Mail Notes — Notes can be Users can e-mailed or shared through a SharePoint site.

New in OneNote 2010 — Microsoft has added the following new features in OneNote

2010:

1. Improved tables with rapid note taking.

2. You can now place documents on a page of notes as icons.

3. Dragand drop of pages and sections.

4. Sub pages now have their own titles.

5. Insta-Search now allows users to search OneNote data instantly.

Presented below are screens shots of OneNote.
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Microsoft Office InfoPath 2010 is an information-gathering program. Using Office InfoPath 2010,
you can create and deploy electronic forms solutions to gather information efficiently and
reliably. You can also use the InfoPath Forms Services capabilities in Microsoft Office SharePoint
Server 2010 to extend your business processes beyond your corporate firewall, delivering forms
as Microsoft Office Outlook e-mail messages, Web browser forms, or forms for mobile devices.

Gather Information Efficiently And Reliably

Office InfoPath 2010 makes information gathering more efficient by delivering electronic forms
that reach the necessary participants, reduces redundant data entry, and improves the quality
of the data collected. InfoPath forms help you reach more users by providing an easy form fill-in
experience across Web browsers, e-mail messages, or mobile devices.
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Office InfoPath 2010 provides real-time validation, pre-populated fields, and connections to
important sources of information. Office InfoPath 2010 solutions are integrated with the
Microsoft Office system to deliver powerful electronic forms capabilities in a familiar package.
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InfoPath forms can be deployed to many Web browsers for fill-in, including Microsoft Internet
Explorer, Netscape, Mozilla, Safari, and others.

Centralize Forms Management And Control

Office InfoPath 2010 and Office SharePoint Server 2010 can be combined to centralize the
deployment and management of forms throughout your organization. InfoPath Forms Services
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of Office SharePoint Server 2010 help you get control over your forms solutions by providing
centralized management of electronic forms for the entire organization. Office SharePoint
Server 2010 provides a unified portal and a forms and content management solution for your
enterprise to help you manage electronic forms in the same context as other critical business
functions.
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InfoPath Forms Services is fully integrated with Office SharePoint Server 2010 to help ensure
organizations can centrally manage and deploy electronic forms. View a larger image.

Streamline Forms-Driven Business Processes

Office InfoPath 2010 integrates with your current business applications and systems using
industry standards so you can automate existing business processes without having to reinvent
them. InfoPath form solutions provide an way for your organization to gather and present
information from your existing line-of-business systems using the familiar Office interface. Office
InfoPath 2010, Office SharePoint Server 2010, and Microsoft BizTalk Server 2006 combine to
deliver a comprehensive solution for optimizing business processes. Advanced form design and
development tools enable Office InfoPath 2010 to streamline complex processes using dynamic,
interactive forms that connect users to the right data.
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121Contract #12345
Statement of Work/Purchase Order/Schedule
This Statement of WorkfPurchase Order/Schedule ("SOW") is between Contoso Corporation ("Contoso”) and
Jessica Amaold ("Contractor”). If this SOW is being entered into under the Contoso Corporation Purchase Order
Terms and Conditions (the “PO”), this SOW is effective as of the "start” date listed in the PO. If this SOW is being
entered into under an agreement other than the PO, this SOW is effective as of 2005-12-14. The PO or such other
governing agreement, as applicable, are referred to in this SOW as the “Agreement.” The parties agree as follows:
1. Detailed Description of Work: The following describes the project expectations and specifications,
Contractor activities, and reporting requirements for goods, services, products, and/or other items or materials
that Contractor shall perform and/or deliver to Contoso under the Agreement as a work made for hire [collectively, +
the “Work”): *

Sedion:l Pagerlof2 | Words 1513

The integration capabilities of Office InfoPath 2010 and the Microsoft Office system enable
InfoPath to extend into other programs to improve information gathering for databases,
documents, and more.
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BIOGRAPHY & CONTACT INFORMATION

J. Carlton Collins, CPA - carlton@asaresearch.com
ASA Research - Atlanta, GA 770.734.0950

J. Carlton Collins, CPA is a Certified Public Accountant with experience in technology, tax,
auditing, accounting systems, financial reporting, and bond financing. He is an author, lecturer,
and technology & accounting systems consultant. He has published more than two dozen books,
two hundred articles, and thousands of web pages. As a public speaker, Mr. Collins has delivered
more than 2,000 lectures in 44 states and 5 countries addressing more than 500,000 business
professionals, including numerous keynote lectures at national and international conferences.
Key awards include: "AICPA Lifetime Achievement Award", "Tom Radcliffe OQutstanding
Discussion Leader Award", "GSCPA Outstanding Discussion Leader Award", and "Accounting Technologies' Top Ten CPA
Technologists Award". As a consultant, Mr. Collins has assisted 275+ large and small companies with the selection and
implementation of accounting systems. Mr. Collins has a Bachelors degree in Accounting from the University of Georgia, is a
26 year member of the AICPA and the Georgia Society of CPAs, and is also a licensed realtor.

At the University of Georgia Mr. Collins was elected President of the Phi Eta Sigma Honor Society, was initiated into the
BIFTAD Honor Society, was a member of Alpha Tau Omega fraternity, and served three years in the Judicial
Defender/Advocate program. At Glynn Academy High School Mr. Collins was Senior Class President, Class Valedictorian, and
received a principle nomination to Annapolis Naval Academy. Mr. Collins has been married for 25 years and has two
children. He devotes his leisure time to family, travel, tennis, fishing, snow skiing, and riding motorcycles (dirt and street).
Mr. Collins is a talented artist (drawing), and is skilled in many areas of construction including building, electrical, plumbing,
and finish work. Mr. Collins won top prize as a comedian performer on Celebrity Cruise Lines, is president of his home
owners association, participates in the Gwinnett Clean and Beautiful program, and volunteers for Cooperative Ministries
food drive.

Selected Positions, Awards & Accomplishments:

1. 2008 and 2009 Chairman of the Southeast Accounting Show - the south's largest CPA event.

2. Recipient of the 2008 Tom Radcliff Outstanding Discussion Leader Award.

3. Named “Top Ten CPA Technologists” by Accounting Technologies Magazine; Named “Top 100 Most Influential CPAs ”
by Accounting Technologies Magazine in multiple years.

4. Has personally delivered over 1,500 technology lectures around the world.

5. Has published 80+ pages of accounting software articles in the Journal of Accountancy.

6. Recipient of the AICPA Lifetime Technical Contribution to the CPA Profession Award.

7. Recipient of the Outstanding Discussion Leader Award from the Georgia Society of CPAs.

8. Lead author for PPC's Guide to Installing Microcomputer Accounting Systems.

9. Has installed accounting systems for more than 200 companies.

10. Past Chairperson of the AICPA Technology Conference.

11. Has delivered keynote and session lectures at dozens of accounting software conferences including seven Microsoft
Partner Conferences, five Sage Conferences, and multiple conferences for Epicor, Open Systems, Exact Software, Sage
ACCPAC ERP, Dynamics.NAV, Dynamics.AX, SouthWare, Axapta .

12. Has provided consulting services to many computer companies (including Compaq, IBM, Microsoft, Apple, Novell,
Peachtree, Epicor, Sage Software, Softline, Exact, ACCPAC, Intuit, Peachtree, Great Plains, and others).

As an auditor Mr. Collins has audited businesses in the areas of health care, construction, distribution, automobile
dealerships, insurance, manufacturing, and general business. Mr. Collins' tax experience includes corporate, individual,
partnership, fiduciary, and estate tax planning work. In the area of finance, Mr. Collins has prepared feasibility studies and
financial forecasts for nearly 300 projects seeking more than $3 billion in startup capital, including field work for 80 of those
projects. Mr. Collins is familiar with bond issues, Medicare and Medicaid reimbursement, and conventional financing
matters. As a consultant, Mr. Collins worked with the entire Microsoft Excel development team contributing more than 500
pages of design improvements - many of which are found in Excel today.
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CPE Course Evaluation Form

(In accordance with State Board guidelines, this form is retained as a permenant record of your attendance)

COURSE TITLE: Microsoft Office for CPAs DATE:

NAME:

COMPANY:

ADDRESS :

CITY, STATE, ZIP:

TELEPHONE: E-MAIL:

Instructor's Name: J. Carlton Collins Excellent=5  Very Good=4 Average=3 Fair=2 Poor=1
1. The Discussion Leader's knowledge of the subject matter was: ® @ @ @ 6y
2. The Discussion Leader's presentation skills were: @ @ @ @ @
3. The learning objectives were met ® @ @ @ 6
4. The course materials were valuable and contributed to learning ® @ @ @ @©
5. 2 course content was relevant ® @ @ @ 6y
6. Time allocations were appropriate @ @ @ @ @
7. Please rate the quality of the facilities ® @ @ @ 6
8. Were prerequisite requirements appropriate ® @ @ @ @
9. Please rate the effectiveness of the audio / visual systems ® @ @ @ 6

COMMENTS




